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1. Using MediaWorks EXP

1. USING MEDIAWORKS EXP

MediaWorks EXP provides several ways to locate, organize, and replay recordings stored on an Eventide
NexLog Express recorder. Once the desired recordings have been found, they can be easily organized
into incidents for saving and export. The recordings can also be examined, updated and listened to.

With MediaWorks EXP you can also live monitor channel(s), view the status of channel(s), and (if
permitted) enable/disable recording on channel(s) for on-demand record/don’t record purposes. The
data for each recording can be exported in several ways.

The information about using MediaWorks EXP includes:

e Locating and Organizing Recordings

¢ Viewing and Playing Recordings

e Creating an Incident

¢ Updating Recordings

e Exporting Recording Data from an Incident
e Monitoring a Recorder

e Resource Search Groups

e Archives

1.1. Accessing MediaWorks EXP

Open one of the supported browsers:

e Google Chrome
e Microsoft Edge (Chromium)
e Mozilla Firefox

Enter the address of your NexLog Express recorder in the URL bar. The address will either be an IP
address or a DNS address. Loading this page in the browser will bring you to a login page.
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Fig. 1.1 MediaWorks EXP Login/Splash Screen

For MediaWorks EXP to connect to the recorder with HTTP, port 80 must be open; for HTTPS, ports 443.
If you can’t connect, check with your network administrator that these ports are open.

1.2. Logging Into MediaWorks EXP Using Authentication
Providers

O New in version 2024.1.

P License Required

This feature must be licensed to be used. Contact your Eventide Communications Dealer for

assistance.

MediaWorks EXP can also log into the recorder using a Single Sign-On (SSO) method of authentication.

© 2025 Eventide Communications LLC



1. Using MediaWorks EXP
NexLoc DX

Communications Recording Solutions

4.0.24.1

Recorder: 23183.qa.nexlog.host

LOG IN WITH COMM743

USE LOCAL LOGIN

Fig. 1.2 MediaWorks EXP Authentication Login

Once configured, a user will be redirected to an authentication provider for login, then automatically
logged into a MediaWorks EXP session.

For complete setup instructions, please refer to the “NexLog Express Authentication & Active Directory
Implementation Guide” Section 9. “NexLog DX-FIPS ADFS Configuration”.



This page was intentionally left 99.88% blank.



2. Locating and Organizing Recordings

2. LOCATING AND ORGANIZING RECORDINGS

The typical process for finding and organizing recordings includes the following steps:

e Browse or search for recording data on the recorder.

e Create and save Incidents by selecting individual recordings or groups of recordings and organizing
them into incidents.
e Export the datain a variety of formats.

2.1. Browsing for Recordings

By default, only the Browse tab is available. The additional tabs detailed in this documentation are
available with the Add-On license Full MediaWorks . Consult with your Eventide Communications

Dealer for more information.

The simplest method for locating recordings on the recorder is provided by the Browse tab, Fig. 2.1.
When viewing the Browse tab, the connected sources appear on the left. Below the source(s), a list of
months corresponding to the available data on the recorder will appear after you click on the + sign next
to the source. Clicking on a + sign next to a month will display all the days in that month that data was
recorded. Clicking on a + sign next to a day will open a list of channels on that recorder that contain the
data for the day selected. When you click on a channel, MediaWorks EXP retrieves the recordings for
that channel and displays them in the upper right pane.
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Fig. 2.1 Browse Tab

To retrieve recordings for a different day, expand the tree for the appropriate day and click on the
desired channel. The recordings for that channel will then be retrieved and displayed. To update the
browse tree, click on the blue refresh button at the top right of resources tree pane, next to the current
day. Each channel in the resources tree will be updated with the new calls.

The Browse tab can display the list of channel in three modes: Resource Name, Resource Name Grouped
by Recorder, or Channel Number Grouped by Recorder. The default is Resource Name. To change the
display mode, click on Show... at the top of the left pane and select the mode from the drop-down menu.
When viewing the information by Channel Number Grouped by Recorder, each physical channel on the
primary recorder and connected bridges and archives will be listed with its channel number.

2.2.Searching for Recordings

MediaWorks EXP provides a powerful interface for advanced recording retrieval in the Search tab.
When viewing the Search tab, a list of search criteria in the form of Filters is provided in the left pane.
Clicking on Filters... at the top of the panel displays a drop-down list of filters.

© 2025 Eventide Communications LLC
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Fig. 2.2 Search Tab

Each element of a search is contained within a search “panel” in the left pane of the Search tab. The Date
and Resource panels are always required, so you must provide, at a minimum, a value for these criteria to
conduct a search for recordings. When more filters are added, additional panels will appear as needed. If
necessary, scroll the search panel to view the additional panels. Each filter panel can be compressed or
expanded by clicking on the arrow located in the upper left corner of the pane.

2.2.1. Creating a Search

To create a search, first select one or more days from the Date filter area. Dates can be selected by
clicking on the calendar (default), or by specifying a date range or relative time period. To change the way
a date filter is specified, click the down arrow in the upper right corner of the Date filter panel and
choose the desired mode from the drop-down menu. The modes include Calendar (default), Date Range,
and Relative.

In the Calendar mode, you can select a continuous range of dates across more than one month, as
follows: Select the earliest date, click the forward arrow to navigate to the next month, hold down the
Shift key, and select the last date.

In Date Range mode, you can enter date and time by clicking the calendar icons next to the Start and End
text fields; this will pop open a window that lets you choose the date and time visually with sliders. You
can also edit the fields as text. The start and end fields use the Date Chooser format as set in the Date
Format Options.

In Relative mode, you can choose how far back from the current time you want the search to cover. For
example, a setting of 2 Days and HH:MM:SS 04:15:30 will search on call records from the most recent
two days, four hours, fifteen minutes and thirty seconds relative to the time the Search button is pressed.
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You can edit this as text or you can click the clock icon to bring up a window that has sliders to set the

hour, minute and second values.
O New in version 2025.1.

When you select a date range, the channel names in the Resources filter will update to show the number
of calls completed within that range. If a channel has no calls for the selected date range, O will be
displayed in parentheses next to the channel name. Note that call count is not affected by additional
filters.

Filters

< JUN 2022 >

S M T W T F S
ENERER -

8 9 10 M
12 13 14 15 16 17 18
19 20 21 22 23 24 25
26 27 28 29 30

Use Time Range

iii
8

Resources

E-= Resources
911 Pos 1(De) (483 calls)
911 Pos 11(De) (114 calls)
911 Pos 12(De) (513 calls)
911 Pos 3(De) (155 calls)
911 Pos 5(De) (141 calls)
911 Pos 7(De) (225 calls)
911 Pos 8(De) (542 calls)
< 911 Position 1 (0 calls)

Fig. 2.3 Call Counts displayed next to Channel Name

Next, one or more resources or resource groups can be included in the search by selecting them in the
Resources filter panel below the Date panel. The Resources filter displays resources for the recorder.
Any number of resources can be selected. Resources can be selected by Resource Name, Physical
Channel Number Grouped by Recorder, or by Resource Name Grouped by Recorder. To change the way
the Resources filter is displayed, click the down arrow in the upper right corner of the Resources filter
panel and choose the desired mode from the drop-down menu.

When using the Grouped by Recorder options, the resources will be separated by NexLog system the
resources originate from. In Resource Name mode, all resources made available by NexLog Access
Bridge connections will be listed alongside the locally available resources as if it were all one system.
Because Physical Channel Number is tied specifically to hardware, it is only available in Grouped by
Recorder format.
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2.2.2. Initiating a Search

To initiate a search, click on the Search button at the top right in the Search pane. All recordings that
meet the search criteria will be displayed in the tabular record view (in the right pane). You can also press
the enter key to kick off a search after changing any of the search parameters; otherwise the enter key
will start playback on the currently selected call.

2.3. Using Additional Filters

You may narrow your search by specifying additional filters, such as Call Length or Protected. To add an
additional Search filter, click on Filters... and select a filter from the list. The selected filter will be
displayed below the Resource filter area. More filters can be added, if necessary. Each new filter will
appear as an additional panel.

Note: Some additional filters are standard on all recorders and will always appear on the drop-down list.
Other additional filters depend on the custom fields included in the recording table. Some or none of
these filters may be included on the drop-down list of your recorder.

To remove afilter, click the X button which appears in the title bar of each optional filter. Alternately,
deselect the filter from the Filters... drop-down list. Once removed, the filter will not be used in
subsequent searches.

2.3.1. Standard Additional Filters

The following standard additional filters appear in the Filter drop-down list of all recorders.

Call Length

Enter the minimum and maximum call durations. MediaWorks EXP will search for all recordings
equal to or between these values.

Call Note
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Enter text in the Note box. MediaWorks EXP will perform a search for all recordings that contain
this text string in the Note field. Check the Case sensitive? box if you wish to make the search match
case as well.

PIN

For installations that use a PIN code, enter the PIN number. MediaWorks EXP will include this as
part of the search criteria.

Protected

Search for all recordings that are protected, or all recordings that are unprotected.

Telephone

Enter the telephone number digits. Check the Search DTMF box to find recordings which match the
telephone number in the DTMF field. Check the Search Caller ID box to find recordings which
match the telephone number in the Caller ID field.

Call Direction

This filter only applies to recordings that contain data in the Caller ID or DTMF fields. Enable
Incoming to find recordings that match incoming calls. Enable Outgoing to find recordings that
match outgoing calls. Enable Unknown to match recordings that could not be identified as either
incoming or outgoing. Enable Use DTMF and Caller ID to determine to use heuristics on the data in
the Caller ID and DTMF fields to determine call direction.

Suppressed

Check Show suppressed to search for recordings that were suppressed on the recorder. Check
Show unsuppressed to search for recordings that were unsuppressed on the recorder. Check Show
forced to search for recordings that were forced into recording on the recorder.

Audited

© 2025 Eventide Communications LLC
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Check Show accessed to search for recordings have had their data accessed by client applications.
Check Show not accessed to search for recordings that have not had their data accessed by client
applications.

Deleted

Click on Show deleted to search for recordings that do not have audio data associated with them,
which may happen when the recorder purges data periodically to maintain free-space for newer
calls. Click on Show not deleted to search for recordings that do have audio data associated with
them.

O New in version 2023.1.

Record ID

A unique alphnumberic identifier automatically assigned to each call log and listed in the call
properties. Clicking on the Record ID in the call properties window will automatically copy the ID to
the clipboard.
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‘ ’
Q Search © Instant Recall B 12/22 incident B incident 4122 NeXLOG

Filters (1) >  Results as of 2023-01-19 14:41:53... 2400 records, O selected | Rotate Canvas| Q. B & Call Properties + x

i= Browse

Search

Channel 8 Source Name Channel Name  Record ID Properties All History User Info location Transcriptions
Channel 9 NLDX_VM_240100149  Channel 2 03Q8YXONr0A4rsAs
WIN10 )
L0 ACET NLDX_VM_240100149  Channel 2 0ayQVjGz7dXaV2fA General Time
4 Group 1 test NLDX_VM_240100149  Channel 2 0BeC8ZPoalnwQao8 Channel Name Channel 2 JNgeney)
NLDX_VM_240100149  Channel 2 OcwbViwDfSh7ZBco Calltype « [ENEK — onPVD_;[vlqﬁRcm
© NLDX_VM_240100149  Channel 2 0dMNRMajh89POHNA N
Dtmf Flag
NLDX_VM_240100149  Channel 2 0Dolal482jgiXb4Y
NLDX_VM_240100149  Channel 2 0e04X5t0VB70yinG phone data
| [NLDX_vM_240100149 | Channel 2 OFjPYD9VIG7TRCIN ) Ota Encryption
NLDX_VM_240100149  Channel 2 0gIOREXO0USsJ4HD
NLDX_VM_240100149  Channel 2 0h1hG2523€0FONT6
NLDX_VM_240100149  Channel 2 OHHnt1gbasqlyOlx
NLDX_VM_240100149  Channel 2 OhVtamuogygtlH7!
NLDX_VM_240100149  Channel 2 0igwG34HpJVACTPM
NLDX_VM_240100149  Channel 2 0IkRoR6XM59UBBU]
X Record ID = NLDX_VM_240100149  Channel 2 0JzwIpkM2SITjiMV
OFJPYDOVIG7TRCIN o5 NLDX_VM_240100149  Channel 2 OkjalmJdbu3rxul
NLDX_VM_240100149  Channel 2 OMC4Ef8sM63xrAut
NLDX_VM_240100149  Channel 2 OMIzfgaHrBQPIPHD
NLDX_VM_240100149  Channel 2 0mZKapDnFfb6wG7D Copied to clipboard
03 0536:00 0500 2023 0705 05:57:00 0500 023 0705 05:35.00 0500 20250103 05:39:00 -0500 2023-01:03 05:4000-0500 2023-01°03 05:41:00-0500
Resource Name | | \ f |
Channel 2 BJ it [;.u....\.«wqw.q‘ T T yuw—ol\'wrnlm\J {;mmpuu..q l»m..n.w..n.n I ..u...\.m.m.m‘ I..w...\.wm
oneMinute v & 1 @& &
v a { K| . S

00:00

Fig. 2.4 Record ID

2.3.2. Custom Additional Filters

These additional filters are based on the custom fields that have been added to the call properties for a
particular recorder. Enter the string as it appears in the More tab of the Call Properties screen.

Following are some typical examples of additional custom filters which may or may not appear in the
Filter drop-down list of your recorder, depending on your particular custom fields.

:City:** Search for recordings that have a specific city name associated with
them. Enter the city name string the Search for: box.
:Customer Name:** Search for recordings that have a specific customer name associated with

them. Enter the customer name string in the Search for: box.

Radioid

Search for radio call recordings that have Radioid information associated with them. Enter the
Radioid string in the Search for: box.

© 2025 Eventide Communications LLC
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State
Search for recordings that have a specific state associated with them. Enter the state string in the
Search for: box.

Street Address
Search for recordings that have a specific street address associated with them. Enter the street
address string in the Search for: box.

Subject
Search for recordings that have a specific subject associated with them. Enter the subject stringin
the Search for: box.

Talkgroup
Search for recordings that have a specific talk group associated with them. Enter the talk group
string in the Search for: box.

Time
Search for recordings that have a specific time associated with them. Enter the time string in the
Search for: box.

User Id

Search for recordings that have a specific user ID associated with them. Enter the user ID stringin
the Search for: box.
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2.4.Saved Search Filters

If you regularly make use of the advanced Search Filter options, you will likely find Saved Search Filters a
very useful feature. This allows you to save and recall customizable search filters, including all metadata
fields and search criteria (date, resources) in the format and style you most prefer.

Saved Search filters can be accessed from the Filters button or the Tools menu option Edit Search Filters.
These options open a pop up window that allows you to load, save, and delete search filters. Filters are
saved based on the current state of the search column, and you can choose which values to remember
for the search, including Date, Resources, and any metadata options currently open.

The Filter Name and lower section (by default called New Search Filter) show the Filter you are currently
acting on. Clicking a saved search will load the details into this window. If you want to then load it into
the search tab, click Load.

If you click one of the saved search filters and then want to work with the current settings instead, click
View Current to load the current settings into this window, from which they can be edited and saved.

For example, one may want to save a search that shows the last three days of call activity on a set of
channels, to load each Monday to see what happened over the weekend. To create a filter like that,
configure a search for Relative date mode, set it to 3 days, then select the resources desired, and then
open the Edit Search Filters and save as Last 3 Days.

Saved Search Filters
Geo-Fence North NJ Show calls from last

Last 3 Days Days 3

Add New... HH:MM:SS 11:52:24

Annotations

Search Filters

Saved Search Filters

Audited

Block Access
Block Access Exceptions
Block Access Info
Call Direction Code
Called Party

Caller Id

Calling Party
Calltype

Clip Details

Color Code
Deleted

Dtmf

Duration
Encrypted On Disk

£-0) Ambulance
-0 Fire
-0 Police

© 2025 Eventide Communications LLC
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[EREDET

View Current Load
Filter Name: Last 3 Days

@ Last 3 Days

Save Value?

Delete Save

Filter
Date

Resources

Close

Fig. 2.5 Last 3 Days Example



2. Locating and Organizing Recordings

For convenience, if you save the hours, minutes and seconds as 0 and days as 3, this filter will load as

3 days plus all the time that has passed today, so that the results show today and the previous 3 days

in full. If you really want 72 hours only, save with the days set to 3 and the seconds set to 1.

Saved Search Filters work well with Geo-Location; you can save Geo-Fences of areas you regularly
search and recall them with ease.

Saved Search Filters

Last 3 Days
Geo-Fence North NJ
Add New...

Filters
X Geo-Fence

Annotations
Audited
"1 Block Access
" Block Access Exceptions
Block Access Info
~| Call Direction Code
" Called Party
Caller Id
Calling Party
" Calltype
" Clip Details
Color Code
Deleted

" Pringeton @

G|

o alo!
Map data ©2020 Google , Terms of Use  Report a map error

Fig. 2.6 Northern New Jersey Geo-Fence Saved Filter Example

2.5. Expanded Search Filter View

MAR 2020 APR2020

Fig. 2.7 Expanded Search
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Expanded Search Filter View lets you fill your screen with all of the search filter options configured, for a
clear view of the search at a glance. For example, the above image shows a search for:

e Calls recorded on March 29 or 30, 2020

e on any of 16 specific resources

e inside or near Wilmington, North Carolina
¢ that have anote

¢ and that have been accessed (played back)

Without expanding the view, a search like this would require scrolling up and down to be sure of what
parameters are set, even on a large monitor.

Use the > icon in the top left area next to “Filters” to expand the search. Use the same icon, now <, to
close it back to the original column width.

¢» Channels Q, Search

Filters >

= I

Fig. 2.8 Search, Filters, Expand

You can rearrange your filters as you wish, and then use the Lock icon to keep them in place. The curved
arrow will automatically organize them for you, if you wish. The X on the right edge can be used to
collapse the view back to the original column width.

a C X

Fig. 2.9 Lock, Autolayout, Close
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2.6. Tab Search

Tab Search allows you to narrow your search results by searching all fields of all calls in a given search
result for any text string. For example, searching on “panel” could return calls that have 212 in DTMF,
Caller ID or a Street Address. It is a simple tool to find information quickly.

Once asearch is performed, the calls will be listed only by the field that matched and the contents of that
field; clicking on a row in Tab Search will highlight that call in the call grid.

Tab Search is accessible from the View menu -> Icons and Markers -> Show Tab Search, and once shown,
from the tool bar above the call grid via the Magnifying Glass icon.
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3. VIEWING AND PLAYING RECORDINGS

After you have found and organized recordings you may view and play the recordings.

3.1. Viewing Recordings

Recordings displayed in the Browse, Search, or Incident tabs are shown in two different ways

simultaneously. The first is a simple tabular list displayed in the upper right-hand pane, called the record

view. This view can be customized in that it supports several different column and sorting options. The

second is a graphical chart of recordings displayed in the lower right-hand pane referred to as the

timeline. The timeline can also be customized, but only supports a single method of displaying the

recording data by time.

Together, the record view and timeline view provide a comprehensive look at the same set of data.

Selections between the two views are synchronized; any recordings selected in one are automatically

selected in the other. Similar operations may be performed from each view, including playback and

export.

3.2. The Record View

The record view in the upper right-hand pane presents recording data in tabular format. It is also called

the call grid. You may sort the information by clicking on the appropriate column heading. A small arrow

will indicate the sort direction. To reverse the sort, click the column heading again.

Results as of 2020-03-05 14:12:36 -05:00

8902 records, 0 selected @

Source Name

NexLog DX-Series
NexLog DX-Series
NexLog DX-Series
NexLog DX-Series
NexLog DX-Series
NexLog DX-Series
NexLog DX-Series
NexLog DX-Series
NexLog DX-Series
NexLog DX-Series
NexLog DX-Series
NexLog DX-Series
NexLog DX-Series

NexLog DX-Series

Channel Name
EMS-East-2
EMS-West
Dispatch-EMS
Dispatch-EMS
Dispatch-EMS
EMS-West
Dispatch-EMS
Dispatch-EMS
EMS-East-2
Dispatch-EMS
Dispatch-EMS
EMS-West
Dispatch-EMS
Dispatch-EMS

Start Time

2020-03-05 13:29:23 -05:00
2020-03-05 13:29:36 -05:00
2020-03-05 13:29:39 -05:00
2020-03-05 13:29:56 -05:00
2020-03-05 13:30:13 -05:00
2020-03-05 13:30:29 -05:00
2020-03-05 13:30:30 -05:00
2020-03-05 13:30:47 -05:00
2020-03-05 13:30:54 -05:00
2020-03-05 13:31:04 -05:00
2020-03-05 13:31:21 -05:00
2020-03-05 13:31:22 -05:00
2020-03-05 13:31:38 -05:00
2020-03-05 13:31:55-05:00

“ Duration

00:30
00:34
00:05
00:06
00:06
00:33
00:06
00:06
00:31
00:06
00:06
00:34
00:05
00:05

Callerld  Dtmf

Fig. 3.1 Record View
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Columns can also be reorganized. Click and drag any column heading to a new position. The type and
number of columns can also be customized. Right click any column heading and a menu of available

column names will appear. You may add or delete a column from this menu. To reset the columns to their
user-defined default values, select the Reset to Default option.

Start Time ~ Duration
I NexLog DX-Series Back Hallway 2020-03-18 07:25:59 -04:00  00:09

NexLog DX-Series Back Hallway 2020-03-18 07:26:17 -04:00 | 00:07

Source Name Channel Name

Fig. 3.2 Record View Showing Records with Removed Media and an Error

There is a retention setting option that allows administrators to retain metadata (duration, date, custom
fields, channel number, etc) about record but delete the media (audio or screen recording) whenever the
recorder needs to delete recordings to make space. In this case, calls are shown with an [R] in the left-

means there is an error with the call; hover the mouse over the ! to

lll”

most column of the call grid. A red
see the error message.

O New in version 2024.1.

When editing columns in the Call Grid, a user can simply type the first letter of the required column to

quickly search across all options.

Example

After right-clicking a Call Grid column, type the letter “F” to jump directly to all the columns starting with
the letter “F”.

= Eventide | &)

Tools  Playbac e Hel
NexLos
e >

© Channels

Search Filters (1) Orecords, 0 selected

Source Name Channel Na... Start Time Duration Callerid  Dtmf

Compression Type
Connection ID
v Dimf

Date E B

< DEC 2023

10
17
24
31

4
1
18
25

Resources

T W T F

5 6 7 8
12 13 14 15
19 20 21 22
26 27 28 29

Use Time Range

= Resources

SEARCH
--~ Records

Volume

Speed

Resource Name

One Minute v

00:00
) 100%
) 100%

[ aala bl

@

v Duration
End Time (Local)
End Time (UTC)
Evaluated
Field 114
Field Eight
Field Eleven
Field Fifteen
Field Five
Field Four
Field Fourteen
Field Nine
Field One
Field Seven
Field Six
Field Ten
Field Thirteen
Field Three
Field Twelve
Field Two

Fig. 3.3 Call Grid Quick Search
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3.3. Record View Menu Options

Selecting a recording in the record view and then right-clicking on that recording causes the Record
View context menu to appear.

w Properties

38:2

374

374

36:2

35:4 New Incident from Selected Records

Block media access
Protect

View Location

350 Add Selected to Incident »
34:2 Evaluate Records »
3314  start Sequential Playback
22 Start Resource Mixed Playback
Export. Ctri+AR+E
Export Single Recording
Export Using Preset »
Add Text Annotation
Add Audio Annotation

Upload User Content

Generate Word Factor

Fig. 3.4 Record View Context Menu

The Record View context menu selections include:

e Properties - See Section 5.1: Call Properties

¢ Block Media Access... - See Section 12.4: Media Access Blocking (Optional, off by default)

e Protect - Checking this box prevents the selected recording from being deleted from the recorder
due to recorder call retention policy. When protecting a large number of calls, a progress bar will
pop up to provide feedback while the system is protecting calls.

¢ View Location - View recording’s location on a map if available. See Section {number}: {name}

e New Incident from Selected Records - See Section 4: Creating an Incident

e Add Selected to incident - See Section 4.1: Adding and Removing Recordings from an Incident

e Evaluate Records - Evaluate selected call recordings. Requires Quality Factor add-on license. See
Eventide Quality Factor Software Manual for details.

e Start Sequential Playback - See Section 3.9.1: Sequential Playback Mode

e Export... - See Section 6: Exporting Recording Data from an Incident

e Export Single Recording - See Section 6: Exporting Recording Data from an Incident

e Export Using Preset - Exports selected recordings using a saved preset. See Section 6.3: Export
Presets and Defaults
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¢ Add Text Annotation - Add annotations to a call, at a specific point in time. See Section 5.3:
Annotating Calls

¢ Add Audio Annotation - Add audio commentary to a call, at a specific point in time. See Section 5.3:
Annotating Calls

¢ Upload User Content - Upload a file to the recorder for recording keeping and use in incidents. See
Section 12.2: User Content Uploads

e Show Errors... - This option will only appear if there is an error with the record, indicated by a red
exclamation point next to the call. Select it to get see information about the error.

¢ Generate Speech Factor Al - Enables Speech to Text Integration automatically, or on select
playback.

e See Section 3.11: Speech Factor Al Transcriptions

3.4. The Timeline View

The Timeline view in the lower right-hand pane shows the same set of recordings that are displayed in
the Record view, but presents the recording data in a linear chart. Recordings are organized into groups
by channel name and are displayed in chronological order from left to right. The individual recordings are
drawn in the timeline in the horizontal direction in relation to their duration. Scroll the timeline to the
right (or to the left) to view recordings that are not visible. If more than one channel is represented in the
data, scroll the timeline up or down to display channels that may not be initially visible.

Resource Name - ‘ ”‘N' A ‘ - L . ‘r o r‘
Dispatch-EMS H ‘,_ J ‘ ‘ L ‘ L ‘ U H (o U
% Pan: A S LY LY ¢ ) L
EMSEast1

EMS-East-2

EMS-West

One Minute v

Fig. 3.5 Timeline View - Audio Recordings

You can increase or decrease the time length displayed on the timeline, and increase or decrease the
height of the individual rows. To zoom, click on the appropriate small magnifying glass in the lower left
corner of the pane. (These are from left to right: vertical zoom in, vertical zoom out, horizontal zoom in,
horizontal zoom out.) In Fig. 3.5, it has the words Thirty Seconds in the left corner. Clicking this will open
amenu offering a variety of time scales from one second to one year. The selected time scale defines the

amount of time to be displayed between each “tick” on the timeline. In Fig. 3.5, there are three ticks, each
representing the start of each half minute.

© 2025 Eventide Communications LLC
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For finer control of the timeline scroll bar:

1. Press and hold your cursor over the scroll bar. The scroll bar will disappear.
2. Use your cursor to navigate through the timeline at a more controlled pace.

If you zoom out on a large amount of call data with several system or text annotations per call,
annotations will be displayed as red dots to improve legibility. You will need to zoom in to see details

for a specific call.

NexLog215 TEXT_154 2020-03-20 14:52:29 -04:00 00:18 8005551212 911. County 2020-

........ 2z P Ty
Resource Name

TEXT_154
i R DL Illlﬂlﬂll@ll@l@ll@

e 5 3 @G

0000

Fig. 3.6 Example of Annotations as Red Dots at High Zoom

If an Analog board’s channel is configured in the Configuration Manager to record with the detect
type On Voxbreak, you can have recordings which are assigned the calltype Inactivity in
MediaWorks EXP. They also have a different appearance from regular Audio recordings in the
timeline. As shown in Fig. 3.7 below, the timeline contains the standard grey blocks which
correspond to Audio recordings as well as transparent blocks which correspond to Inactivity
recordings. These Inactivity recordings occur when the audio input levels on the channel fall below
the channel’s configured VOX threshold. The difference in appearance makes it easy to distinguish
between Inactivity and Audio recordings in the timeline, while the difference in calltype designation
makes it easy to search for periods of activity or inactivity. Inactivity recordings can be played from
the timeline or the record view table by double-clicking it just as any other call can. For more details
regarding “ON VOXBREAK”, refer to the Eventide NexLog Express User Manual.
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Little Ferry Back Hallway 2020-03-23 20:31:11 -04:00 00:08 0004 -+

» Little Ferry Back Hallway 2020-03-23 20:31:18-04:00  00:23 Inactivity
e L B e O 7 R =y TR E o
I T N TR R T N TN N W A | Il i [ R | I [ )
| Bk el vone 21 | [ [ ] f4] A1 ] [

Fig. 3.7 Example of Inactive and Audio Calls from On Voxbreak Recordings

3.4.1. Adding Bookmarks in the Timeline

The bookmark feature in the timeline allows you to create bookmarks during a 911 call. This feature is
especially useful for marking key times for significant events while you continue performing other
searches or navigating across different tabs in MediaWorks EXP.

To set a bookmark:
1. Hover your cursor over a position in the timeline and right-click.

2. Select Set Bookmark and choose your bookmark number. You can add up to ten bookmarks to the
timeline.

:( Start Sequential Playback [
Start Mixed Playback

Set Loop Start

Set Loop End

Set Export Start

Set Export End

Set Bookmark 2 Bookmark 1

Clear All Bookmark 2

| Bookmark 3

Bookmark 4
Bookmark 5
Bookmark 6

Bookmark 7

12 Bookmark 8

Bookmark 9
Analog Channel 1

2025-04-02 00:38:51 -04:0_ 2o°kmark 0

Fig. 3.8 Bookmark Context Menu

Once you add a bookmark, a number will appear at that time.
To navigate back to the bookmark:

1. Press the corresponding number on your keyboard. For example, press 1 to return to Bookmark 1.

© 2025 Eventide Communications LLC
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Fig. 3.9 Bookmark Icon

Bookmarks are only visible within the date range that was assigned to them. The bookmark will only

appear if the selected dates are within the assigned range. If you try to navigate to a bookmark
outside the selected dates, you will see the message BOOKMARK OUT OF RANGE.

To remove a bookmark:

1. Right-click the bookmark icon and select Remove Bookmark.

YT —————— Y=Y BT YW Yy "~ ———— Ty ]
2025-04-02 00:45:00 -04:00 2025-04-02 00:50:00 -04:00 20250

| R R R A T N L T SO
Remove Bookmark

Fig. 3.10 Removing Bookmarks

To clear multiple bookmarks:

1. Right-click anywhere in the timeline and select Clear All.
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HUZ UUIDULL -USUU ZUZ5-U4-UZ UUIddUU -Usuu ZUZo-UsuZuluuu

I (L L T T T O O R . . Y

] Start Sequential Playback

Start Mixed Playback

Set Loop Start
Set Loop End
Set Export Start
Set Export End

Set Bookmark »

Clear All

Fig. 3.11 Clear All Bookmarks Option

3.5. Set Default Timeline Zoom Levels

O New in version 2024.1.

This feature can save your default Timeline zoom levels for new tabs so your viewing preferences remain
the same for all incidents.

To set the default timeline zoom level in MediaWorks EXP, go to View -> Timeline Default:

Eventide | =)
B Incident #3 -< > NeXLOG

1records, 1 selected &

Theme

Properties and Notes | [ Export Ing Multimedia Display Options

v Enable Geo-Display

Source Name Channel Nz Callerid  Dtmf

~ Duration

Icons and Markers

Connection Information

Alarms
Reports
Archives
Play Audible Alarm
v Follow Playback
Show Playing Record Ctrl+Alt+C

Show Playback Audit -01-05 18:10:00 -05:00 2024-01-05 18:20:00 -05:00
Resource Name | |
| L (I [ TR B B

Column Defaults

Channel 1 \L
Timeline Defaults
N
ave Gurrent Columns Layout as Default

Warn On Exit

TenMinutes v & | &) l a

00:00 00:00

Volume 100%

L ]
Speed [ ] 100% I< > >I CD

Fig. 3.12 Timeline Default
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Then select the preferred Timeline Zoom Level:

Tools  Playbact Help Eventide | &)

@ Channels & Incident #3 © Channel 1
Choose Channels m Hours m Minutes 27 records, 0 selected

Source Name Channel Na... Start Time Duration Callerid  Dtmf

NexlLog Channel 1 10:31:12 01:01

NexlLog Channel 1 10:30:06 01:01

NexlLog Channel 1 10:29:00 01:01

NexLog Channel 1 10:27:54 01:01

NexlLog Channel 1 10:26:48 01:01

NexLog Channel 1
—

Resource Name

Channel ] Default Zoom | |

One Second
Five Seconds

Ten Seconds u

Ten Minutes
Thirty Minutes
One Hour
Six Hours
OneMinute v & | @& & ‘ ‘(;welve Hours me
ne Day —

00:31 Two Days WMoo:s
Ten Days
|< ’ Thirty Days » Channel 2

Sixty Days 2024-01-08 10:30:02 -05:00

Ainatis Ravie

Volume. [} 100%

Speed [ ] 100%

Fig. 3.13 Timeline Zoom Level

All new Incidents and Search Tabs will now default to the selected Timeline Zoom Level:

File Edit Tools layback View Help Eventide | =)

@ Channels Q Search »| @ Incident #3 © Channel 1 NeXLOG

choose Channels  [(Jl]Hours KIS Minutes 27 records, Oselected &

Source Name Channel Na... Start Time ~ Duration Callerid  Dtmf
# NexLog Channel 1 10:32:18 00:28

NexLog Channel 1 10:31:12 01:01

NexLog Channel 1 10:30:06 01:01

NexlLog Channel 1 10:29:00 01:01

NexlLog Channel 1 10:27:54 01:01

NexLog Channel 1 10:26:48 01:01

05000 o100 05200
EserEaNme | [ L | [T T R R o
Channel 1 B | | o
. 4 -
One Minute hv yr A @ Q a o >
—
00:31 Moot
Volume [ ] 100%

I< ’ >I CD » Channel 2

Speed [ ] 100% 2024-01-08 10:30:02 -05:00

Fig. 3.14 Timeline Zoom Level Updated

39
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3.5.1. Playback Settings Menu

In the Channel Name box on the left there are a number of playback settings that you can seton a
channel-by-channel basis by using the settings menu.

020-03-23 07:21:00 -04:00 2
Resource Name o | |
I | I
Back Hallway L‘
Volume: 32% Pan: Right
Dispatch-EMS
Volume: 50% Pan: None D E] E] E] []
Dispatch-Fire T bl
Volume: 80% Pan: Left D) ) 80% |
Dispatch-Police [
Volume: 64% Pan: Left L @ R
EMS-East-1 [
Volume: 50% Pan: None v AGC
EMS-East-2
Volume: 50% Pan: None [ Obfuscate ]
v EQ Boost
Options...
Close

Fig. 3.15 Playback Settings Menu

They include:

¢ Volume Slider - Moving the volume slider left or right decreases or increases the volume for this
channel. Clicking on the mute button (green speaker icon) to the left of the down arrow mutes the
sound on the selected channel. The button will then be grayed out. Clicking on the grayed-out mute
button will restore the sound to that channel.

e Balance Slider - Pan this channel to the right, center or left of the stereo field.

o AGC - Checking this box will enable automatic gain control on this channel.

e EQ Boost - Apply an EQ boost or cut based on the EQ settings in the tool menu.

e Options... - Clicking on this menu item displays an Options dialog box. (See Playback Settings
Options below.)

3.5.2. Playback Settings Options

The Options dialog box for playback settings allows you to enable Mute, AGC, Obfuscate or EQ Boost for
this channel. Mute, AGC and EQ Boost just have an Enable checkbox to turn the feature on and off. The

© 2025 Eventide Communications LLC
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obfuscate option allows you to garble the sound of voices on the channel so that the identity of the

speaker is obscured. The Amount slider allows you to adjust the amount the effect is applied to the audio.

Lius ey
Little Ferry
Little Ferry

Back Hallway

Volume: 50% Pan: None

AGC Enabled
EQ Boost Amount; = @

Fig. 3.16 Obfuscate Option

3.5.3. Resource Gain Defaults

mavuviey
0006 -
Inactivity

In the Tools menu, you will find Resource Gain Defaults, which opens to the above panel that allows you

to configure a default setting for the EQ, AGC and Gain for every resource name currently on the system,

so that every tab you open from then on will load these settings.

Resource Gain Defaults

Channel Name

EQ AGC VoL

Dispatch-EMS @ Reset Use Current
i Dispatch-Fire 0 0O —@=— Reset Use Current 5
: Dispatch-Police ) == Reset Use Current %
! EMS-East-1 0 0O =@= Reset Use Current
= -
mi EMS-East-2 D) === Reset Use Current m.
Ly EMS-West Q@ Reset Use Current ][

Fire-North @ Reset Use Current

Fire-West — @ Reset Use Current

PDW 0 0O —@— Reset Use Current

Police-10th DS o Reset Use Current

Police-41st 00 —¢ Reset Use Current

Police-80th B —@— Reset Use Current
o Cancel
N ——— priytoTab || Save || Cancel |

Fig. 3.17 Resource Gain Defaults



3. Viewing and Playing Recordings

Reset will return to factory defaults: EQ and AGC Off, Volume at Odb gain. Use Current will change the
settings to those set in the currently open tab; this is useful if you've gotten it “just right” and want to
save the settings for the future. Apply to Tab will apply all of the settings in this pop up to the open tab.
Save will save the settings and they will be applied when new tabs are opened.

3.5.4. EQ Settings

In the Tools menu, the EQ Settings menu option opens a pop up that allows you to set the amount of
signal boost or cut in a three band EQ. This allows you to tune the playback of call audio to improve
sound quality and compensate for lines that are too bright or muddy. One EQ setting is supported at a
time; you can either have it turned on for all channels here with Always On setting, or you can turn it on
for specific channels only as detailed above.

ck Hallway 2020-03-24 04:42:55-04:00 00:10
ck 9
k Lo—@ Mid —@ Hi —@ 3
| Always on =

|

Fig. 3.18 EQ Settings

3.5.5. Timeline View Menu Options
Selecting a recording in the Timeline view and then right-clicking on that recording causes the Timeline
View menu to appear.

The menu selections are the same as those in the Record View menu. Refer to the Record View Menu
Options for information about those menu items.

Note: When working in an Incident Tab, there is also a Remove option that can be selected; selecting
Remove From Incident allows you to remove the selected recording(s) from the incident.
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3.5.6. Timeline Zoom Options

The Timeline has zoom options that let you adjust how much call data you are looking at in a given
amount of horizontal space. This ranges in granularity from one second to one year.

Litue rerry vispaicn-rire

One Second

Five Seconds

Resource Name

Dispatch-EMS Ten Seconds
Volume: 50% FE

Thirty Seconds

Dispatch-Fire v "
Volume: 50% F One Minute
Dispatch-Police o v
Volume: 50% E Five Minutes
EMS-East-1 Ten Minutes 0
Volume: 50% E
EMS-East-2 Thirty Minutes b
)

Volume: 50% F One Hour

Six Hours

Twelve Hours

One Day

Two Days

Ten Days

Five Minutes v R
Thirty Days l

Sixty Days I

O Ninety Days

e} One Year |<

Fig. 3.19 Timeline Zoom Options

The Timeline has zoom options that let you adjust how much call data you are looking at in a given
amount of horizontal or vertical space. The horizontal ranges in granularity from one second to one year.
This grain affects what the distance between two markers on the timeline means. In the example below,
the zoom is set to one minute and the dark checkmarks in the timeline are one minute apart:
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2020-0-3-24 05:23:00-04:00 2020-03-24 05:24:00 -04:00 2

Resource Name

T T S U T N N N T T T T T T RO R |
Dispatch-EMS @ E] B E] @ B
Volume: 50% Pan: None
Dispatch-Fire "
Volume: 50% Pan: None
Dispatch-Police
Volume: 50% Pan: None
EMS-East-1
Volume: 50% Pan: None
EMS-East-2
Volume: 50% Pan: None

Fig. 3.20 Timeline At One Minute Zoom

The magnifying glasses with + and - signs can be used to increase or decrease the horizontal (time) zoom
level; the arrows change the vertical zoom. Shift+Click into the timeline will zoom in, Shift+Right-Click
will zoom out.

3.5.7. Full Timeline Mode

When using the “Search” Tab, MediaWorks EXP will now expand the Timeline view horizontally to offer a
larger Timeline window.

¢ By double clicking the divider between the calendar pane and the callgrid pane, MediaWorks EXP
will toggle between Standard View and Full Timeline Mode.

Tools  Playba ——
[ = ROHS1 | © InstantRecall @ Evaluations

@ Channels
Search Filters > Create Impound  Results as of 2022-02-04 17:02:39 -05:00 57records, Oselected  Q B €
Dot Source Name Channel Na... Start Time - Duration  Callerid  Dtmf
NLDX_VM_240100149 Channel 1 2022:02.0123:36:37 05:00 14:56
< FEB 2022 > NLDX_VM_240100149 Channel 1 2022-02:01 23:11:43-05:00 14:56
S M T WTF s NLDX_VM_240100149 Channel 1 2022-02-01 22:46:49 -05:00 14:56
= NLDX_VM_240100149 Channel 1 2022:02.0122:21:55 0500 14:56
2 3 5
L] NLDX_VM_240100149 Channel 1 2022:02.01 21:57:01 0500 14:56
6 7 8 9 10 M 12
NLDX_VM_240100149 Channel 1 2022:02:01 21:32:07 -05:00 14:56
1314 15 6 17 18 19
NLDX_VM_240100149 Channel 1 2022:02-01 21:07:13-05:00 14:56
20 21 2 23 24 25 26
o s NLDX_VM_240100149 Channel 1 2022.02.01 20:42:19 0500 14:56
~ NLDX_VM_240100149 Channel 1 2022:02.0120:17:25-05:00 14:56
() Use Time Range
NLDX_VM_240100149 Channel 1 2022:02:01 19:52:31-05:00 14:56
Resources ?| NLDX_VM_240100149 Channel1  2022-02-0119:27:37-05:00 14:56
B FSWES NLDX_VM_240100149 Channel 1 2022:02.0119:02:43 05:00 14:56
he‘ NLDX_VM_240100149 Channel 1 2022:02.0118:37:49 0500 14:56
Channel 3 NLDX_VM_240100149 Channel 1 2022:02:01 18:12:55-05:00 14:56
Channel 4 NLDX_VM_240100149 Channel 1 2022-02-01 17:48:01-05:00 14:56
ECZSZSZ NLDX_VM_240100149 Channel 1 2022.02.0117:23:07 -05:00 14:56
Channel 7 NLDX_VM_240100149 Channel 1 2022:02.0116:58:13 05:00 14:56
Channel 8 NLDX_VM_240100149 Channel 1 2022:02:01 16:34:16 -05:00 1027
NLDX_VM_240100149 Channel 1 2022-02-0116:09:22 05:00 14:56
NLDX_VM_240100149 Channel 1 2022.02.01 15:44:28 -05:00 14:56
NLDX VMM 240100149 Channel 1 2022.02.011519:34 0500 14:56
Resource Name o
Channel 1 = | | | |
e -
< >
00:00 00:00
Voluma ° 100%
o w P M0
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Fig. 3.21 Standard View
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@ Channels Q Search OHS1 | @ Instant Recall

Search Filters

Date Source Name:

< FEB 2022 >

O Use Time Range

Resources

- Resources

Resource Name

Channel 1 >

oneHowr v & T @ &

NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149

NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149

NLDX_VM_240100149
NLDX_VM_240100149

Channel Na...
Channel 1
Channel 1
Channel 1

Channel 1
Channel 1
Channel 1

Channel 1
Channel 1

@ Evaluations

Create Impound | Results as of 2022-02-04 17:02:39 -05:00

Start Time

~ Duration

Caller Id

Dimf.

2022-02-01 23:36:37 -05:00 14:56
20220201 23:11:43 05:00 14:56
2022-02:01 22:46:49 -05:00 14:56

RTIRG NLDX_VM_240100149 Channel 1 2022-02-01 22:21:55-05:00 14:56
. oo . NLDX_VM_240100149 Channel 1 2022-02-01 21:57:01-05:00 14:56
o o ors 1 NLDX_VM_240100149 Channel 1 20220201 21:32:07 -05:00 14:56
NLDX_VM_240100149 Channel 1 2022-02:01 21:07:13-05:00 14:56

20 21 22 23 24 25 2
Vs NLDX_VM_240100149 Channel 1 2022-02-01 20:42:19 -05:00 14:56

2022-02-01 20:17:25-05:00 14:56
20220201 19:52:31 -05:00 14:56
2022-02:01 19:27:37 -05:00 14:56

NLDX_VM_240100149 Channel 1 2022-02.0119:02:43 -05:00 14:56
NLDX_VM_240100149 Channel 1 2022:02-0118:37:49-05:00 14:56
Channel 3 NLDX_VM_240100149 Channel 1 2022-02.0118:12:55-05:00 14:56
Channel 4 NLDX_.VM_240100149 Channel 1 2022:02:0117:48:01 0500 14:56
g:::::: 2 NLDX_VM_240100149 Channel1 20220201 17:23.07 -05:00 14:56
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Channel 8 NLDX_VM_240100149 Channel 1 2022-02-0116:34:16-05:00 10:27
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20220201 15:44:28 -05:00 14:56
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Fig. 3.22 Full Timeline Mode

3.5.8. Headless View

|”

When configuring User Settings in NexLog Express, selecting the “Instant Recall” permission allows for a

large format view of the most recent calls on the recorder.
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Fig. 3.23 Headless View

3.6. Playing Audio Recordings

Once you have located recordings from the Browse, Search, or Incident tabs, you have several options
for playing the recordings. The following information describes the options for playing recordings in the
Sequential mode. In this mode, recordings are played one recording at a time, in the order in which they
appear in the record list. To change the play order, sort the list of recordings differently. Playback will
adapt to the new sequence. For information about playing recordings in the Mixed mode, see Playback
Modes.

To begin playing the audio from a recording, press the Play button in the Playback console at the bottom
of the screen (see The Playback Console). The first recording in the list will begin playing. Toindicate
which recording is currently playing a green arrow appears to the left of the recording in the Recording
pane, and the call’s row is highlighted in green.

Alternatively, select a recording and press Enter on the keyboard to begin playback, or press the
Spacebar on the keyboard to begin, pause, and resume playback. Once the first recording in the list has
been selected, the Spacebar can only be used to pause and resume play. To select another recording,
highlight the recording in the Record view or in the Timeline view and press the Enter key or double-click
on the new recording. The recording will start playing immediately. Use the Spacebar or Pause button to
stop playback and the Spacebar or Play button to resume playback.
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You may also use the sub-menu items in the Playback menu to control playback or right-click the desired
recording and select Start Sequential Playback from the drop-down menu.

3.7. Playing Screen Recordings

06:00:00

& |

n
. 8

s ‘3

Screen Playback

Screen recordings can be played back in the same way as Audio calls, but there are additional options
that relate specifically to screens. These options are configured via the Multimedia Display Options
window you can access via the View menu:
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Multimedia Display Options X

Default Multimedia Display

« Display in Canvas
Display in Application
Default Multimedia Orientation
« Split on Top
Split on Right l
Metadata Items to Display

Annotations
Block Access
Block Access Exceptions

) Block Access Info

Called Party
) Caller Id

Calling Party
. Calltype E
Channel Name
) Clip Details

Color Code W

Fig. 3.25 Multimedia Display Options

This allows you configure how multimedia recordings will be played back, and also allows for configuring
the real-time display of Metadata, discussed below. Display in Application is shown above; the screen
recording plays back in a floating window inside the MediaWorks EXP browser window. Display in
Canvas looks like this:

© 2025 Eventide Communications LLC



3. Viewing and Playing Recordings

Results as of 2020

yovvaier man zes ivauway = vaaune

Dispatch-Police TueMar242.. © @ X

Source Name Channel Name Start Time ~ Duration Caller Id Dtmf Calltype

9 LitioFery ———oispaahPolos |20200324055946-0600 J11d6 ||~ |
Little Ferry Traffic-Police-1 2020-03-24 05:54:22 -04:00  00:59 -
Little Ferry Traffic-Police-1 2020-03-24 05:56:20 -04:00  01:00 -

Resource Name
Dispatch-Police
Volume: 50% Pan: None
Police-10th

Volume: 50% Pan: None
Police-41st

Volume: 50% Pan: None
Police-80th

Volume: 50% Pan: None
Traffic-Police-1

Volume: 50% Pan: None

”‘OneMinute vi%

13 O o o L O e e

o st e s

A panel appears above or to the right of the search results (depending on the Multimedia Orientation
setting). This panel is called the Multimedia Canvas. It can also appear to the right of the call list:

Results as of 2020-03-24 11:53:43 -04:00

Source Name Channel Name
Dispatch-Police.
Little Ferry Traffic-Police-1

I Little Ferry Traffic-Police-1
Little Ferry Traffic-Police-1
Little Ferry Police-10th
Little Ferry Police-80th
Little Ferry Traffic-Police-1
Little Ferry Traffic-Police-1
Little Ferry Traffic-Police-1
Little Ferry Traffic-Police-1
Little Ferry Police-41st
Little Ferry Police-80th
Little Ferry Traffic-Police-1
Little Ferry Traffic-Police-1

Fig. 3.26 Canvas at Top

708 records, 1 selected  Rotate Canvas | &}
Start Time
2020-03-24 05:56:20 -04:00
2020-03-24 05:58:18 -04:00
2020-03-24 05:59:22 -04:00
2020-03-24 05:59:22 -04:00
2020-03-24 06:00:16 -04:00
2020-03-24 06:02:14 -04:00
2020-03-24 06:04:12 -04:00
2020-03-24 06:06:10 -04:00
2020-03-24 06:06:13 -04:00
2020-03-24 06:06:14 -04:00
2020-03-24 06:08:08 -04:00
2020-03-24 06:10:06 -04:00

ispatch-Police Tue Mar 24 2020 05:53:46 GMT-0400 (Eastem Daylig.. © & X

Resource Name
Dispatch-Police
Volume: 50% _Pan: None
Police-10th

Volume: 50% _Pan: None

TorOeIa000

Volume: 50% Pan: None

Police-80th
= volume: 50% Pan: None

[Z1=]

Traffic-Police-1
OneMinute v| & T

YTE—I

Fig. 3.27 Canvas at Right
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Fig. 3.28 Media Window Controls (Detail)

The top right corner of the media window contains these three buttons: Pop out to Application, Pop Out
to External Window, and Close. If popped out to the application level, the first button will show a minus
sign for “Collapse into Multimedia Canvas.”

MediaWorks DX

Dispatch-Police Tue Mar 24 2020 05:53:46 GMT-0400 (Eastern Daylight Time)

Fig. 3.29 Media Window Popped Out

When popped out to an external window, the multimedia record is still controlled by the Playback
Console in the main MediaWorks EXP window. It also just has an X for Close in the upper right corner,
which will pop the call back into the main window.
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MediaWorks DX

Metadata

RSOS_RG_LOCATION : (-71.459,-115.531) * CALLER_ID : 6255309222
RSOS_RG_LOCATION : (-81.999,-113.001) - CALLER_ID : 9143820022
RSOS_RG_LOCATION : (-43.999,-134.001) + CALLER_ID : 9163664024
RSOS_RG_LOCATION : (-82.999,-115.999) « CALLER_ID : 7325310893

RSOS_RG_LOCATION : (-16.999,103.001) « CALLER_ID : 7329403578
RSOS_RG_LOCATION : (-43.999,-100.999) * CALLER_ID : 7327698012

Fig. 3.30 Real-Time Metadata Panel

The Metadata Panel shows a list in chronological order of the metadata associated with calls played back
from this search, browse or incident. The line in bold is the current or most recently played call. This lets
you highlight the specific metadata you want to keep track of as you play calls.

3.8. The Playback Console

The Playback Console, located at the bottom of the browser window, allows you to control all aspects of
playing recordings. From the Playback Console, you can adjust the volume and speed of the recording(s)
being played:

¢ Volume - Use this slider to increase or decrease the master audio volume. Moving the slider to the
right increases the volume; moving it to the left decreases the volume. Pressing the 100% button to
the right of the slider will reset the slider to the default center position.

e Speed - Use this slider to increase or decrease the playing speed of the recording(s). Moving the
slider to the right increases the speed; moving it to the left decreases the speed. Pressing the 100%
button to the right of the slider will reset the slider to the default position.

[ )
Channel 27
I< ’ ’I CD] 00:20 00:30

Fig. 3.31 Playback Console

The buttons in the center of the console include (from left to right):

e Previous Recording - If playback is less than 3 seconds into the recording, moves to previous
recording in the selected sequence. If playback is more than 3 seconds into the recording, resets to
the start of the current recording.
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¢ Play/Pause - Plays any highlighted recording, pauses if currently playing, or resumes playback after
pausing.

¢ Next Recording - Moves to the next recording in the selected sequence.

e Loop - Loops playback for the selected recording or recordings. For sequential playback, this is the
beginning and end of a recording or the loop boundary settings within a single recording. For mixed
playback this is the loop boundary settings anywhere within the timeline.

To the top of the console are the following additional tools:

o Slider - The slider on top of the console allows you to change the playback position. This is known
as scrubbing. You can scrub at any time during playback. To quickly move to a different spot within
arecording, click and drag the scrub slider. While scrubbing, keep track of the position by watching
the playback time indicator.

¢ Skip - The double-arrow buttons on each side of the slider allow you to Skip Forward (>>) or Skip
Back (<<).

While arecording is being played, its attributes scroll from right to left in the area above the playback
controls. This information includes the recording’s channel name, recording time and length of the
recording. The information in the area above the slider includes the current playback time. If you click
inside this area, it will switch to show the total length of the recording (on the right) as well as current
playback position (on the left).

The Playback Console can be displayed in two modes: Static Playback Console (at the bottom of the
page) and Floating Playback Console . The mode can be switched at any time from static to float by
clicking arrow button in the upper right corner of the Static Playback Console. Once enabled, the
Floating Playback Console will be displayed in the upper right corner of the tab by default, but it can be
moved around the window. To change the mode back to static, click x close button in the upper right
corner of the float console.

ha @ |4 » P O @

ha....e. —. e e e

hannel 27 2020-03-19 00:04:29 -04:00 00:30

Fig. 3.32 Floating Playback Console
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The Playback Console state is global for all tabs, except Channels tab and Evaluations tab and saved
between the loads. The Static Playback Console is located at the bottom of the browser window. Once
started in one tab, the playback can be controlled with the same console in other tabs. Playback Console
is displayed as blue in active tab, where the calls are playing from and grey - in other tabs.

Anytime the Playback Console mode can be switched from static to float by clicking arrow button in the
upper right corner of the Static Playback Console. Once enabled, Float Playback Console will be
displayed in the upper right corner of the tab by default, but it can be moved around the window. To
disable Float Playback Console, click x close button in the upper right corner of the float console.

3.9. Playback Modes

MediaWorks EXP supports two modes of playback: sequential and mixed. Recording data can be
streamed from an Eventide recorder or from a remote incident containing embedded audio data.
Optionally, playback can be modified to include “Time Marker” information at the start of each recording.

3.9.1. Sequential Playback Mode

Sequential playback occurs on one recording at a time. The order in which recordings play is determined
by the record view. To change the order in which sequential playback operates, change the sort order of
the record view.

To begin sequential playback, select Start Sequential Playback from the right-click context menu in the
Record view or Timeline view. Alternatively, you can double-click a recording or highlight a recording and
press the Enter key.

3.9.2. Mixed Playback Mode

Mixed playback will play back recordings in the timing that they actually occurred. Mixed Mode playback
is also referred to as ‘real time playback’. The order in which recordings plays is determined by the start
time of the recording. Mixed playback always proceeds in time order, from earliest to latest. If you are
examining recordings from multiple channels, the case may be that multiple recordings occur at the same
or overlapping times.
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For example, if audio was recorded on a channel named “Dispatch 1” at the same time audio was
recorded on a channel named “Emergency 5” the audio for both recordings will be played back at the
same time. When audio is playing in Mixed mode, you can easily follow the progress in the timeline,
which highlights all playing recordings across all channels.

3.9.3. Mixed Playback of a Single Resource/Channel

Single timeline resource/channel can be played back in mixed mode. This is useful for playing back a
single talkgroup or resource while looking at search results or instant recall on more than one timeline
resource at a time. In order to active Single Resource mixed playback hold down the Ctrl key while
viewing the properties menu and select “Select Resource Mixed Playback.”

3.9.4. Mixed Playback of Currently Selected Call Records Only

You can playback only a selected subset of calls in the timeline, in mixed mode. Use Ctrl+click to

select multiple calls from the timeline or the call list, and then right click one of the selected calls and
choose “Start Mixed Playback.” This will then play in real time all of the selected calls and no other calls.

3.9.5. Quick Playback from Timeline Header: Click to Play

You can click in the timeline header (where the time is displayed along the top) to start mixed playback at
any point. We call this “click to play.” If you have started calls in sequential mode, a click to play will follow
suit and play in sequential mode. You can switch it back to Mixed by right-clicking in the Timeline header
and selecting “Start Mixed Playback.”

3.10. Playback Audit

MediaWorks EXP now offers a played audio indicator to let users see previously played recordings.

Under the “View” dropdown in the menu bar, select “Show Playback Audit”
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Theme » NeXLOG

Multimedia Display Options

9records, 1 selected | RotateCanvas Q0

v Enable Geo-Display
Icons and Markers >
Connection Information
Alarms
Reports

Archives

== Play Audible Alarm
Source Name Channel N; ¥ Follow Playback allerid  Dtmf
NLDX_VM_240100149 Channel 3 Show Playing Record Ctri+Alt+C

NLDX_VM_240100149 Channel 3 = v Show Playback Audit N
NLDX_VM_240100149 Channel3 | coiumn Defaults
NLDX_VM_240100149 Channel 3

NLDX_VM_240100149 Channel 3

NLDX_VM_240100149 Channel 3 S

| > Mioxcwczioraons chamels — a0z 21 0w o500 40—
NLDX_VM_240100149 Channel 3 2022-01-21 10:20:00 -05:00 14:56
NLDX_VM_240100149 Channel 3 2022-01-21 09:55:06 -05:00 14:56

Fo0T 2T 104700 05

Save Current Columns Layout as Default

Resource Name

Channel 3 >]

" A
One Minute v &

i 14:56
Volume e » Channel 3
I I ’I (’) ]‘ 20220121 104831 0500 _

Fig. 3.33 Show Playback Audit

With this function enabled, the user now has a visible indication of any recordings that have been
previously listened to.
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© Channels | i= Browse & ROHS1 b NexlLoG

Properties and Notes | | Export Impound | B Quarantine 9records, 1 selected  Rotate Canvas | Q. @

Channel 3 Fri Jan 21...

Source Name Channel Na... Start Time ~ Duration Callerid  Dtmf
e NLDX_VM_240100149 Channel 3 2022-01-21 13:14:18 -05:00 14:56
o NLDX_VM_240100149 Channel 3 2022-01-21 12:49:24 -05:00 14:56
e NLDX_VM_240100149 Channel 3 2022-01-21 12:24:30 -05:00 14:56
o NLDX_VM_240100149 Channel 3 2022-01-21 11:59::
® NLDX_VM_240100149 Channel 3 2022-01-21 11:34:
e NLDX_VM_240100149 Channel 3 2022-01-21 11:09::

| D [NLDX VM 240100149 | Channel 3 |2022-01-21 104454 -05:0014:56 I

NLDX_VM_240100149 Channel 3 2022-01-21 10:20:00 -05:00 14:56
NLDX_VM_240100149 Channel 3 2022-01-21 09:55:06 -05:00 14:56

F00 P022-01 21 104500 0500 2022-01-21 10:46:00 0500 2022-01-21 104701
Resource Name

Channel 3 >]

OneMinute v & 1 @& ©
01:07 [FTT™ 14:56

Volume e 100% » Channel 3
Speed  emu— 100% I< Il ’I C) ]‘ 2022-01-21 10:46:01 -05:00 -

Fig. 3.34 Playback Audit

e Grey Dot shows any records listened to in a past session

Source Name Channel Na... Start Time ~ Duration
LDX_VM_240100149 Channel 3 2022-01-21 13:14:18 -05:00 14:56
LDX_VM_240100149 Channel 3 2022-01-21 12:49:24 -05:00 14:56
LDX_VM_240100149 Channel 3 2022-01-21 12:24:30 -05:00 14:56
LDX_VM_240100149 Channel 3 2022-01-21 11:59:36 -05:00 14:56

Fig. 3.35 Past Session Indicator

¢ Orange Dot shows recordings listened to in current active session

NLDX_VM_240100149 Channel 3 2022-01-21 11:34:42 -05:00 14:56
NLDX_VM_240100149 Channel 3 2022-01-21 11:09:48 -05:00 14:56

Fig. 3.36 Current Session Indicator
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3.11. Speech Factor Al Transcriptions

MediaWorks EXP now features Speech Factor Al Transcriptions, an optional Al-based transcription
product that can be configured for NexLog DX-Series recorders. When enabled, this feature offers the
ability to transcribe calls as they record, including the ability to record multiple participants during a call.
If recordings are separated, Al Transcriptions generates a transcription with each speaker listed
individually, providing the ability to generate analytics across all lines.

Speech Factor Al Transcriptions can either run in a hosted cloud environment where encrypted packets
summarizing audio are sent to a secure server for analysis, or can be hosted on an on-premises server
sold by Eventide Communications.

Speech Factor Al Transcriptions includes the following features:

e Background Transcriptions
e Manual Transcriptions
e ‘Boost’ Transcriptions

Speech Factor Al Transcriptions can be enabled and configured either to run automatically in the
background or configured manually. You can transcribe specified channels either in real-time
(Background Transcriptions Mode) or can select an individual recording for transcription (Manual
Transcriptions Mode) to provide quick and accurate transcriptions of calls and events.

The ‘boost’ transcription feature provides ways to improve the accuracy of Al transcriptions. Each of
these transcription modes is covered in detail in the sections that follow.

P License Required

Speech Factor Al Transcriptions requires the following Eventide Communications product license
for the Al Transcriptions Service.

e DX928 - Speech Factor Al Analytics T1

If your NexLog Express recorder is enabled with this license, you can transcribe recordings in both

Background Transcriptions mode and Manual Transcriptions mode.
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Background Transcriptions mode and Manual Transcriptions mode were previously known as
‘Always On’ mode and ‘On Demand’ mode. Each mode required a separate license historically. Now
only a single license is required, as noted above. Cloud-hosted “Background Transcriptions Mode”

recording is sold on an annual basis and is licensed per resource/channel to be transcribed.

3.11.1. Configuring Speech Factor Al Transcriptions

You can configure a NexLog Express recorder for Speech Factor Al Transcriptions. For Speech Factor Al
Transcriptions to work, you must first set up a resource group from the web configuration manager of
your NexLog DX-Series recorder. For more information, see the NexLog DX-Series User Manual 7.3.4.
Resource Groups.

This section covers the configuration of each of the following Speech Factor Al Transcriptions features:

e Background Transcriptions
e Manual Transcriptions
¢ ‘Boost’ Transcriptions

To configure Speech Factor Al Transcriptions, you must add the license key to the NexLog DX-Series
recorder.

3.11.2. Adding the Speech Factor Al Transcriptions License

To add the Speech Factor Al Transcriptions license to the recorder:
1. Sign in to the source NexLog DX-Series recorder’s Configuration Manager with your credentials.
2. Have your 20-digit Speech Factor Al Transcriptions license key ready.

3. In the left navigation menu, select System — License Keys.
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NEW LICENSE KEY

I License Key: [ |

Serial Number: 240 =it
System Info

Date and Time

Add Cancel

Storage Devices

Fig. 3.37 Entering the License Key

4. In the right pane, select the Add Key button.
5. Inthe License Key field, enter your 20-digit Speech Factor Al Transcriptions license key.

6. Confirm that your Speech Factor Al Transcriptions license now appears in the License Key column.
It will be listed as ‘Cloud Transcription’. Your license is now active.

11982264198500003913

Num MediaWorks Mobile DX Connections: 5

Comm-Tech(Solacom) NG911 Call Recording Bundle (Voice, Metadata and SMS): 1
SipRec Recording: 1

Add-on

06769799583894173380
Add-on Advanced Evaluation Scheduling: 1
Transcription(Always On): 1

e 14674913620853085698
Integrations: [RapidSOS_RAD]

05293281330744712477

Vesta i3 Call Handling: 1

Add-on

Fig. 3.38 License Added

3.11.3. Background Transcriptions

Background Transcriptions refers to the Speech Factor Al Transcriptions feature that can be enabled to
automatically transcribe audio calls as they record in real-time. You can read the transcripts as they
happen and instantly search for words or phrases.

The number of channels that can be configured for simultaneous transcription in Background
Transcriptions mode is determined by the number of channels purchased for the Speech Factor Al

Analytics T1 license.
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To enable Background transcriptions and apply them to call recordings, you must access the Al ->

Transcriptions navigation menu of your NexLog Express recorder’s web configuration manager and
enable the Background Transcriptions integration.

To enable background transcriptions:

1. In the left navigation menu, select Al -> Transcriptions. The Transcription page opens.

Home TRANSCRIPTION

System
Integration Enabled

Networking Call Pointer Date/Time:

[ (=] (o0 v |- |00 v [00 v

Recording

Call Pointer Mode: | Start Time v

Al

Channels: B \

Assistants Channel Group: [ Select a channel group v

System Languages: [English (United States) v

Transcriptions English (United States)

; Boost Phrase and Value: B ( |15 (More Likely) v Add Boost

Find And Replace: 7] [ [ Add Mapping
d Se

View Logs Export Logs

Service Account Key Uploaded: ©)

Upload Service Account Key: [ Choose File | No file chosen Upload

Cencel

Fig. 3.39 Enabling Background Transcriptions

2. Make sure that the Integration Enabled checkbox is selected.
3. Under Call Pointer Date/Time, select the calendar icon and then select a date to populate the field.

4. To the right of Call Pointer Date/Time, select the time in hh:mm:sec for each of the three drop-
down menu fields to specify when transcriptions will start.
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Enable Automatic Processing:

Call Pointer Date/Time: [2025-01-01 [06~]:[00v]:[00+v]

Fig. 3.40 Selecting the Date and Time

5. Under Call Pointer Mode, select Start Time. Call Pointer Mode specifies the date and time at which
Al Transcriptions will start transcribing call audio.

6. Channels: specifies which channel(s) will automatically enable transcriptions. You can select an
individual channel or a range. However, the preferred method is to select a Resource Group instead
to transcribe calls. If you choose this method, you can leave the Channels category blank.

7. From Resource Group: select a Resource Group to use to automatically transcribe calls.

8. In the Languages drop-down menu, choose your language. Speech Factor Al Transcriptions
supports multiple languages:

e en-US - English (US)

e es-US - Spanish (US)

e fr-CA - French (CA)

e fr-FR - French (FR)

e de-DE - German (DE)

e ar-AE - Arabic (United Arab Emirates)
e it-IT - Italian (Italy)

You can add up to four languages, which are then listed on-screen. The default language is “English
(United States)”.

Additional supported languages include Russian and Japanese. To request more language code

options, contact service@eventidecommunications.com for more details.

1. Service Region: specify the processing region for transcriptions.


mailto:service%40eventidecommunications.com
mailto:service%40eventidecommunications.com
mailto:service%40eventidecommunications.com
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Resource Group:

Languages: | English (United States) v

English (United States)

Service Region: | Select a Region v

Fig. 3.41 Selecting Resource Group, Language, and Service Region

Once you have configured Background Transcription mode, MediaWorks DX will now automatically
generate Speech Factor Al Transcriptions on all enabled resources in the background.

3.11.4. Manual Transcriptions

You can also configure transcriptions manually. Just as in Background Transcriptions mode, in Manual
Transcriptions mode, you can generate manual Al transcriptions on any channel or recording by
configuring and enabling the Manual Transcriptions integration from your NexLog Express recorder’s
Web Configuration Manager, under Al -> Transcriptions.

To generate manual transcriptions:
1. In the MediaWorks DX user interface, select a call.

2. Right-select the call and choose Generate Transcription.
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& Restore Incident

Results as of 2025-02-05 13:42:16 -05:00

40records, 1selected Q B

Cha.. SourceName  Channel Name Start Time Duration  Callerid  Dtmf Speech  AiSum.. AicCallT.. RecordID
131 Nexlog 183 911 Pos 1(De) 20220602 19:44:33-04:00  01:59 6108 = man. 6301 Excuse me. Motor vehic Police uBVXNIRDYTI
131 NexLog 183 911 Pos 1(De) 2022-06-0220:13:20-04:00  02:09 6108 6301 Yeah, somel Caller report Police vZcOBUIBNTr
| o Nestog105 511 ros 09— 0220070007155 0400 o020 e el ansomen
131 NexLog 183 911 Pos 1(De) 20220610 10:43:35-04:00  01:30 610 | et bri Police fAVPVRgOmE
131 NexLog_183 911 Pos 1(De) 20220610 12:16:17-04:00  02:03 610¢ B Police 100VjOKIVEPS
New Incident from Selected Records ) |
131 NexLog 183 911 Pos 1(De) 20220610 12:43:25-04.00  00:35 610¢ Id: Accidental 1101sXcfhali
131 Nexlog_183 911 Pos 1(De) 2022-06-1013:21:12-04:00  01:01 grof  Create SearchFilter from 2672716262° By ooice weLSKWpVg:
131 NexlLog 183 911 Pos 1(De) 2022-06-10 14:08:26-04:00  01:48 610] AddSelectedtoincident * ip Police mrote7X5bi0
131 Nexlog.183 911 Pos 1(De) 20220610 14:53:27-04:00  01:06 610¢ Evaluate Records * div Police A10ja5P8hqt
131 NexLog 183 911 Pos 1(De) 20220610 15:04:24-04:00  01:55 850¢  Start Sequential Playback fac Police TniC8s528Vn
131 NexLog.183 911 Pos 1(De) 20220610 15:12:24-04:00  01:47 610f  Start Mixed Playback bri Police chqelUv4oBX
131 Nexlog_183 911 Pos 1(De) 2022-06-10 16:09:46 -04:00 02:11 2678 Export Ctri+aitsg 18 Police e6BUPrS4yJ
Y ¢ ]
131 Nexlog 183 911 Pos 1(De) 20220610 16:38:54-04:00  00:15 6108 ¢, ot Single Recording id: Accidental dcarglfkoGN
131 NexLog_183 911 Pos 1(De) 2022-06-10 17:05:58 -04:00 01:38 610% lv Police onB4kyd4ulD,
Export Using Preset »
131 Nexlog.183 911 Pos 1(De) 20220610 19:22:31-04:00  00:33 610§ fu Accidental W5eppNyqgH
Add Text Annotation
131 NexLog_183 911 Pos 1(De) 2022-06-10 19:43:35-04:00 00:18 610¢ ¢ Accidental JviJKo1pB3g
131 Nexlog 183 911 Pos 1(De) 2022-06-10 21:52:14-04:00  01:45 21 A\ Audio Annotation Police 7eWSKXGI8O)
131 Nexlog_183 911 Pos 1(De) 2022-06-10 23:03:54 -04:00 00:19 61 0{ Generate Transcription nc Accidental HAvszs76Ny:
131 NexLog 183 911 Pos 1(De) 2022-06-10 23:28:28-04:00  00:09 610¢  Search in record ¢ Accidental WTRyMgrojd
131 NexLog_183 911 Pos 1(De) 2022-06-02 12:36:52 -04:00 00:27 267¢ Al Assistant » jdi Accidental DkBLSTcuwx]
Resource Name
911Pos 1(0e) Bl g

Fig. 3.42 Generating Manual Transcriptions

The call transcription is now generated and displayed in the Call Properties dialog on the

Transcription tab.

Properties

Transcription

Transcription

User Edited Transcription

All History

Format @

Call Properties

Al

Transcription

Hi. This is 911. Your phone just called here. Is
everything okay?

Talker 1

911.
Talker 0

-1011:3

2022-06-10 11:37:27 04:0
Yeah, your phone just called here. Is everything, okay?
Talker 1 2022-06-10 11

Oh yeah, just, uh, uh, | probably call it by accident. I'm
here right now just a, uh, Springfield Police Department.

Fig. 3.43 Manual Transcriptions
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3. As before, from your MediaWorks DX user interface, right-select a recording and then select
Generate Transcription.

Manual Transcriptions mode is billed by the number of hours of recordings transcribed,

available in quantities of 1000 hour increments.

4. Sign in to your MediaWorks DX user interface.
5. Right-select a recording and then select Generate Transcription.

Once you have configured your choice of Transcription mode, MediaWorks DX will now automatically
generate Speech Factor Al Transcriptions on all enabled channels in the background. You can now search
for and view your transcriptions in MediaWorks DX.

See Searching for Transcriptions in MediaWorks DX for more information.

3.11.5. Configuring Boost

The ‘Boost’ feature provides ways to correct words or multi-word phrases that Al may mis-transcribe.
Mis-transcriptions may occur either because Al interprets a word or phrase as very similar to one found
inits Al model, or because it is not found in it.

‘Boost’ increases the likelihood that Al will correctly transcribe a word or phrase. The best strategy to
use to have Al correct its transcription depends on whether the word or phrase is found in Al’'s model.
Here, trial-and-error is required because there is no way to know this in advance.

3.11.5.1. Before Configuring Boost

Before configuring Boost for a customer, Eventide Communications suggests monitoring how
transcription is working practically in the real world, by looking at 911 calls. Note that Boost is only
required if issues exist to be resolved. As an important example, is the Agency Name being correctly
transcribed? Is there a specific pattern of mis-transcribed words or phrases? If not, configuring Boost
may not be needed currently.
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If a specific transcription problem(s) exists, set up Boost, then monitor again.

3.11.6. Using Boost

The ‘Boost’ feature is best explained by presenting some practical use cases. Three practical real-world
examples now follow. The first two examples assume that a word or phrase is found in Al’'s model.

Example 1:

Suppose you have two similar or identical-sounding valid words, such as ‘whether’ and ‘weather’, and that
both words are found in Al's model. If you wanted the word ‘whether’ to be the more frequently-
transcribed word, you would assign it a greater weight using Boost.

To boost a word or phrase:
1. In the Boost Phrase field, enter the desired word, ‘whether’.

2. In the Boost Value field to the right, from the drop-down menu, select the highest weight value ‘20
(Very Likely).

3. To the immediate right in the Boost Value field, from the following drop-down menu options,
choose ‘20 (Very likely)'.

¢ O (Very Unlikely)
e 5 (Unlikely)

e 15 (Likely)

e 20 (Very likely)

4. Select the Add Boost button.

Boost Phrase and Value: [whether [20 (Very Likely) 1| [ AdaBoost
0 (Very Unlikely)
5 (Unlikely) Add Mapping

Find And Replace: @ [

15 (More Likely)

View Logs Export Logs

Fig. 3.44 Boosting a Word or Phrase for Transcriptions
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Following this procedure maximizes the probability that Al will choose “whether” over “weather”, the
majority of the time.

Example 2:

Similarly, suppose your agency name is ‘Barton County’, but Al mis-transcribes it as ‘Pardon County’. The
assumption is that this is because although the phrase ‘Barton County’ is found in Al’'s model, it is not at
the top of the list of Al's phrases. In this case, you can boost ‘Barton County’ so that it is correctly
transcribed.

1. In the Boost Phrase field, enter the (correct) phrase, ‘Barton County’.
2. Inthe Boost Value field, select the greatest value “20 (Very Likely)”.

3. Select the Add Boost button. ‘Barton County’ is now likely to be transcribed the majority of the
time.

0 (Very Unlikely)

Boost Phrase and Value: Barton County [20 (Vvery Likely) v |

Find And Replace: & 5 (Unlikely) | | Add Mapping
[15 (More Likely)
View Logs Export Logs ‘
20 (Very Likely)

Fig. 3.45 Configuring the Boost Value Field

Similarly, add additional words or phrases as per customer requirement. Service Provider technicians
should boost the end customer’s Agency Name. Each added boost phrase becomes listed on-screen with
its corresponding boost value.

Conversely, had you assigned the lowest weight of “O Very Unlikely” to ‘Barton County’, this would
minimize the likelihood of ‘Barton County’ being transcribed, as opposed to similar-sounding phrases in
Al's model. If this strategy fails, the word or phrase will likely not be found in Al's model.

Example 3:

In this example, the assumption is that a mis-transcribed word or phrase is not in the Al's model. This
scenario requires a different strategy consisting of just two steps. Continuing with the “Barton County”
example, again, suppose that phrase is mis-transcribed as ‘Pardon County’. In this case, ‘Barton County’ is
unknown to Al. To remedy this consists of a two-step procedure.
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In step one, what we can do is boost ‘Pardon County’— the mis-transcribed word —which is in Al’'s model.
(The reason for this will be made clear in step two). This gives ‘Pardon County’ the highest weight among

similar phrases known to Al. The result is to increase the likelihood that the Al will transcribe that

phrase.

In step two, we can use Search and Replace to create a fixed, one-to-one mapping between the mis-
transcribed phrase, ‘Pardon County’, and ‘Barton County’, so that Al is now highly likely to transcribe
‘Barton County’ over any other phrase the greatest percentage of the time. The following procedure

illustrate this.

To map a boosted word or phrase to another using find and replace:

1. In the Boost Phrase field, enter ‘Pardon County’, the mis-transcribed phrase.

2. In the Boost Phrase Value field, from the drop-down menu select “20 (Very likely)”.

Boost Phrase and Value: ] Pardon County 15 (More Likely) v 'Add Boost

Pardon County,20 [ Boost mistranscribed phrase.

Find And Replace: £ Pardon County Barton County

Pardon County — Barton County

Map mistranscribed
View Logs Export Logs phrase to correct phrase.

Fig. 3.46 Boosting a Word or Phrase Using Find and Replace

3. Select Add Boost.

4. In the Find field, enter ‘Pardon County’.

5.In the Replace field, enter ‘Barton County'’.

6. Select the Add Mapping button. This mapping now maximizes the likelihood that Al will correctly
transcribe ‘Barton County’ instead of ‘Pardon County’.

7. Repeat this process to configure replacement words for unknown names, adding word or phrase

mappings as required. Each new mapped pair will appear on-screen across the page.

8. Leave the Service Account Key section as-is. The Service Account Key will have been uploaded

earlier already by an Eventide Communications technician, as indicated by the green check mark in

the next screenshot.

9. By default, only configure the ‘911 Positions’ Resource Group for transcriptions.
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Service Account Key Uploaded: ®

Upload Service Account Key: [ Choose File | No file chosen Upload

Fig. 3.47 Service Account Key

10. Select Save.

3.11.7. Searching for Transcriptions in MediaWorks DX

You can search for, and view your transcriptions in MediaWorks DX using the Transcription Tab search
function. Transcription Tab Search is a robust search filter option that gives you the ability to find
keywords directly from call transcriptions.

To search for transcriptions:
1. Sign in to MediaWorks DX with your credentials.

2. Select the Search icon.

Dtmf Record ID Speech —————
6311 LE9e6BNylQQIJH7I Yes, this is Philly. You just took my bike w§/se|ect the J. And
16311 | HQUXHRZI4YoAQSFp Search icon. |
6311  JGKKEVDY5d3QxQwq - B

6311  fGOAY2C6Pjepj5f3

6311  4dY3blCZmagPgApb

6311 WFr1rOOtHYirLrex

6311  stfNepwt8QSM8uT8

6311  pXViqy9pEG44VBDC

12:08:00 -04:00 2022-06-08 12:09:00 -04:00 2022-06-08 12:10:00 -04:00 2022-06-08 12:11:00 -04:00
o e o b o e o o o b o

i bbbttt £t

Fig. 3.48 Select Search Icon

The Al Transcriptions Search Tab dialog appears.
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NexLoc

13 records, 1 selected B

mf Record ID Transcription Tab Search
11 LE9e6BNylQQIJH7I Yes, tl
i aosmaoirs 3
11 JGKKEVDv5d3QxQwq

11 fGOAY2C6Pjepj5f3 Probability Results
11 4dY3bICZmagPgApb

11 WFr1rOOtHYirLrex

11 stfNepwt8QSM8uT8

11 pXVigy9pEG44VBDC

[C] Use selected calls only

| Use best guess only

————————————————
8:00 -04:00 2022-06-08 12:09:00 -04

- | [ DT
(N did o 1D
it AL

The text is an approximation and errors are expected. It's possible
that search terms will be missed. Results should be verified by
listening to the audio.

Fig. 3.49 Transcriptions Tab

3. Inthe Transcription tab Search window, type a search term in the search field and then select Go.
All available transcription records that contain your search term will be listed in the Transcription

tab Search window.
4. Select a target call from the results to listen to it.

5. To view the transcription, hover your mouse at the bottom of the timeline over the thin grey bar.

The transcription text now becomes visible.

6. To confirm the accuracy of transcription results, listen to the call audio by selecting a call listed in
the Transcription Tab Search window. Each call is shown with a green right-pointing arrow.
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rld Dtmf Record ID Speech

m Yes, this is Philly. You just took my bike with a gun. You know, 7 second. And|
110016 6311  HQUXHR2I4Yohaass
885600 6311 fGOAY2C6Pje [ | Use selected calls only

110033 6311  4dY3bICZmag ‘Philly
110030 6311 WFr1rOOtHYir

[] Use best guess only

Probability Results
112019 6311 stfNepwt8QSh 57% Yes, this is Philly. You just took my bike with a gun. ...
515270 6311 pXVIgy9pEG4: B 919, ... your emergency? In Philly. You're in. Stay on the ...

-
2022-06-08 12:05:00 -04:00 04
TR | ' ' | il

The text is an approximation and errors are expected. It's possible that search terms
will be missed. Results should be verified by listening to the audio.

Fig. 3.50 Transcription Tab Search

You can view Transcriptions in recordings by hovering your mouse towards the bottom of the timeline,
onits grey section, and also within the recording’s call properties.

3.11.8. External Media

Speech Factor Al Transcriptions allow for external media such as voice, text, photos, and videos to be
uploaded to the recorder for transcription, analysis, and exporting.

3.11.9. Radio Transcription

Speech Factor Al supports radio transcription. Quality of transcription may vary based on the input
source.

© 2025 Eventide Communications LLC



4. Creating an Incident

4. CREATING AN INCIDENT

In MediaWorks EXP, an incident contains a group of related recordings. To find recordings, see Browsing
for Recordings and Searching for Recordings. Once a set of recordings has been found, the next step is to
group them into related sets known as “incidents.” New incidents can be created from a selection of
recordings, and additional recordings can be appended to existing incidents. Incidents form the
foundation for many of the other MediaWorks EXP functions, such as exporting recording data.
Incidents can also be shared with other users by emailing them or saving them to a shared location on the
Eventide recorder.

Incidents can be stored remotely on the recorder. To create a new incident, select New Tab from the File
menu and then select Incident from the drop-down list. An empty Incident tab labeled “Untitled” will be
created. To create a new incident with an initial set of recordings, first select the recordings from the
Record view or Timeline view. Then right-click and select New Incident from Selected Records from the
drop-down menu. A new incident tab labeled “Untitled” will be created containing the recordings you
selected.

<« > > O

Fig. 4.1 Incident

An incident can also be populated with recordings in several other ways. From the Browse or Search tab,
a group of recordings can be copied to an incident tab using drag-and-drop. With the Browse or Search
tab open, select one or more recordings. Then click the selected recordings and, while holding the mouse
button down, drag the recordings to the new Incident tab. Release the mouse over the Incident tab and
the recordings will be added to that incident.

When Browsing for Recordings or Searching for Recordings, calls that have been saved to an incident will
have a visual indicator when the “Incident” column is selected.
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i= Browse

Search

Date

25

Resources

E-8 Resources

Channel 2
Channel 3
Channel 4
Channel 5
Channel 6
Channel 7
Channel 8
Channel 9

Q Search

DEC 2022 >

4 5] 6 7 8 0
o v ISR

26 27

Use Time Range

Channel 1

Filters

W T F s

1 2 3
9 1

22 23
29 30

24

28 31

= |

SEARCH

ds

© Instant Recall

Results as of 2023-01-05 11:12:03 -05:00

Source Name
DO 24510013 hamel 20221220 125938 0530
NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149
NLDX_VM_240100149

B Evaluations

Channel 1
Channel 1
Channel 1
Channel 1
Channel 1
Channel 1
Channel 1
Channel 1
Channel 1
Channel 1
Channel 1
Channel 1
Channel 1

& 12/22 incident

Channel Na... Start Time

NexlLoc
QBE®

436 records, 1 selected

Caller Id

Duration

2022-12-18 21:09:14 -05:00 14:56
2022-12-20 12:34:44 -05:00 14:56
2022-12-20 12:09:50 -05:00 14:56
2022-12-20 11:44:56 -05:00 14:56
2022-12-20 11:20:02 -05:00 14:56
2022-12-20 10:55:08 -05:00 14:56
2022-12-20 10:30:14 -05:00 14:56
2022-12-20 10:05:20 -05:00 14:56
2022-12-20 09:40:26 -05:00 14:56
2022-12-20 09:15:32 -05:00 14:56
2022-12-20 08:50:38 -05:00 14:56
2022-12-20 08:25:44 -05:00 14:56
2022-12-20 08:00:50 -05:00 14:56

Channel 1

One Minute v

Resource Name

[]

A v
v A

|

—
0 12:56:00 -05:00

2022-12-20 12:57:00 -05:00 2022-12-20 12:58:00 -05:00

Fig. 4.2 Incident Indication

All saved Incidents can be seen by right-clicking a call in the callgrid and hovering over “Open Incident”. If

an instance is selected from this section, it will open in a new tab.

Additionally, Incidents can be opened by going to File > Open Incident and selecting a file from the “Open

Incident” window.

Recorder

» [0 01_owner
» [0 01_read
» [ 01_write
» [ 1Folder
» (] DELETE
(L FOLDER1
v [ NAB
1 NAB2
» [ Restrict01
» [ Restrict1
-~ Location 2
" Geo-Location
| Location
" screens

Upload

4+ New Folder | SortBy Modified

v -

Be s

Location 2

DESCRIPTION:
MODIFIED:

2023-10-24 13:14:03 -04:00
OWNER:

Eventide

READ/WRITE:

No

READ/WRITE USERS:

READ ONLY:

Yes

READ ONLY USERS:
RESTRICTED INCIDENT GROUP:

Search filter:|

o N

Fig. 4.3 Open Available Incident
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4.1. Adding and Removing Recordings from an Incident

Once created, an incident can be further expanded or reduced. To add recordings to an open incident,
first select the desired recordings from the Browse or Search tabs, or another Incident tab. Once
selected, click and drag the selection to the destination Incident tab and then release it. The recordings
will be appended to that incident.

Alternatively, after having selected the recordings you wish to add, right-click the selection and choose
Add Selected to incident from the menu that appears. A submenu lists all possible destination incidents.
Select the desired incident and the recordings will be appended to it.

To remove recordings from an incident, select the recordings you wish to remove from the Incident tab
they are associated with and select Remove from the Edit menu. Alternatively, you can right-click the
recording selection and choose Remove from Incident from the menu that appears, or simply highlight
the chosen incident and use CTRL+D.

4.2.Saving an Incident

To save an incident to the recorder, first make sure the Incident tab is selected, then select Save Incident
from the File menu. If this is a new incident, when the Save Incident dialog box appears, the Recorder tab
will be automatically selected.

The Protect Calls in Incident option will automatically mark all recordings as protected when saving the
incident; this is turned on by default. Optionally you can edit the incident properties and permissions
here too. When saving an incident with a large number of calls with this option on, a progress bar will pop
up to provide feedback while the system is protecting calls.

Enter an Incident Name and then click OK to save.
O New in version 2024.1.

Incidents can be saved to either a general list of incidents, or specific folders for better organization and
compliancy.

General List
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Incident Folders

Open Incident X

Recorder Upload

Incident
Location 2
Geo-Location
Location
screens
screen redaction
2 screens
audio redaction
RestrictedUserIncidel
Ross County
Mobile-2
FP-1
Mobile-1
9/29
9/28
| 1hr call

Description

Modified

2023-10-24 13:14:03 -04:00
2023-10-20 15:49:59 -04:00
2023-10-20 12:05:25-04:00
2023-10-16 13:11:13 -04:00
2023-10-12 13:55:09 -04:00
2023-10-12 13:28:07 -04:00
2023-10-12 13:24:36 -04:00
2023-10-09 13:56:14 -04:00
2023-10-03 14:31:30 -04:00
2023-10-02 13:57:15-04:00
2023-10-02 13:52:19 -04:00
2023-10-02 13:50:54 -04:00
2023-09-29 12:57:54 -04:00
2023-09-28 13:49:09 -04:00
2023-09-28 12:54-35 -04-00

=

~ Owner Read/Write Read/V
Eventide No
Eventide No
Eventide No
Eventide No
Eventide No
Eventide No
Eventide No
RestrictedUs¢ No
Eventide No
Eventide No
Eventide No
Eventide No
Eventide No
Eventide No

Fventide No

Search ﬂlter:[

o I

Recorder Upload

+ New Folder

» [0 01_owner

» [0 01_read

» [ 01_write

» [ 1Folder

» (L3 DELETE
L3 FOLDER1

» [0 NAB

» [ Restrict01

» [ Restrict1

Location 2

Geo-Location

Location

screens

2 screens

clel AL AL AL AL AL,

audio redaction

Ross County
| Mobile-2

screen redaction

Fig. 4.4 Incident List

Open Incident

Sort By Modified v

MODIFIED:

OWNER:
Eventide

No

READ ONLY:
Yes

[ bEscrIPTION:

READ/WRITE:

Location 2

2023-10-24 13:14:03 -04:00

READ/WRITE USERS:

READ ONLY USERS:

RESTRICTED INCIDENT GROUP:

RestrictedUserIncident

Search filter:|

e

Fig. 4.5 Incident Folders
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The following actions need permissions assigned in Web Configuration:

e Add new folders
e Delete folders
¢ Edit folder names

4.3. Download an Incident Locally

Incidents can be also be saved locally to your computer. By default, one usually wants to save an incident
remotely, which means on the recorder itself, for use on that recorder. But if you need to share an
incident across different recorders, you can save the incident locally to your computer as an <incident
name>.eti file. This file can then be shared and opened with the Open Incident file menu option.

To save locally, you must first save the incident to the recorder. Once you have saved it to the recorder,
select Save Incident As from the File menu, and choose the Download tab. You can optionally enter a
password here that the incident will require to open.

Save Incident As X

Recorder Download

Name Utility-Water Main 927 Bro
Password e
Repeat password oo

Package Player with Incident

Fig. 4.6 Local Incident Save

This file can then be shared and opened with the Open Incident file menu option, by clicking the local tab
and clicking Add File. Select an .eti file, click ok and then click OK in the Open Incident dialog. If there is a



4. Creating an Incident

password, you will be prompted to enter it and if that succeeds, the incident will open with all of the calls,
notes, attachments and metadata as seen on the original recorder.

4.3.1. Pack and Go

P License Required

This feature must be licensed to be used. Contact your Eventide Communications Dealer for
assistance.

When licensed, Pack and Go allows you to export an offline incident with a built in player. This is useful
for allowing a user to explore an incident’s content without access to a recorder.

The Pack and Go player is portable and does not need to be installed. It does not require any network
access and can be opened by anyone with a Microsoft Windows 7 or newer PC. The player can optionally
require a password.

When opening the Pack and Go incident player offline for the first time, Microsoft Defender may
trigger an alert preventing an unrecognized app from starting. We recommend selecting the option
“Run anyway”, or purchasing a specialty security license.

Please contact your Eventide Communications Dealer for more assistance.

4.4, Incident Renaming

Incidents can be renamed by right-clicking on the incident either in the open incident menu or on the tab
of an open incident.

© 2025 Eventide Communications LLC
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& Utility-Water Main 927 Broadway*
Close Tab

Close Other Tabs

Start Time

2020-03-05 15:12:13 -05:00

2020-03-05 15:12:04 -05:00 R
2020-03-05 15:11:19 -05:00 01:00

Save Incident

Rename Incident

Fig. 4.7 Rename Option in Tab Right-Click Menu

Rename Incident X

‘ What would you like to rename this Incident to?
New name: Utility-Water Main 927 Bro

Fig. 4.8 Incident Rename Pop Up

4.5. Incident Properties

The Properties button (at the top of the tab and in the Save window) opens to an Incident Properties
window that allows for a searchable text description of the incident, as well as fine control of which
permissions each user on the system has for this incident.
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annels & Utility-Water Main 927 Broadway*

3

*
|

Incident Properties Owner: Eventide

Properties

Description:

Permissions| ¥ Protect Calls on Save

Notes and Attachments:

Note Creator Filename Date Created Attachment

Notes can be added by anyone with read/w Eventide 2020-03-02 22:1¢ "
=
.|‘\
H]

New Note '_

0 Add
Incident Link
http://192.168.17.10/client/mediaworks/?incidentGuid=aAM9XfD6oghQHCOf Select All

N e |

Fig. 4.9 Incident Properties and Notes

This window contains a variety of information and options for this incident, including Permissions,

Description, Notes, File Attachments, and an Incident Link URL.

The “Protect Calls on Save” checkbox in the upper right corner controls whether or not calls added to

this incident after the initial save will be protected when the incident is saved.

4.5.1. Incident Properties and Notes: Description

The Description text box at the top of the Incident Properties window can be used to describe the

incident and highlight anything particularly interesting about it. This description can then be searched

for in Open Incident dialog, making it easier to find specific incidents on systems that have many.

4.5.2. Incident Properties and Notes: Notes

Notes can be added by anyone with read/write permissions for the incident. Each note will include the

creator, the date created, and if media is attached to the note, a file name. Short notes will be fully visible

but for longer notes, you can right-click and select View Note from the context menu to see the full text

of the note. If there is a document attached of a supported type (text, jpg, wav, mp3, etc), you will be able

© 2025 Eventide Communications LLC
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to seeit in this pop up as well. From this context menu you can also choose to edit or delete the note or

download the attached file. The paper clip icon next to Add allows you to attach media (or any kind of file)
to the note.

Incident Properties Owner: Eventide

Properties ‘

Description:

¥ Protect Calls on Save

Notes and Attachments:

tes can be added by anyone with read/w| Eventide 2020-03-02 22:1

=

New Note Notes can be added by anyone with read/write permissions for the
incident. Each note will include the creator, the date created, and if e
media is attached to the note, a file name. Short notes will be fully ] 0 Add
visible but for longer notes, you can right-click and select View %

Incident Link Note from the context menu to see the full text of the note. If there

is a document attached of a supported type (text, jpg, wav, mp3,

http://192.168.17.10/client/i  etc), you will be able to see it in this pop up as well. From this Select All

context menu you can also choose to edit or delete the note or

download the attached file.
L

Fig. 4.10 Incident View Note

4.5.3. Incident Properties: Permissions

The Properties button (at the top of the tab and in the Save window) opens to an Incident Properties
window that allows for a searchable text description of the incident, as well as fine control of which
permissions each user on the system has for this incident.
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Incident Properties Owner: Eventide
Properties
Descriptiol Permissions

Incident Locked Owner Only Read Only Read/Write
Custom @ | Allusers |

P,

® Asaunders
Notes ant gpe|jerye
Note
Notes ca

DBarton

DCooper

DSigal

ECherry
New Note

LBertucci l
|: MGilson . (it
Incident Li
| Lo« [

Fig. 4.11 Incident Properties - Permissions

The default for new incidents is Read Only: only the original creator of the incident can make changes,
and everyone else can open it to listen to calls and read notes.

The radio buttons in the top line allow you to assign permissions for all users at once, and can also be
used first to set a default state before assigning specific permissions to a few users. For example, you may
want only two users to have access to this incident, so you click the All Users Owner Only button and
then click Read Only for the two users you want to share it with. Owner Only is the same as No Access
for users other than the user that created this incident.

Note that the Owner of an incident always has Read/Write permissions.

4.6. Redacting Recordings in an Incident

Redaction is an umbrella feature allowing for modifying part of a call’s audio, either by replacing it with
silence or a tone, or by applying an effect such as obfuscation or automatic gain correction. Obfuscation

transforms the original speaker’s voice into something clear but not recognizable as a specific person and
aims to make identifying a source difficult.
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2020-03-05 15:1
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Block media access...
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1

Add Redaction Point

Split/Join Media

Fig. 4.12 Redaction in Context Menu

Redaction points are available only for calls organized into an incident. Right-click on a call record to add

a Redaction point. This will show up as a purple highlighted space in the call, with a smaller square in the
upper right corner. Clicking that square gives the redaction space focus, so you can adjust its duration by
dragging the start and end times, or adjust its location by click in the center and dragging it from side to

side.
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Fig. 4.13 Redaction Area

If you right-click the Redaction area, a Redaction specific menu will pop up. From here, you can open an
options menu for this redaction, change the kind of effect to be applied (Mute, Tone, AGC, or Obfuscate),
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“Move” the redaction by giving it mouse-focus the way clicking the upper right corner would, or remove
the redaction entirely.

2020-03-05 15:11:00 -05:00 2020-03-(

Resource Name | |
1 | | | | | | 1

Dispatch-Fire

Volume: 50% Pan: None

Dispatch-Police

Volume: 50% Pan: None

EMS-West

L A R AR A A A R R

[ (=] [ | =]

Volume: 50% Pan: None {D LR TRy T
Traffic-Police-1
Volume: 50% Pan: None I ET o TR

Thirty Seconds v

Fig. 4.14 Redaction Area

The Options for a Redaction include the maximum gain of the AGC, or the kind of Obfuscation. A lower
value for Obfuscation modulates pitch downward, and a higher one moves it upwards.

4.7. Enhanced Video Redactions

O New in version 2024.3.

Video redaction is a useful tool to help safeguard sections of a timeline for legal, compliance, or security-
related reasons. MediaWorks EXP is capable of the following redactions:

e Entire Screen Video Redaction
e Al Face Blur Video Redaction
e Static Video Redaction

¢ Dynamic Video Redaction

4.7.1. Entire Screen Video Redaction

When using Entire Screen Video Redaction, a user can select a portion of the timeline and blur the entire
visible video output when exported to an mp4 file.

Once anincident is saved, right-click the selected timeline, and choose “Add Video Redaction”.
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This will create a blocked section in the timeline that represents the window of redaction.
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Fig. 4.15 Add Video Redaction

When you right-click the upper right section of the redaction window, you'll be given the option of Entire

Screen, Al Face Blur, Static Area, Dynamic Area, Set Start/End, Select All, Edit, and Remove.

Select the “Entire Screen” option:
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File Edit View Help Eventide | =)

o Nexloo

Properties and Notes B Export Incident | [B» Pack and Go 1records, 1 selected | Rotate Canvas| B @

Source Name Channel Name Start Time ~ Duration Callerid  Dtmf
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Select All | 00:16
Edit ==
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Fig. 4.16 Entire Screen

To edit the redaction window, select the “Edit” option, then hover over the ends of the redaction window
to extend the beginning/end, or move the entire redaction section.

The “Set Start”/”Set End” options can be used to set the start or end of the video redaction according to
where the playhead is in the timeline of the recording.

The “Select All” option will apply the redaction to the entire length of the recording.
The “Remove” option will remove the redaction from the recording.

_ e e e ey
8:05 -04:00 2024-04-29 13:48:10 -04:00 2024-04-2

| 4 | T T e I T

o |

Fig. 4.17 Redaction Area

Once the redaction area has been created, save the incident, then select “Export Single Recording...” to
create an mp4 file of the redacted video.
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Fig. 4.18 Redaction Export

Preparing Files For Export

Export complete

Fig. 4.19 Redaction Complete
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In order to view the redaction section of the video, the file must first be exported, then viewed on
the mp4 file.

Fig. 4.20 Entire Screen Video Redaction

4.7.2. Al Face Blur Video Redaction

Similar to the Full Screen Redaction feature mentioned in the previous section, the Al Face Blur function
can identify and blur facial features by using Al recognition to create redacted sections in the timeline.

Once anincident is saved, right-click the selected timeline, and choose “Add Video Redaction”.
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Fig. 4.21 Add Video Redaction

This will create a blocked section in the timeline that represents the window of redaction.

When you right-click the upper right section of the redaction window, select the “Al Face Blur” option.
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Fig. 4.22 Al Face Blur
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Please see section 4.7.1 Entire Screen Video Redaction for details on how to edit a video redaction.

Once the redaction area has been created, save the incident, then select “Export Single Recording...” to
create an mp4 file of the redacted video.
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Fig. 4.23 Redaction Export

Preparing Files For Export

Export complete

Fig. 4.24 Redaction Complete
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In order to view the redaction section of the video, the file must first be exported, then viewed on

the mp4 file.

After exporting, Al Face Blur Video Redaction can now be opened and played on your local media player.

Fig. 4.25 Al Face Blur Video Redaction Playback

© Important

Before sharing videos publicly, users must verify the Al’s face-blurring accuracy to ensure

compliance with privacy regulations. Inadequate verification may lead to legal liability for
unauthorized data disclosure. Eventide Communications LLC is not liable for inaccuracies in Al

blurring. User diligence is crucial for legal compliance and privacy protection.
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4.7.3. Static Area Video Redaction

Similar to Full Screen Redaction, Static Area Video Redaction can select a portion of the timeline and
block out only the user-selected area of video output when exported to an mp4 file.

J

Once anincident is saved, right-click the selected timeline, and choose “Add Video Redaction”.
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Fig. 4.26 Add Video Redaction

right-click the upper right section of the redaction window and select the “Static Area” option.
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Editing this feature creates a resizable box that can be placed over the preferred area of redaction.
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Please see section 4.7.1 Entire Screen Video Redaction for further details on how to edit a video

redaction.

Once the redaction area has been created, save the incident, then select “Export Single Recording...” to

create an mp4 file of the redacted video. The static redaction area will produce a black box over the

chosen selected area.
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Fig. 4.29 Redaction Export
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Preparing Files For Export

Export complete

Fig. 4.30 Redaction Complete

In order to view the redaction section of the video, the file must first be exported, then viewed on
the mp4 file.
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Fig. 4.31 Static Area Playback

4.7.4. Dynamic Area Video Redaction

Dynamic Area Video Redaction shares the characteristics of Static Area Video Redaction while letting
the user move the redaction box in real time to adjust to the video as it’s playing.

Once anincident is saved, right-click the selected timeline, and choose “Add Video Redaction”.
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Fig. 4.32 Add Video Redaction
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right-click the upper right section of the redaction window and select the “Dynamic Area” option.

Eventide | #)

Loc

Properties and Notes Export Incident | [Bs Pack and Go 1records, 1selected | RotateCanvas| B &

mp4 Mon Apr29 2024 13:48:08.. @ @ ¥ X

Source Name Channel Name Start Time ~ Duration Callerid  Dtmf

Entire Screen

Al Face Blur

Resource Name Static Area

b N | 1
mp4 > T i v Dynamic Area N

Set Start
Five Seconds v < | SetEnd B >
—
00:00 i | Select All i 00:16

Volume

Edit =
1< Remove % 00:00 00:16

Fig. 4.33 Dynamic Area

192.168.23.163/ client/mediaworks/#

Editing this feature creates a resizable box that can be placed over the preferred area of redaction.

While playing the video, right-click on the playback window and select ‘Edit. Then, click and drag the
redaction box over the area of the video you want to redact. You can adjust this box in real time as the
subject moves within the video.
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Please see section 4.7.1 Entire Screen Video Redaction for further details on how to edit a video

redaction.

Once the redaction area has been created, save the incident, then select “Export Single Recording...” to
create an mp4 file of the redacted video. The static redaction area will produce a black box over the

chosen selected area.
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In order to view the redaction section of the video, the file must first be exported, then viewed on

the mp4 file.

Dynamic Area Playback

4.8. Incident Clip Management

Incident Clip Management is a feature intended for systems that use analog recording with imperfect
call stop and start recording criteria. On systems relying on Vox or TRV thresholds and hold times,
sometimes a single call will be recorded as two, and other times two calls can be recorded in a single call.

Incident Clip Management allows users making incidents to join or split audio calls in an incident so that
the calls are played back correctly. The original call records remain on the recorder in their as-recorded

state.

A split or joined call record is called a clip.
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4.8.1. Incident Clip Management Configuration and Permissions

Incident Clip Management is an optional feature: for anyone on the system to use it an Admin user must
turn the feature on in Configuration Manager under Users and Security: System Security. When enabled,
this will add two custom fields required for Incident Clip Management, is_clipped_media and clip_details,
if they do not already exist. At that point, any Admin or Researcher user can use Incident Clip
Management.

Fig. 4.38 Enable Incident Clip Management in Configuration Manager

4.8.2. Joining Calls with Incident Clip Management

Once configured, the tools to split and join media are relatively straight forward. Note that this function
is only available for use on call records in an incident. Below is an example image showing a call that split
because the volume of the audio dropped too low for too long, causing it to be broken into two calls.

20-03-05 15:11:00 -05:00 2020-03-05 15:11:30 -05:00 -03-0 )5:00 2020-03-05
1 ' 1
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Fig. 4.39 Enable Incident Clip Management in Configuration Manager

In order to fix this:

1. Add both calls to an incident and select one of the calls, right-click and select “Split/Join Media”
from the context menu.
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Fig. 4.40 Select Split/Join Media from Menu

1. The Split/Join Area will appear; this is very similar to the Redaction tools previously discussed.
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Fig. 4.41 Split/Join Area

1. Drag the edges of the Split/Join Area to contain the call audio.
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Fig. 4.42 Resize Split/Join Area to Include All Audio

1. And then click the green check box to merge, or the red X to cancel.
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From 2020-03-05 15:11:05
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Fig. 4.43 Click Green Checkbox and then Click OK

1. You then get a summary of what will be joined, with the option to remove the original records from
the incident. In the case like this, of joining two calls, you are going to want to use the default
setting to remove the original two from the incident. The original calls remain on the recorder, but
are replaced in the incident with the new joined call. The call grid will be updated with the new call
as well.
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Fig. 4.44 The Calls are Now Joined

4.8.3. Splitting Calls with Incident Clip Management

Here we will tackle the other common scenario: a pair of calls that are joined together because the Vox
hold time was set too long and the calls were very close together in time:
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Fig. 4.45 Example of Calls Improperly Merged Because of Vox Timeout

1. As above, click the call and use the context menu to Split/Join Media, and then adjust the
boundaries to surround the first call, click the green check mark.
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Fig. 4.46 Adjust Split/Join Area

1. In this case, we want to uncheck the default “Remove original record(s) from incident” option: we
want the original to remain in the incident for the next step. We are going to crop a second call out
of it and at that point we will use the default setting to remove the original.
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Split/Join Media

Creating new record using 1 record
From 2020-03-0515:11:19
To 2020-03-05 15:11:44

) Remove original record(s) from Incident

Fig. 4.47 Uncheck “Remove original record(s) from incident”

1. Click OK. The selected area is now added to the incident as a separate call. The original remains.

T T T T T e M e e

Fig. 4.48 First Call Split, Original Call Remains

1. Again, use the context menu to click Split/Join Media and select the second call’s audio area.
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Fig. 4.49 Select and Split the Second Call

1. Click the green check mark and click OK on the prompt (leaving the default setting.)
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|‘|.|‘|‘|‘|‘|‘|‘|‘|.I‘|‘|.|.| |.|.|‘|‘|‘|‘|‘|‘|‘|‘|‘|‘|‘|‘|.|‘|‘|‘|‘|‘|‘

il o o REE
)

Fig. 4.50 Split the Second Call and Remove the Original Call from the Incident

1. Now both calls exist in the incident as separate call records, shown accurately in the timeline and
call grid.

LA A R R A S O O S A R U R A R U

' |-¢~\|-pu>-\{-~~|.| Y] wH—i|>lu|*H|~lH-|

|-|}“~H|-|Hi|l| \Hill') -‘-"niln-“- +«-u|-1l o h+¢

Fig. 4.51 The Calls are Split

4.8.4. More about Incident Clip Management

Calls that have been split or merged with Incident Clip Management will appear in search results at the
same time as the original calls. Incident Clip Management calls are always displayed on top in the
timeline; they are also highlighted with a yellow border, as seen in the screen shots above. Enabling the
call grid column Is Clipped will also let you quickly see whether a call was modified with Incident Clip
Management or not.

In an incident, you can quickly access the original version of a clip by right-clicking it and selecting
“Restore Original Media” to bring all original calls involved into the incident. There is an option to remove
the clip from the incident in the same step.

If a clipis no longer useful (or created wrongly in the first place) it can be deleted from the recorder by
right-clicking it and selecting “Delete Clip.” It is important to note that if a clip is used in multiple
incidents, it will no longer be available in any of them.

© 2025 Eventide Communications LLC
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4.9. Pinning Media to an Incident

Multimedia in an incident can be “pinned” to the canvas, such that they are always shown when the
incident is loaded. This is so that important events in an incident can be highlighted for future research.
In an incident, a multimedia record, such as a screen capture, will playback in a panel that has these
options in the upper right corner:

6 records, 1 selected | Rotate Canvas

Dispatch-Police Thu Mar 05 2020 15:08:32 GMT-0500 (E.. © & ¥ X

— — E— —
2020-02-05 T510-00 -05:00 2020-02-05 151100 -05-00 2020-02-N5 15192

Fig. 4.52 Multimedia in an Incident (Detail)

The left most of these icons is the Pin to Incident button. If you click this, the frame around the media will
turn grey and the Pin to Incident and the Pop Out to Application will disappear:

6 records, 1 selected | Rotate Canvas| &

E— S— E— —
2020-03-05 15:11:00 -05:00 2020-03-05 15:12:00 -0

Fig. 4.53 Pinned Multimedia in an Incident (Detail)
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4.10. Exporting an Incident

Incident Export exports the entire incident based on the export default. The only difference is that it
always selects “All Media” on the first panel because otherwise it would only export the currently
selected calls. If you want to modify the export settings from the default, you can click the Back button to
adjust any of them.

File Edit Tools Playback View Help

A Properties and Notes (1) | | Export Incident

@ Channels

v

Channel Name Start Time

Dispatch-Fire 2020-03-05 15:12:13 -05:00
EMS-West 2020-03-05 15:12:04 -05:00
Traffic-Police-1 2020-03-05 15:11:19 -05:00
EMS-West 2020-03-05 15:11:11 -05:00
Nienatnh_Cira 2N7°N_N2_.NE 1R-11-NE _NE-NN

Fig. 4.54 Export Incident

Exporting an incident with this button will also include all attached files in the resulting zip file rather
than requiring you to download each one individually from the Properties and Notes page.

For more details on Exporting, see Exporting Recording Data from an Incident.

4.11. Deleting an Incident

To delete an incident in MediaWorks EXP, right-click the incident tab and select “Delete Incident”.

Close Tab
Close Other Tabs
Save Incident

Rename Incident ‘

Delete Incident %

i= Browse Q Search © Instant Recall B Evaluations B 12/22incident

Properties and Notes | | B§ Export Incident

Source Name Channel Na... Start Time ~ Duration c

NLDX_VM_240100149 Channel 1 2022-12-18 21:09:14 -05:00 14:56

Fig. 4.55 Delete Incident
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5. UPDATING RECORDINGS

Once recordings have been collected into incidents, there are a number of ways to examine their
properties. Examine detailed properties for any recording by right-clicking a recording and selecting
Properties from the menu. The Properties dialog box will appear, allowing you to add information such as
notes and to access the audit history of the recording.

Any notes modified in this dialog box are saved back to the recorder on which it originated. Similarly,
changing the Protected status of a recording updates the recording’s status on the source recorder.

5.1. Call Properties

The Call Properties screen lists the attributes of the selected call recording and includes the following
default tabs:

¢ Properties: provides information about the call properties.

¢ All: allows you to add information about the call to default or custom metadata fields.
e History: Provides a history of the call.

e Map: Provides location and address information.

5.1.1. Properties

The Properties tab provides detailed information about the recording’s location, time, and phone.

Checking the Protected box in the Attributes section will prevent the recording from being deleted by
the configured retention settings.

You may add information about the recording in the Notes box. You can also add custom fields at
Recording — Custom Fields in Configuration Manager. Custom text fields with a Text Display Type of
Standard, Long, or XML will appear here in the properties tab.
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Call Properties X

Properties All History User Info testing

General Time

Channel Name Channel 3 Start Time 2022-01-21 11:59:36 -05:00
Calltype <) AUDIO Duration 14:56

Phone Attributes

Caller Id Protected

Dtmf Suppressed No

Call Direction  Inbound Flag @

Calling Party Call GUID pukJ4260RY10cdo5

Notes

Fig. 5.1 Call Properties - Property Tab

5.1.2. All

The All tab includes the custom fields specific to your recorder that contain additional information about

the recording. From this screen, you may edit any of the custom field information.

Call Properties X

Properties All History User Info testing

Notes Show Empty @l )

Agency

Agent Id

Call Direction  Inbound

Call GUID pukJ4260RY10cdo5
Called Entity

Called Party

Caller Id

Close

Fig. 5.2 Call Properties - All Tab
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5.1.3. History

The History tab provides an audit history of each time this recording has been accessed, including the

related user information.

Call Properties X

Properties All History User Info testing

Event Time ~ Description User Name Action
2022-01-21 13:54:12 -05:00 Protected call with callgu Eventide Protect Call
2022-01-21 13:54:58 -05:00 Accessed media for Playl Eventide media accessed

Close

Fig. 5.3 Call Properties - History Tab

5.1.4.Map

The Map tab offers information about location, address, and Geo-Fence data providing critical feedback

on acall’s origins.

To toggle map legend, click the map icon.
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Search Filters

Q search © Instant Recall & deerin the road & lake charles

>  Results as of 2023-04-10 15:12:01-04:00

1489 records, 1 selected  Q B

Start Time

Caller Id

Date Source Name  Channel Name Duration
Lincoln 911 Brooklyn Fire/EMS ~ 2023-04-01 00:00:03-04:00 0103
S'Z" [2025.04-01 00:00:00 Lincoln 911 Brooklyn Fire/EMS ~ 2023-04-01 00:01:07-04:00 0023
B 04
" (20230402 00:00:00 Lincoln 911 Brooklyn Fire/EMS 20230401 00:01:45-04:00 0006
Resources Lincoln 911 Brooklyn Fire/EMS 20230401 00:01:50-04:00  00:08
:“";“9 Z Lincoln 911 Brooklyn Fire/EMS ~ 2023-04-01 00:02:00-04:00  00:45
nalog
Analog 5 Lincoln 911 Brooklyn Fire/EMS 20230401 00:02:45-04:00 0005
Analog 6 Lincoln 911 Brooklyn Fire/EMS 20230401 00:04:04-04:00 0007
Analog 7 )
In911 Kiyn Fi 0401 00:04:33 -04 1
TS Lincoln Brooklyn Fire/EMS 20230401 00:04:33-04:00  00:14
Analog 8 Lincoln 911 Brooklyn Fire/EMS 20230401 00:04:50-04:00  00:10
H camera1 Lincoln 911 Brooklyn Fire/EMS 20230401 00:05:03-04:00 0006
H camera2 Lincoln 911 Brooklyn Fire/EMS ~ 2023-04-01 00:05:19-04:00  00:06
H camera 3
Channel 4 Lincoln 911 Brooklyn Fire/EMS 20230401 00:05:31-04:00 0006
Cﬁaﬂﬂe‘ 8 . Lincoln 911 Brooklyn Fire/EMS | 2023-04-01 00:05:37 -04:00 -
Channel 39 Lincoln 911 Brooklyn Fire/EMS ~ 2023-04-01 00:05:55-04:00 0007
* Channel 45
« Channel 46 Lincoln 911 Brooklyn Fire/EMS 20230401 00:07:34-04:00 0005
# Channel 49 Lincoln 911 Brooklyn Fire/EMS 20230401 00:07:44-04:00 0005
Lincoln 911 Brooklyn Fire/EMS  2023-04-01 00:07:50-04:00 0017
Lincoln 911 Brooklyn Fire/EMS 20230401 00:08:08-04:00 0005
Lincoln 911 Brooklyn Fire/EMS 20230401 00:12:02-04:00  00:09

Resource Name

Brookivn Fire/EMS > e
Five Seconds v ‘ 5

0201 0010525 DAOD.

202502 01 000530 0200

Call Properties

Properties Al

Section Name

Location (35.271611,79.78808)
Address
heboro £
+
@
Ughari
Geo-Fence  NatighallFoet
Pinehurs
Southern

=)

aurinbui

GO Ve | Termsotse

Map 911 call handling Radio CAD

+ x

M Ali Location

W Cad Location E911

W Cad Location Gps

W Location

W Prepared911 Location
Rsos Location

M Rsos Rg Location

00:00

Volume

Speed

Search Filters

100%

100%

Fig. 5.4 Toggle Legend On

1489 records, 1 selected  Q B

Start Time

Caller Id

Date Source Name  Channel Name Duration
Lincoln 911 Brooklyn Fire/EMS  2023-04-01 00:00:03-04:00 0103
SRS (E) Lincoln 911 Brooklyn Fire/EMS  2023-04-01 00:01:07-04:00 0023
023.04-02 00:00:00 Lincoln 911 Brooklyn Fire/EMS 20230401 00:01:45-04:00 0006
Resources Lincoln 911 Brooklyn Fire/EMS  2023-04-01 00:01:50-04:00  00:08
e Lincoln 911 Brooklyn Fire/EMS 20230401 00:02:00-04:00 0045
nalog
Analog 5 Lincoln 911 Brooklyn Fire/EMS  2023-04-01 00:02:45-04:00 0005
Analog 6 gl tincomon Brooklyn Fire/EMS 20230401 00:04:04-04:00 0007
Analog 7 o ;
S Lincoln 911 Brooklyn Fire/EMS 20230401 00:04:33-04:00  00:14
Analog 8 Lincoln 911 Brooklyn Fire/EMS 20230401 00:04:50-04:00  00:10
H camera 1 Lincoln 911 Brooklyn Fire/EMS 20230401 00:05:03-04:00 0006
H camera2 Lincoln 911 Brooklyn Fire/EMS ~ 2023-04-01 00:05:19-04:00  00:06
H camera 3
Channel 4 Lincoln 911 Brooklyn Fire/EMS ~ 2023-04-01 00:05:31-04:00 0006
Channel 8 Lincoln 911 Brooklyn Fire/EMS | 2023-04-01 00:05:37-04:00 | 00:03
A, = C
Lincoln 911 Brooklyn Fire/EMS ~ 2023-04-01 00:05:55-04:00 0007
# Channel 45
« Channel 46 Lincoln 911 Brooklyn Fire/EMS ~ 2023-04-01 00:07:34-04:00 0005
# Channel 49 Lincoln 911 Brooklyn Fire/EMS ~ 2023-04-01 00:07:44-04:00 0005
Lincoln 911 Brooklyn Fire/EMS 20230401 00:07:50-04:00 0017
Lincoln 911 Brooklyn Fire/EMS 20230401 00:08:08-04:00 0005
Lincoln 911 Brooklyn Fire/EMS 20230401 00:12:02-04:00  00:09

Resource Name

00:00

File  Edit T P ] D)

5  Results as of 2023-04-10 15:12:01-04:00 Call Properties

Properties Al

Section Name

Location (35.271611,79.78808)
Address
-
Asheboro
7l
Geo-Fence T

Map  9l1callhandling  Radio  CAD

NationallFol¥et

Map data 62023 Google | Terms of Use.

+ x

Pinehrst
Souther Pines Fayet

Hope Mi

Laurinburg

Close

Brookivn Fire/EMS >| en
FiveSecondsv| 5 1 @ & >
00:00
Volume Y 100%
- o | i P b

O New in version 2024.1.

Fig. 5.5 Toggle Legend On

Selected call events show a 2 mile radius of the surrounding areas on the call property map.
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Playback

iZ Browse

Helr

NexLoG

CECHENT & incident#3 @ Channel 1

S Filters (1) > | Results as of 2024-01-08 10:54:10 0500 T22records,Oselected @
Source Name Channel Name Call Properties
® Nexlog Channel 2
« JAN 2024 R 5 (e a2 Properties Al History
NexLog Channel 2
S M T W T F s
Ty Channel 2 o
12 3 4 5 6 N T Bl [
exLox annel @
TRl 0oz N Lg a2 V]
exLo hanne
1415 16 17 18 19 20 N
NexLog Channel 2
21 2 28 24 25 26 27
NexLog Channel 2
2% 29 30 1
NexLog Channel 2 L 4 Dobson's Backhoe!
O Use Time Range & Septic Tank
NexLog Channel 2
= g
Resources = NexLog Channel 2.
[ Resources NexLog Channel 2 D
NexLog Channel 2 mm @ E
NexLog Channel 2 ap data 92074 T
NexLog Channel 2
Nextog Channel 2. Call Direction  Inbound
NexLog Channel 2
Close
T GEme I Ce=l
NexLog Channel 2 2024-01-0810:43:32-05:00  00:31
NexLog Channel 2 2024-01-0810:42:5705:00  00:30
NexLog Channel 2 2024-01-0810:4222-05:00  00:30
NexLog Channel 2 2024-01-0810:41:47 05:00  00:30
Resource Name:
Channel 2 >
A Y @ @
OneMinute v & 0 B & Q >

Do
» Channel 2
2024-01-08 10:53:57 -05:00

—_——————— 0

Speed

> O.

Fig. 5.6 Call Property Map View

5.1.5. Edit Call Properties

MediaWorks EXP offers the ability to configure, edit, and add new Call Property tabs in order to give
quick access to a user’s data and feedback.

Configure Call Properties

To configure your Call Properties, highlight a track and select Edit Call Properties under Menu Bar -
> Tools



5. Updating Recordings

@ Channels

© Instant Recall & ROHS 1 ‘ © Instant Recall @ Evaluations

Properties and Notes (1) Export Impound Quarantine

9records, 1 selected Q B @

NexLoe

Source Name Channel Na... Start Time ~ Duration Callerld  Dtmf Weather
DO 24000145 Crama s 2nza0n 2131485001456 || |
Call Properties Configure Tab x
Properties All History User Info testing
Tab Name |Properties [ 7]
Lowsecion [ | ] & JEREERRRCTS
Channel Name Channel 3 Agency
Calltype «) AUDIO Call GUID V2adgaVtet6dq7IP v X
Dtmf Flag Layout | Two Columns v ‘Time
ohone . |Agency ~| [AddField | [Agency ~| [AddField |
. Channel Name ™ ¥ X Agency ™4 x
Agency Ota Encryption
b = Calitype ~ ¥ X calGuD v x o
! Dtmf ™ ¥ X Flag [N 28 4 I
phone S v E X
[ oc ] coes |
One Minute v | & T
< >
00:00 00:00
Volume o 100%
Speed o 100% I< > >I C‘)

Fig. 5.7 Call Properties Configure

When you select the settings icon in the top right corner, you'll be able to customize your Properties tabs
to add and organize detailed information that your user needs as well as add additional header sections
and adjust layout between single columns, double columns, or annotation sections.

Add Additional Call Properties
To add more tabs to your Call Properties, select Edit Call Properties in the Menu Bar, and select the

+in the top right corner. This will give you the ability to add new tabs, create multiple headers
within each tab, and apply new fields within each of those sections.
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@ Channels

© Instant Recall & ROHS 1 ‘ © Instant Recall @ Evaluations

Properties and Notes (1) Export Impound Quarantine

NexLoe

9records, 1 selected Q B @

Source Name Channel Na... Start Time ~ Duration Callerld  Dtmf Weather
e e e
N RV VY T e A oo oo oo oo oo Configure Tab x
Call Properties X
5 Tab Name TESTING | H
BB e off]

[Section Name | > v OE X

Layout [ Two Columns v| [ngh! Column Name

Properties All History User Info

|Flag v| [AddField| |[Evaluated | [AddField |

Close

A Y @ o
One Minute v ®

v A < >
00:00 00:00
Volume ) 100%
speet A o [T S )

Fig. 5.8 Call Properties New Tab

Call Properties Embedded View

O New in version 2023.1.

Call Properties can be viewed in its own window, or you can dock it on the right-hand side of the main
menu window.

To move embed the call properties window into the main menu window:

e Click the - symbol in the Call Properties box to dock the window into the call grid
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Caller Il Properties
00:17:55-04:00
00:42:49 -04:00
01:07:43 -04:00

01:32:37 -04:00
01:57:31 -04:00
02:22:25-04:00

02:47:19 -04:00
03:12:13-04:00
03:37:07 -04:00
04:02:01 -04:00
04:26:55 -04:00
04:51:49 -04:00
- Protected
05:41:37 -04:00
06:06:31 -04:00

Call Properties
All History uration
Notes Show Empty (T :::
1:56
kS6
k56
k56
k56
Call Direction  Inbound k56
Calltype % AUDIO E
k56
Channel Name GW Sim 3 156
Duration 14:56 156
Record ID arSalDUzcsBR8pze
Source Name  NexLog DX Demo GW1

06:31:25-04:00
06:56:19 -04:00
07:21:13 -04:00

Start Time
Suppressed

—————
2025-04-06 20:00:00 -04:00

2025-04-06 05:01:48 -04:00

No

~ v Dtmf Annotati

2025-04-10 20:00:00 -04:00

..|..\...\.

Fig. 5.9 Call Properties Pop-up Dialog

Filters Restlts as of 2023-01-18.. 2400 records, 1 selected _ Rotate Canvas| Q. B @

< JAN 2023 >

S M T W T F s
12 3 4 5 6 7
s o @ 12 13 14
5 16 17 18 19 20 21
22 23 24 25 26 27 28

O use Time Range

WINTO
WINTO AGENT

Source Name
NLDX_VM_240100149 Channel 2
NLDX_VM_240100149 Channel 2
NLDX_VM_240100149 Channel 2
NLDX_VM_240100149 Channel 2
NLDX_VM_240100149 Channel 2
NLDX_VM_240100149 Channel 2
oC20i015 crame2azso10 01537 050
NLDX_VM_240100149 Channel 2
NLDX_VM_240100149 Channel 2

© NLDX.VM_240100149 Channel 2 2023.01-10 06:16:13-05:00
Resources NLDX_VM_240100149 Channel 2 20230110 06:27:01 -05:00
= Zis;‘r":‘e‘s NLDX_VM_240100149 Channel 2 2023-01-10 20:46:13 -05:00
NLDX_VM_240100149 Channel 2 2023.01-1017:37:49-05:00

Channel 3 NLDX_VM_240100149 Channel 2 2023.01-1007:22:49-05:00
Chamne 4 NLDX_VM_240100149 Channel 2 20230110 01:21:01 -05:00
Ghannel & NLDX_VM_240100149 Channel 2 2023.01-1015:58:49 -05:00
Channel 7 NLDX_VM_240100149 Channel 2 20230110 11:52:49 -05:00
Cremer® NLDX_VM_240100149 Channel 2 20230110 16:13:13-05:00

NLDX_VM_240100149 Channel 2
NLDX_VM_240100149 Channel 2
NLDX_VM_240100149 Channel 2
NLDX_VM_240100149 Channel 2

Channel Name _ Start Time
202301110 05:57:37 0500
2023-01-10 07:14:25 -05:00 Section Name
2023-01-10 08:37:13 -05:00 Weather

202301110 22:56:25 0500
2023-01-10 20:03:37 -05:00
2023-01-10 04:23:25 -05:00

2023-01-10 21:39:37 -05:00

2023-01-10 23:21:01 -05:00
Geo-Fence

2023-01-10 10:45:01 -05:00
20230110 22:39:37 -05:00
20230110 19:24:37-05:00
20230110 02:12:37-05:00

Resource Name

D000 0500 oS OTO O e OO0t

P T
I 5

Call Properties. + x

Properties Al History  Userinfo

yettevile G

i Greenvile

Wilmington

50

location  Transcr 4 %

M Location

Nev e

Morehead ity

006190001

S

T o A T ey »-m--nmm\w‘

bttt e[ estome o] et

Channel 2 > [pe st
oneminute v| & I @ Q| s
—
06:17:39 i 23:59:55

100%

100%

> >l o.

»>Mixing : 1 call
20230110 06:17:39 -05:00

Fig. 5.10 Embedded View

The second embedded view can be toggled by double-clicking the divider between the call grid and the

timeline:
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i= Browse

Search Filters

Source Name Start Time. Duration Inll Properties Al History  Userlnfo location + £
NLDX_VM_240100149 Channel 2 2023-01-10 05:57:37 -05:00 00:31

< JAN 2023 > NLDX_VM_240100149 Channel 2 2023.011007:14250500 0030 E Show e
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SEARCH P
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Fig. 5.11 Embedded View Option 2

5.2. Editing Call Notes in the Call Grid

If you make the Note column visible, you can edit call notes directly in the call grid by double clicking on

the field associated with a call. If you want to edit the note for the next call, hit enter to finish this note
and move to the next. Once you have a note entered in one or more calls in a given search or incident, you

can also reuse previous notes by clicking on a call then opening an autocomplete menu that will list the

notes from other calls in this view, as seen below.

ion Note

Example note 1
Example note 2

Example note 1
Example note 2

05:00 2020-03-05 15:12:00 -05:00 2020-03-05 15:13:00 -05:0
.

Fig. 5.12 Note Autocomplete Menu



116 5. Updating Recordings

5.3. Annotating Calls

Annotation allows you to make notes in a recording at the precise time in the recording that is of interest.
For example, you can mark where someone on the line starts yelling, or when a sound in the background
caught your attention. Annotations are visible on the timeline as a little yellow pin marker, and if you
hover your mouse over them, the text will pop up, in this case “A comment about this moment in time.”:

2020+ 2020-03-05 15:12:00 -05:0
[ | ! [ 1
L T Y T A T A T T R A R R R R
L{ } (SR S
M -4-4[ A comment about this moment in timeJ

Fig. 5.13 Text Annotation in the Timeline

Annotations are paired to the call, so the pin will be visible in any search, browse or incident that includes
it. To add an annotation, right-click on the call and select Add Text Annotation. This will open the
Annotation editor, with the Date set to the time of where you initially clicked.

Annotation X

Note:
This is an example Text Annotation

Resource Name: EMS-West
Permissions: Read/Write v
Date: 2020-03-05 15:11:26

Speak Talking Time
e |

Fig. 5.14 Editing an Annotation
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You can adjust the time alignment by configuring the date in this window; if you want the annotation to
precisely align with the start or end of the call, you can use the left (start) and right (end) arrows around
the date to set it to the start or the end.

When looking at the properties of a call record that has been annotated, a list of these annotations will
appear at the bottom of the properties window.

Call Properties X

Properties More History

Location Time

Source: NexLog DX-Series Start Time: 2020-03-05 15:11:11 -05:00
Channel:  EMS-West Duration:  00:34

Phone Attributes

CLID: A

DTMF: | Protected

Direction:  Inbound

Notes

Annotation at 2020-03-05 15:11:33 (UTC -05:00:00)

"A comment about this moment in time"

"This is an example Text Annotation"

Annotation at 2020-03-05 15:11:22 (UTC -05:00:00) m

Fig. 5.15 Properties showing Annotations

5.3.1. Audio Annotations

Annotations can also include audio, if you have a microphone attached to your computer and are using
Firefox, Chrome, or Edge (Chromium). Internet Explorer does not support the necessary web
technologies for this feature to work.

For privacy reasons, using a microphone with MediaWorks EXP requires that you grant explicit

permission to the web browser to use the microphone; this is handled by the browser. It also requires
HTTPS.
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NexLogDXSeriesRecorder/client/mediawo

Will you allow 192.168.17.10 to use your

| E‘J microphone?
Microphone to share:

Microphone (Jabra PRO 9470) v

W Remember this decision w—
Annotation

Allow Don't Allow

Please allow the browser mic access to record audio.

2020-03-0

2020-03-0:
00:00/01:00

Note:

Resource Name: Dispatch-Police
Permissions: Read/Write

Date: 2020-03-03 00:00:26
[J Speak Talking Time

Experiencing Audio Playback Issues?
[ concel

Fig. 5.16 Audio Annotation Microphone Permission Prompt in Firefox

UuuU/UT:UU

[@) Your recorder requires additional settings to access
your mic in chrome. The recorder must be accessed via
HTTPS. Please contact your dealer for more information.

ons: 'Readswrite v |

Fig. 5.17 Audio Annotation Microphone HTTPS Prompt

Audio Annotations can include text like a regular Annotation, but by using a microphone you can provide

commentary on any call, at any point in the call. Right click on the call in the timeline at the point you wish
to annotate, grant permission to the microphone (once per session) and then click the button with the

red dot in acircle to start recording.

Once you are recording, the timer on the side will count up to the maximum of 60 seconds of recording

time. Click the same button again to stop recording. You can then playback the recording by pressing the

play icon (triangle) in the audio widget that appeared after clicking stop.

You can delete the recording by pressing the red X circle button and you can save by clicking OK.

Playback the call and you will hear the audio annotation, surrounded by a beep at start and end, at the

point in the call you placed it.
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Audio Annotations are played back by default but can be turned off in the Playback menu.

Audio Annotation X
Please allow the browser mic access to record audio.
00:00/01:00

[8] Failed to gain access to the microphone.

| Resource Na

Permissions: Read/Write +

Date: 2020-03-03 00:00:31
[J Speak Talking Time
Experiencing Audio Playback Issues? “ m

Fig. 5.18 Audio Annotation Error: No Microphone

5.3.2. Annotation Images

Annotation images can be added to specific times on the timeline in recordings to help visually identify a
crucial moment or a critical event that occurs in the call. Image annotations can accompany text or audio

annotations as a visual aid. MediaWorks EXP provides a variety of image annotations that you can add to
recordings.

To add an image annotation:
1. Hover your cursor over the specific time in the timeline marker that you wish to annotate.

2. Right-click and select Add Text Annotation. The Annotation box appears.
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Annotation X

Note:

Resource Name: GW Sim 1

Permissions: Read/Write (2] ‘
Date: 2025-04-01 04:40:48 ‘
Icon: nQ R Rl YDH@BAOSO

| Speak Talking Time

—

Fig. 5.19 Annotation Box

3. Add a note to your annotation in the note field. This note will become visible when you hover your
cursor over the icon in the timeline.

4. Set the permissions for your annotation.

1. Owner only permissions only allow the owner to view and edit the annotation.
2. Read only permissions enable other users to view the annotation but they cannot edit it.
3. Read/Write permissions enable other users to view and also edit the annotation.

5. If needed, adjust the date of your annotation.

1. Change the date either by selecting the arrow key icons, entering values in the text box, or by
selecting the calendar icon to the right of the textbox.

6. Select the icon you wish to add to the timeline.

7.Click OK. The icon appears on the timeline. Hover your cursor over the icon to see the text
annotation. If you did not add a text annotation, the text will appear as <Blank Annotation>.
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2025-04-02 23:50:00 -04:00 2025-04

Fig. 5.20 Image and Text Annotation on the Timeline

To edit or delete image annotations:

1. Right-click the image annotation icon on the timeline. A box appears with the options to modify or
delete the annotation.

2. Select Modify Annotation to edit the annotation.

3. Select Delete Annotation to remove the annotation from the timeline.

e —
2025-04-01 05:00:00 -04:00 2025

Modify Annotation

Delete Annotation

Fig. 5.21 Modifying or Deleting Annotation Options
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6. EXPORTING RECORDING DATA FROM AN
INCIDENT

MediaWorks EXP can export recording data from a recorder in a number of different formats. Although
you can export from the Search and Browse tabs, the preferred way to export data is to first create an
incident containing the recordings you wish to export. Refer to Section 4: Creating an Incident for
additional information. Once an incident has been created, select Export... from the Tools menu. The

Export Media dialog box will appear Fig. 6.1. You can also right-click on the selected recordings in the
Record view and choose Export... from the menu.

6.1. The Export Dialog Box

To export recordings:

1. In the Export Media dialog box, Select media, will be highlighted. Select All media in your record
list? to export the media for all the recordings in the incident, or select Only selected media in your
record list? to export only selected recordings in the incident.

2. By default, a text file listing the calls and metadata will be included in the resulting zip file; this can
be exported as a PDF as well. The PDF option allows you to configure which Metadata Columns to
include in the PDF, as this may need to be adjusted to fit the data onto a single page.

3. You can also choose to Include Attachments, for incidents that include attached files. Make your
choice and then click the Next > button.
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Export Media X

| —Export Steps Would you like to export:
Select Media All media in your record list?
Select File Divisions « Only selected media in your record list?

Screen Export Options | Call(s) to export: 1
Select Export Options v| Create text listing
Select Destination ¢l Include Attachments
Create PDF listing

N T

Fig. 6.1 Export Media Dialog Box Step 1

1. Select File Divisions will be highlighted. You may select One file per record (sequential), one file for
the entire record list (sequential), which exports all the calls back to back in order in one file, One
file for the entire record list (mixed), which means it is presented in real time with overlapping calls
audibly overlapping, or One file per resource (mixed), which exports a single mixed file for each
resource involved in this export.

The two Mixed exports have additional options that do not apply to the sequential mode: Skip
Inactive Periods and Apply Boundaries. Skip inactive periods will skip any part of the export that
would have been silent, useful when exports have long periods between calls. Apply Boundaries
allows you to crop the export to a shorter duration than the data set chosen in the first step.

Make your choice and then click the Next > button.
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Export Media X

—Export Steps: How would you like your files divided?
Select Media « One file per record (sequential)
Select File Divisions One file for the entire record list (sequential)
Screen Export Options One file for the entire record list (mixed)
Select Export Options One file per resource (mixed)

Select Destination

Fig. 6.2 Export Media Dialog Box Step 2

1. Select Export Options will be highlighted. Here you can select Time Markers (and then choose the
desired time marker modes), choose to use the timeline playback settings, and set the file type to
save as. In the File output encoding box, select the type of data compression scheme you want to
use. If you have purchased and entered an add-on license for MP3 encoding, MP3 will be an
available choice in this menu.

The Use timeline playback settings and apply redaction areas option is on by default and will cause
exports to sound the same as they do when played back in the same mode as the export, including
volume adjustments, AGC, panning and redaction areas. The Export Audio Annotations option will
include any audio annotations present on the calls being exported.

O New in version 2024.1.

P License Required

This feature must be licensed to be used. Contact your Eventide Communications Dealer for
assistance.

Media can be exported to an MP3 audio format for smaller file size.
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Select the preferred audio output option from the following File output encoding options:

e Mu-law Encoding: Compresses dynamic range, reduces file size, often used in telephony.

e MP3: Compressed format, balances quality and file size, widely used for efficient storage

¢ Raw Encoding: Uncompressed, highest quality, used for audio editing.

¢ Native Encoding: Default format for specific systems, ensures compatibility and optimal
performance.

Export Media X

—Export Steps Time Markers
Select Media (D Enabled

Select File Divisions

Use timeline playback settings and apply

Screen Export Options redaction areas

Select Export Options
Select Destination

Export Audio Annotations
Say time at configured annotations

File output encoding: [ Mu-Law v]

Mu-Law
Raw !
[ Native Encoding

Fig. 6.3 Export Media Dialog Box Step 3

To set MP3 format as the default export option or to create custom presets, refer to Export Presets and
Defaults

Due to licensing constraints, MP3 exporting is not available when using the Pack and Go feature.

After selecting the audio options, click the Next > button.

1. Select destination will be highlighted. Enter a file name for the export, and select Export to File,
Export to Data CD/DVD/Blu-Ray or Email Export. Export to File will create a zip file containing the
exported calls for use on your computer. Export to Data CD/DVD/BIlu-Ray will create an ISO that
can be burned with standard CD burning software to the appropriate media for the size of the
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export; the export dialog will show you whether the estimated size of the export will fit on each of
the kinds of media. Email Export will create a EML file that will automatically open in your
computer’s configured default email client.

Note: You can configure your default email client in the system preferences of the operating
system you are using, for example in Windows 10, it can be found in Control Panel: Default
Programs.

Export Media X

What would you like to name your download file?

' —Export Steps
Select Media Export file name:
Select File Divisions « Export to File
Screen Export Options

Export to AutoUnpacker
Select Export Options « Use Default Location
Select Destination Choose Export Location
Export to Data CD/DVD/Blu-ray
Email Export

Export Presets...

N T N

Fig. 6.4 Export Media Dialog Box Step 4

1. Optional: The export destination can also be Eventide AutoUnpacker. See below for details.
1. Optional: Export Presets and Defaults can be configured from here. See below for details.

1. Finally, click on the Export button to export the recording data; it will be downloaded to your
browser’s default download location on your PC. If you selected Export to File, it will download as a
zip folder containing the audio file or files you requested.

If you selected Export to Data CD/DVD/Blu-Ray, the file downloaded will be an ISO file that you
can use Windows Disc Image Burner to burn to CD or DVD. If you have a Blu-Ray drive please use
the image burning software that it came with.
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6.2. Eventide AutoUnpacker

Exported media can be automatically downloaded and decompressed to your defined default location by
using Eventide AutoUnpacker. To use this option, it must be installed and enabled first from the Tools
menu under Eventide AutoUnpacker.

Eventide AutoUnpacker X

‘ AutoUnpacker allows for a quick and easy export to a default

| location on your computer. Download and install the AutoUnpacker

| application from the Downloads page of the Configuration
Manager or click here. Once this option is enabled, you can select

| the AutoUnpacker option from the export wizard.

| oxJGaneal

Fig. 6.5 Tools = Eventide AutoUnpacker

¢! Unpacker Enabled

Once AutoUnpacker is enabled and installed, you can select one of the two options for exporting.

Use Default Location

Uses the default export location that was defined in the installed application. Exporting this format
will download a file with a “.eaud” extension. If your browser is set to open this file automatically
after downloading, then your exported media directory will automatically open when finished.

Choose Export Location

If your media needs to be exported to a location different from your default, then select this option.
Exporting in this format will download a file with a “.eau” extension. This file type will open the
AutoUnpacker utility so that you can browse to your desired export location.
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I AutoUnpacker Setup X

Welcome to the AutoUnpacker Setup Wizard

AutoUnpacker Px

The Setup Wizard will install AutoUnpacker on your computer. Click Next to continue or dose the window
to exit the Setup Wizard.

Fig. 6.6 Eventide AutoUnpacker Utility

6.3. Export Presets and Defaults

Regularly used Export settings can be saved, both as a default setting that will load every time the Export
dialog is opened, and as individual Export Presets that can be selected from the “Export Using Preset”
menu option. Defaults and presets are saved at the last panel of the Export dialog.
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Export Media X

What would you like to name your download file?
Export file name: Utility-Water Main 927 Bro

—Export Steps
Select Media
Select File Divisions

« Export to File

Screer| Export Options Export to AutoUnpacker

Select Export Options « Use Default Location

Select Destination Choose Export Location

Export Presets

« Save as default export configuration

Save as Preset |

Export Presets...

Fig. 6.7 Saving Export Default and Presets

Clicking the Export Presets... button will prompt you to save the current settings as either a default

export configuration or as a named preset. Once an Export Preset has been saved, the Tools menu and

the right-click context menu will have an Export Using Preset option that allows you to choose a preset

to load.
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Block media access...

v Protect
i S — |
’ Remove from Incident Ctrl+D oo e
New Incident from Selected Records B N .

e L b
Add Selected to Incident b

| Evaluate Records p Joeifrieurefeirfffiui

(X ~¢|-¢|u«|++|n-m-|‘

Start Sequential Playback

Start Resource Mixed Playback

| [ R
Export... Ctrl+Al+E
Export Single Recording... A
Export Using Preset » Example Preset 2
Add Text Annotation 4 Example Preset 3
Add Audio Annotation Example Preset 4 !
Add Redaction Point
Split/Join Media CD

Fig. 6.8 Export Using Preset Menu Option

Selecting an Export Preset will open the Export dialog to the final page, where you enter the export name
and choose the file type (zip, ISO, eml.) You are however free to use the back button to make any
adjustments to the settings that you wish for this export.

You can overwrite an existing preset by saving a newly created one with the same name. You will be
prompted to be sure, and if you click yes, it will overwrite the previous preset. To delete a preset, select
that preset from Export Using Preset and then click Export Presets; instead of a field to save a new
preset, you will see the option to delete this preset.
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Export Media (Example Preset 2) X

—Export Steps What would you like to name your download file?
Select Media

Select File Divisions

Export file name:

« Export to File
Export to AutoUnpacker
« Use Default Location

Screen Export Options
Select Export Options

Select Destination Choose Export Location

Export Presets

« Save as default export configuration

Delete Export Preset Example Preset 2

Export Presets...

=N 2N

Fig. 6.9 Deleting an Export Preset

6.4. Email Export

You can choose to export to an .eml file that you can open with your email client of choice. It will create
an email with the export’s contents attached. Note that your email provider usually has a limit set on the
size of email attachments, so this option is most useful for small exports.

6.5. Export Single Recording

Available from the Tools menu and the right-click context menu, Export Single Recording exports the
currently selected call, with current playback and timeline settings, including volume adjustments, AGC,
panning and redaction areas. This is a quick way to export a single call at a time without any additional
steps or menu-diving.

6.6. Screen Capture Export

Screen capture recordings can be exported much like audio recordings, but there are some caveats.
Recordings from multiple screen resources cannot be mixed together. Screens from the same channel
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can be merged into a single mixed mode export. Audio calls can be mixed with screen recordings from a
single screen resource. If part of the export overlaps such that there is audio with no video, the video will
be black during that time.

There are four encoding types for screen export. The first two, MPEG, High and Medium, are much
higher quality in a much smaller file size, but require VLC or Chrome or other third party software for
playback. The second two, AVI Low and Medium Compression, will work on a stock Windows XP system,

but the quality is lower and the file size is very large. These options are included to allow for maximum
compatibility.
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/.MONITORING A RECORDER

MediaWorks EXP allows you to monitor the live audio feeds on the recorder. In addition, you can view
the status of channels, and (if permitted) manually enable/ disable recording on channel(s) for record-on-

demand purposes.

7.1. Channels Tab

The Channels tab displays all physical channels in a list and provides live status information for all
physical channels on the recorder. To open a new Channels tab, select New Tab = Channels from the File

menu.

To sort the list of channels, click on either the Channel Name or Channel Number header; a small arrow
will indicate the sort direction. To reverse the sort, click the header section again.

Each channel is displayed with the Channel Name, Channel Number, and current Channel Status. To
enable live monitoring of the data currently playing on a channel, click to toggle the Live Monitor icon for
the selected channel. Multiple channels can be monitored simultaneously. Adjust the overall volume level
using the volume slider at the bottom of the window.

To enable recording on a channel, check the Record Enabled checkbox. If the checkbox is deselected, any
audio currently being recorded will stop until the Record Enabled checkbox is re-checked.

The Record Enabled feature is heavily restricted, and must be configured explicitly for each user,
even those with Administrator rights, in Configuration Manager. This is to prevent accidental use of

the feature.

The status of each channel is displayed in the Channel Status column. A colored square indicates the
status. The colors correspond to the following states:

Green - The channel is enabled, but not currently recording any audio.

Red - The channel is enabled and is currently recording audio.
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Yellow - The channel is user disabled.

Grey - The channel is disabled by the system or is not recognized. Consult your system
administrator for details.

You may add more columns by right-clicking on any area in the column headers and selecting one or
more new columns from the drop-down list of column names. Check the box associated with each

column name you wish to add and the new column will appear in the Channels tab. To remove a column,
uncheck the box associated with that column.

7.2.Instant Recall Tab

The Instant Recall tab, as seen below, provides a live window into the activity on one or more channels.

The most efficient method for monitoring a recorder with Instant Recall is to create one tab per filter.
See Resource Search Groups.

B Utlty-Water Main 927 Broadway* i JUNSITISRY

NexLoc

Fig. 7.1 Instant Recall Tab

To open a new Instant Recall tab, select New Tab from the File menu and select Instant Recall from the
drop-down list.

The Instant Recall tab’s main controls are positioned at the top of the screen and include:

e The Choose Channels... button, which will pop open a list of Search Filter Groups and resource
names to filter the call resources shown in the instant recall window.

¢ An adjustable time range that allows you to set the time window for which records will appear.
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¢» Channels Q Search := Browse & Ul

Choose Channels| [JlE| Hours ENJES Minutes

EMS-West
Fire-1 9
Fire-North
Fire-West 9
PDW

Police
Police-10th
Police-41st
Police-80th
PW
Security-Main
Security-Sub
Traffic-Police-1

Tmlom D alim A

OK ‘ Edit Resource Groups... ‘ Cancel

.E.MS-EaSt_-g - [>] Ilumw [ --r]

Fig. 7.2 Choose Channels... pop up menu

The records displayed in the record view will correspond to the selected filter, and will also correspond
to the specified time range.

The Choose Channels... pop up menu lists your Search Filter Groups first and then each named
resources. The channels viewed are selected via mouse click; use Ctrl+Click or Shift+Click to select more
thanone at atime:

e Clicking on Channel 1 and then ctrl+clicking on Channel 9 will select just Channel 1 and Channel 9.
e Clicking on Channel 1 and then shift+clicking on Channel 9 will select Channel 1 through Channel
9.

To adjust the time range, enter a new value for Hours and Minutes. Instant Recall will automatically
refresh the record view. To change the channel that is displayed, select a new channel name from the
drop down list. The record view will again be automatically refreshed.

Depending on your user account, the amount of time you can set may be limited by your system

administrator.

The Instant Recall record view can be customized by right-clicking on any area in the column headers. A
drop-down menu with a list of column names will be displayed. To add a new column, check the box



138 7. Monitoring a Recorder

associated with the column name. To remove an existing column, uncheck the box associated with that
column name.

Columns can also be re-arranged. To move a column to a new position, click on the column header, hold
down the mouse and drag the column header to a new position, then release the mouse. The column will
then re-position itself.

7.2.1. Instant Recall Timeline

Each Instant Recall tab also includes a Timeline view in the bottom half of the page. This allows for all the
features standard to the Timeline view as seen in the Browse and Search tabs, as discussed in chapter
1.4.4 The Timeline View, but also includes some special features unique to the Instant Recall tab:

e Per channel live monitoring of incoming call via Resource Name or Talkgroup.
e Optional up to the minute timeline scroll.

Each resource in the Timeline has a speaker icon at the far right that can be toggled green to have it live
monitor all calls coming in with that resource name. This is different than the Channels tab, which is by
physical id number only.

bk

Fig. 7.3 Instant Recall Timeline (Detail)
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The blue arrow in the right corner toggles whether the display of the timeline is locked to the current
time or not. It will automatically turn off if you play a call in the timeline or scroll into the past, and if you
then click it, it will jump forward to display the current time. It will also turn back on if you live monitor a
resource, or if you scroll all the way up to the right to the current time.

Fig. 7.4 Up to the Minute Arrow (Left is On, Right is Off)

7.2.2. Add More Timeline

O New in version 2024.1.

This feature drills down into a channel to quickly add existing calls to the timeline from before or after
the selected recording.

By right-clicking in front of or behind a call event, you’ll see the “Add More” option. This will add
additional 15 minutes of records from before or after the selected call.
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P /i
@ Channels © Instant Recall © Channel 1 & Incident #3*

Properties and Notes | | Export Incident 1records, 0 selected

Source Name Channel Na... Start Time ~ Duration Callerid Dtmf
NexlLog Channel 1 2024-01-05 18:12:24 -05:0C 01:01

Resource Name 2024-01-05 18:10:00 -05:00 2024-01-05 18:15:00 -05:00 2024-01-05 18:20:00 -05:00 2024-01-05 18:25
LT R T N Y T [ Y T Y T B B T T T T R B | R
Channel 1 m
Add More
Undo Add More »
) ) AV
FiveMinutes v & | &) &) ‘ R
0000 00:00
Volume [ ) 100%

.~ o4 P MO

Fig. 7.5 Add More Timeline
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8. RESOURCE SEARCH GROUPS

A “Resource Group” is a NexLog policy management tool that groups together resources/channels on the
recorder and allows different rules to be applied to them. Search Filter Groups are a special kind of
Resource Group, which make large channel count systems easier to interact with by grouping existing
resources into easily searched groups. To differentiate these from the Saved Search Filters feature of
MediaWorks EXP, they are referred to as Resource Groups in this context.

Resource Search Groups can be edited via the Tool menu at any tab. They are also Edit Resource
Groups... options in contextually useful places on the Search and Instant Recall tabs, as described below.
Finally, Search Filters can also be edited from the Configuration Manager on the Resource Groups page
and User Edit pages; see the NexLog Express user manual for more info.

8.1. Creating Resources Groups for Search

The Edit Resource Groups option in the Tools menu allows you to edit Resource Group Search Filters,

you will see this window:

Edit Resource Groups x

Search Filters for ‘Eventide’ New Group Global Resources

~ Ambulance + Resource Groups

141

Dispatch-EMS (Litte Ferry)
EMS-East-1 (Little Ferry)
EMS-East-2 (Little Ferry)
EMS-North (Unknown Source)
EMS-North 2 (Unknown Source)
EMS-South (Unknown Source)
EMS-West (Little Ferry)

~ Named Resources
1 (Little Ferry) - AUDIO
10 (Little Ferry) - AUDIO
11 (Little Ferry) - AUDIO
12 (Little Ferry) - AUDIO
13 (Little Ferry) - AUDIO

EMS-West 2 (Unknown Source) <« 15 (Little Ferry) - AUDIO
~/Fire 16 (Little Ferry) - AUDIO
Dispatch-Fire (Little Ferry) 2 (Little Ferry) - AUDIO
Fire-1 (Little Ferry) » 3 (Little Ferry) - AUDIO
Fire-North (Little Ferry) 4 (Litle Ferry) - AUDIO
Fire-West (Little Ferry) 5 (Little Ferry) - AUDIO
+ Police 6 (Little Ferry) - AUDIO
Security-Sub (Little Ferry) - AUDIO
Traffic-Police-1 (Little Ferry) - AUDIO
Traffic-Police-2 (Little Ferry) - AUDIO
+Physical Channels
+ Talk Groups

)-
)-

14 (Little Ferry) - AUDIO
)-
)-

Fig. 8.1 Edit Resource Groups Window

There is a similar Edit Resource Groups... option in the Choose Channels... menu on Instant Recall tabs,
which opens the same window. The Edit Resource Groups window has two columns. The left column
contains a list of search filter groups configured to be available for the current user. The right column
contains in bold all existing filter groups not configured for the user, and in plain text the available
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channel resources, first the physical channel ids and then by resource names. The physical channel ids
are formatted like this:

e [source] channel id “current name of resource”
Such that the first physical channel on the recorder itself will default to:
e [local] 1 “Channel 1”

The << and >> buttons are used to move filter groups, channel ids and resources between the two
columns.

From this edit window, you can add and delete Resource Groups in several ways. The first is to click the
New Group button. This will prompt you to name the group, then click ok. An empty group of the name
entered will be created. You can also right click an existing group and select Add New Group

Resource Groups can only be deleted by Administrators and users with access to the Resource
Groups page of the Configuration Manager.

8.2. Adding Resources to Resource Groups

From this edit window, you can add resources to a Resource Group in several ways:

e The named resources and physical channel numbers in the right column can be clicked on to select
them. Use Ctrl+Click or Shift+Click to select more than one at a time. Highlight a group in the left
column by clicking on it. Then add the selected resources by clicking the leftward facing arrows
between the columns.

¢ You can select resources and click+drag them from the right column into the group you want them
to be added to.

¢ You can right-click the name of the group and select from a menu, as seen in the figure below. From
this menu, you can add a Name Filter, using * as a wild card to match multiple resources by name.

¢ This menu also allows you to add a Channel Filter, with which you can specify a range of resources
by physical channel ID and their source, which defaults to Local. The source field is only relevant to
configurations involving resources on the recorder originating from Centralized Archive sources; if
you want to group these, enter the serial number of the Centralized Archiving source into this field.
Click the X to cancel and the Checkmark to save.
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& Example Geaus
cus-£ (Tene e Crove
EMS-E Add Channel Filter
EMS-} Edit Group Name
EMS-North 2 (Hackensack)
EMS-South (Hackensack)
EMS-West (Little Ferry)

EMS-West 2 (Hackensack)

Fig. 8.2 Edit Resource Groups: Right Mouse Button Menu

For example, if you have some channels dedicated to Fire calls and others dedicated to Police, you can
create a Resource Group for the Police channels, and another for the Fire channels and quickly search all
calls on one group of channels.

8.3. Deleting a Resource from a Resource Group

You can delete resources from a Resource Group in two ways. First expand the group in the left column
and then:

Select the resources you want to remove from the filter and then click the >> button between the
columns. Right-Click on the group and select Remove Filter from the pop up menu.

8.4. Using Resource Groups

These filter groups now show up in the channel selectors for Browse, Search and Instant Recall. Updates
made to Resource Groups are live and do not require a refresh of the browser to take effect.
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8. Resource Search Groups

Choose Channels | [l Hours EllE] Minutes

Fire

oK Edit Resource Groups... | Cancel

M s 1

Resources

= Resources
O Ambulance

O Fire

E-0 Police

Use Time Range

Dispatch-Police

Police-10th
Police-41st
Police-80th

SEARCH

13 Records

-
R

|

\

|

\

|

\

¢

00:00

@ Channels i= Browse

El- Resources

- March, 2020
- March 27,2020 - Fri
) Ambulance

O Police
“~Channel 5 (3 calls)
Channel 6 (5 calls)
“Channel 7 (3 calls)
Channel 8 (5 calls)

Fig. 8.3 Resource Groups: In Browse, Search, and Instant Recall
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9. ARCHIVES

Archives can be accessed via MediaWorks EXP.

To connect to an archive, load the archive as appropriate for the kind of archive on the NexLog Express
system, then use the browse button to load the archive into “Playback” mode. The archive will then
connect automatically for MediaWorks EXP users who have permissions to read from archives.

You can disconnect an archive via Connection Information.

Creating Incidents and Evaluations of archived calls are not currently supported.
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10. USER CONTENT UPLOADS

»

Properties and Notes (1) | B Export Impound | | [ Quarantine 13records, 1 selected | Rotate Canvas| Q B

Body Cam ROHS Fri Jan 212022 11:35:48 .. © @ ¥ X

Source Name Channel Na... Start Time ~ Duration Callerid  Dtmf Weather
© NLDX.VM_240100149 Channel3  2022:01-2112:49:24-05:00 14:56
© NLDX.VM_ 240100149 Channel3  2022-01-2112:24:30 -05:00 14:56
© NLDX.VM_240100149 Channel3  2022:01-2111:59:36 -05:00 14:56
NLDX_VM_240100149 User Content U| 2022-01-21 11:37:32 -05:00 00:00
NLDX_VM_240100149 | User Content U[ 2022-01-21 11:35:48 -05:00 o0 | [ | |
© NLDX_VM_240100149 User Content Uj 2022:01-21 11:35:09 -05:00 00:00
© NLDX_VM_240100149 User Content Uj 2022-01-21 11:34:42 -05:00 00:00
© NLDX.VM_ 240100149 Channel3  2022:01-2111:34:42 -05:00 14:56 76 F hazy
© NLDX.VM_240100149 Channel3  2022-01-2111:09:48 -05:00 14:56
- e — s—— —-— — — — S—
3300 0500 0L 02T T 3700 0500 020 2T T 3500 0500 0L 0T 2T 1T 3000 0500 020 2T T3/ 00 0500 prEET
Resource Name R S (T S S N (S S R (R SN SRS R SR A B
Channel 3 ]
efe B
ppd\ B
Body Cam ROHS B ﬁ
A Y @ O
OneMinue v| & T @& &

—

00:00 . 00:00
Volume e s 100% » Body Cam ROHS
Speed e e 100% 1< > >l Q . 2022-01-21 11:35:48 -05:00 -

Fig. 10.1 User Content Upload

User Content Uploads allows a user to upload media to a NexLog Express recorder channel, and use that
media for incidents, evaluations, or general playback.

This feature is intended to assist a user by having all incident data in a central place.
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User Content Uploads require additional licensing and must be enabled in the NexLog Express

Users and Security -> System Security general configurations. See the NexLog Express User Manual
or Contact your Eventide Communications Dealer for assistance.

Audit changes
Audit verbose

() Enable Incident Clip Management
Recording

Enable User Content Uploads

Archiving

C
Enable Terms Of Service splash screen in MediaWorks Plus clients (edil contents in System->Configuration Files->Terms of Service Display)
UrporIEEy [ Enable Block Media Access

Enable MediaWorks Plus ATC/ATM mode

Session C Timeout (min): |5 ]
System Securily
0 Exempt NexLog Access Bridge Hosts from Database Authentication

Active Directory.

Exempted NexLog Access Bridge Host IPAddresses: [ |
sl Encrypted Terminal (SSH) Al v

User Groups

Permissions. Save Cancel

Fig. 10.2 Enable User Content Upload

10.1. Uploading Content

Content or media can be uploaded by right-clicking in the call grid or timeline, then selecting Upload User
Content.

© 2025 Eventide Communications LLC



10. User Content Uploads 149

Upload User Content b4
Add Media

Drag and Drop files here or use the + button.

Fig. 10.3 Add Media

Multiple files can be uploaded by dragging them into the designated area, or by clicking the plus sign.

10.1.1. Edit User Content

Once content has been uploaded the user may set the basic information for it.

Upload User Content X

B jWO0bQSDFVOEx.mp4

Incident Only
Resource Name @ |Channe| 298 V|

New Resource O

Custom Start Time @® 2021-01-07 16:34:44
Suggested Start Time O 2021-01-06 10:45:33

Mime Type Minor Version Model Modify Date
video/quicktime 0.0.0 iPhone 11 2021:01:07 02

Upload

Fig. 10.4 Edit User Content

¢ Incident Only: Make the uploaded content only available to the current incident that it was
uploaded to.
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e Resource Name: Set the resource or channel name that the content should be attached to.

e New Resource: Enter a new resource or channel name instead of reusing an existing one.

e Custom Start Time: Set the content to begin at the time the user right-clicked from, or selected
with the calendar button.

¢ Suggested Start Time: Set the content to begin at the timestamp embedded in the file's metadata.

Once content has been uploaded, only the Resource Name and Start Time can be set.
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11. MORE ABOUT MEDIAWORKS EXP

11.1. Columns

Any data displayed in tabular format, particularly lists of recordings available in the Browse, Search,
Incident, and Channel tabs, can be sorted in ascending or descending order, if applicable, by clicking on
the header for that column. An indicator arrow will appear in that column indicating the sort direction. To
change the sort direction, click on the column header again.

You can also sort columns by a secondary sort by shift + clicking a second column. For example, you
may want to sort by channel name and then by start time; you would click Channel Name first, then hold
down the shift key and click the Start Time (Local) columns. You can change the secondary sort by
again shift + clicking, or you can cancel the secondary sort by clicking on any column, which will then
be the only sort criteria.

Columns can also be re-arranged. To move a column to a new position, click on the column header, hold
down the mouse, drag the column header to a new position, then release the mouse. The column will
then re-position itself.

You can set the default columns for each tab selecting View = Column Defaults in the top menu bar.

wlance »| i= Browse | @ Utility-Water Main 927 Broadway*

Columns exLoc

outas Default | SRR

>  Results as of 2020-03-05 14:44:33 -05:00

Source Name Channel Name Start Time -~ Duratit  *
NexLog DX-Series EMS-West 2020-03-05 15:11:11 -05:00 00:34
- NexLog DX-Series Traffic-Police-1 2020-03-05 15:11:19 -05:00 01:00
V@ NexLog DX-Series Dispatch-EMS 2020-03-05 15:11:22 -05:00 00:06
ﬁ NexLog DX-Series Dispatch-EMS 2020-03-05 15:11:39-05:00  00: 06'
NexLog DX-Series Police-80th 2020-03-0515:11:49-05:00 05:02 | ¥
NexLog DX-Series Fire-West 2020-03-05 15:11:55-05:00  00:22
NexLog DX-Series Dispatch-EMS 2020-03-05 15:11:56 -05:00  00:05 v
NexLog DX-Series Fire-North 2020-03-05 15:11:59-05:00  00:32
NexLog DX-Series EMS-West 2020-03-05 15:12:04-05:00  00:34
- NexLog DX-Series Dispatch-Fire 2020-03-05 15:12:13 -05:00 00:19
NexLog DX-Series Dispatch-EMS 2020-03-05 15:12:13 -05:00 00:05
NexLog DX-Series Dispatch-EMS 2020-03-05 15:12:30 -05:00 00:06
NexLog DX-Series EMS-East-2 2020-03-05 15:12:31 -05:00 00:31 M
=] Resource Name i ; | N, |
l — [ R e I v o
g >

<« » P O

Fig. 11.1 Column Drop-Down List
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The presentation of recordings in the Browse, Search, and Incident tabs can be further customized.
Right-clicking on any area in the column headers displays a drop-down menu of possible column names.
To add a new column, check the box of the associated column name. To remove an existing column,
uncheck the box associated with that column name.

11.2. Calltype

Calltype is a feature that automatically tags records with an image representing the kind of recording it
is. By default, recordings made on Analog Recording cards will be tagged with Audio, T1/E1 with Phone,
screen capture with Screen. The default calltype for VolIP is dependent on the VolP template used.
Default calltypes can also be set on per resource or channel name in Resource Groups. See the NexLog
Express User Manual for more information.

In MediaWorks EXP, these icons will appear in the timeline if Show Calltype in Timeline is checked in the
View menu. You can see the calltype column by making the column visible as you would any custom field
by right-clicking in the call grid header and selecting calltype from the list.

i . B B s |
Channel Name Calltype Start Time 4
Dlspatch -Fire d 2020-03-26 00:00:10 -04:00

Dispatch-EMS d 2020-03-26 00:00:27 -04:00
Fire-West 2 2020-03-26 00:00:36 -04:00
EMS-West =) 2020-03-26 00:00:43 -04:00
Dispatch-Fire LR 2020-03-26 00:00:44 -04:00
Dispatch-EMS g 2020-03-26 00:00:44 -04:00
Fire-North d 2020-03-26 00:00:48 -04:00
EMS-East-2 2 2020-03-26 00:00:53 -04:00

Fig. 11.2 Calltype in Timeline

Audio recordings can also have a different waveform color for each calltype.

Default calltypes icons and a corresponding waveform color can be set at Recording — Custom Fields —
Calltype in Configuration Manager.

See the section about Calltype in the NexLog Express User Manual for more information.

© 2025 Eventide Communications LLC
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11.3. The Menu Bar

The Menu bar is located at the top of the MediaWorks EXP window. Several menu selections have
shortcut keys associated with them and are displayed to the right of the menu selection. Also, if a menu
selection includes an associated shortcut key, the shortcut key is shown parenthetically in the following
descriptions.

The Menu bar includes the following menu items: File, Edit, Tools, Playback, View, and Help.

11.3.1. File Menu

File Edit Tools Playback

New Tab 3l se
Open Incident Ctrl+0
Close Tab

Ctri+S B

Ctrl+Alt+S S

Logout Ctrl+Q 7
8 9 10 11 12 13 1«
15 16 17 18 19 20 2

Fig. 11.3 File Menu

Selecting File from the Menu Bar provides the following menu items:

11.3.1.1. New Tab

The New Tab menu item opens a new tab in the active top-level window. Choose a tab name from the list
that appears. The list includes:

e Browse ( ctrl + b))
e Search( ctrl + t)
e Incident ( ctrl + i)
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e Channels ( ctrl + 1)
e Evaluations ( ctrl + g)
¢ Scheduled Evaluations

11.3.1.2. Open Incident

Keyboard Shortcut: ctrl + o

The Open Incident... menu item opens an existing remote incident in a new tab.

11.3.1.3.Close Tab

Keyboard Shortcut: ctrl + w

This menu item closes the active tab. You cannot close the last tab.

11.3.1.4. Save Incident

Keyboard Shortcut: ctrl + s

The Save Incident menu item saves the active incident. If an Incident tab is not active, this option is not
available.

11.3.1.5. Save Incident As

Keyboard Shortcut: ctrl + alt + s

This menu item saves a copy of the active incident by prompting for a new incident name. If an Incident
tab is not active, this option is not available.

11.3.1.6. Logout

Keyboard Shortcut: ctrl + q

© 2025 Eventide Communications LLC
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Selecting the Logout menu item logs the user out of the NexLog recorder, and will go back to the initial
splash screen with a login prompt. There is an “Are you sure” prompt.

11.3.2. Edit Menu

Edit Tools Playback View Help
1 Select All Ctrl+A
! Ctr+D
i Ctrl+J

New Incident From Selected Records ~ Ctrl+Alt+l

Y EEE Y T ZEESEEm

i Set Loop Start to Current Time Ctrl+[

Set Loop End to Current Time Ctrl+]
! Set Export Start to Current Time Ctrl+Alt+[
! Set Export End to Current Time Ctrl+Alt+] F
2 77 2A IR WP 77 79 b T

Fig. 11.4 Edit Menu

Selecting Edit from the Menu Bar provides the following menu items:

11.3.2.1. Select All

Keyboard Shortcut: ctrl + a

The Select All menu item selects all recordings in the active tab.

11.3.2.2. Remove From Incident

Keyboard Shortcut: ctrl + d

Selecting the Remove From Incident menu item removes the selected recordings on the active Incident
tab. If an Incident tab is not active, this option is not available.
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11.3.2.3. Incident Properties

Keyboard Shortcut: ctrl + j

The Incident Properties menu item invokes the Incident Properties dialog box on the active Incident tab.
If an Incident tab is not active, this option is not available.

11.3.2.4. New Incident from Selected Records

Keyboard Shortcut: ctrl + shift + i

This menu item creates a new Incident tab in the active window containing all the selected recordings. If
a list of recordings is not available in the active tab, this option is not available.

11.3.2.5. Set Loop Start to Current Time

Keyboard Shortcut: ctrl + [

This selection sets the “loop start” point to the value of the current playback time. This is only available
on those tabs that can play audio from a recording.

11.3.2.6.Set Loop End to Current Time

Keyboard Shortcut: ctrl + ]

This selection sets the “loop end” point to the value of the current playback time. This is only available on
those tabs that can play audio from a recording.

11.3.2.7.Set Export Start to Current Time

Keyboard Shortcut: ctrl + shift + [

This selection sets the “export start” point to the value of the current playback time. This is only available
on those tabs that can play audio from a recording.

© 2025 Eventide Communications LLC
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11.3.2.8. Set Export End to Current Time

Keyboard Shortcut: ctrl + shift + ]

This selection sets the “export end” point to the value of the current playback time. This is only available
on those tabs that can play audio from a recording.

11.3.3. Tools Menu

Tools Playback View Help

Export Ctrl+Alt+E
Export Multiple Impounds...
Print/Export Records

Edit Search Filters

Edit Resource Groups

Edit Date Formats

Edit Default Permissions
Resource Gain Defaults

EQ Settings

Eventide AutoUnpacker...
Edit Call Properties

Change Password

Fig. 11.5 Tools Menu

Selecting Tools from the Menu Bar provides the following menu items:

11.3.3.1. Export

Keyboard Shortcut: ctrl + alt + e
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This menu item opens the Export Media dialog box for the current list of recordings. See Section 6:
Exporting Recording Data from an Incident for additional information.

11.3.3.2. Export Using Preset

This menu item opens the Export Media dialog box for the current list of recordings with the preset’s
settings selected. See Section 6: Exporting Recording Data from an Incident for additional information.

11.3.3.3. Export Multiple Incidents

Keyboard Shortcut: ctrl + alt + e

This menu item opens the Export Multiple Incidents dialog box, including a scrolling list of selectable
incidents on the recorder and options for exporting more than one of them at a time. See Section 6:
Exporting Recording Data from an Incident for additional information.

11.3.3.4. Print/Export Records

This menu item opens the Print/Export Options dialog box, including a choice of format for the export
(xIsx, pdf, csv), which columns and what audit information to include. This only exports record metadata
and not the audio.

11.3.3.5. Edit Search Filters...

This menu item opens the Search Filters window. See Section 2.4: Saved Search Filters for additional
information.

11.3.3.6. Edit Resource Groups...

This menu item opens the Edit Resource Groups window. See Section 8: Resource Search Groups for
additional information.

© 2025 Eventide Communications LLC
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11.3.3.7. Edit Date Formats

This menu item opens the Date Format Options window. This window allows you to customize the way
dates and time are formatted throughout MediaWorks EXP. We recommend leaving out the day, month
year from the Instant Recall Date Format because Instant Recall will always be displaying calls from the

very recent past.

Date Format Options X

Global Date Time Format

New: YYYY-MM-DD HH:mm:ss:SSSZ | Current: 2021-01-23 19:03:08:054 -05:
Instant Recall Date Time Format

New: HH:mm:ss Current: 19:03:08

Date Chooser Format

* yyyy-mm-dd yyyy/mm/dd mm/dd/yyyy dd/mm/yyyy
Examples:

‘MMMM Do YYYY, hmm:ss a" -> January 23rd 2021, 7:03:08 pm
‘dddd-MMMM DD/YY (hh A)" -> Saturday-January 23/21 (07 PM)
"DD.MM.YYYY HH:mm:ss.SSS ZZ" -> 23.01.2021 19:03:08.054 -0500

Fig. 11.6 Date Format Options

The default global date time format is: YYYY-MM-DD HH:mm:ss Z

¢ YYYY: Four digit year
e MM: Two digit month

e DD: Two digit day

¢ HH: Hours (24 hour clock)

e mm: Minutes
e ss: Seconds
¢ SSS: Milliseconds

e Z: offset from GMT time

The hyphens and colons in between the variable names are shown as is.

159

The Load Defaults button will restore the settings to the default. The examples show how other variable

names can be used to get other results. If you have more complex date needs, contact Eventide support
for additional information.
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11.3.3.8. Edit Default Permissions

This menu item opens the Edit Default Permissions dialog box so that you can change the default
permissions and call protection settings for Incidents and Annotations.

pFary | DipatciEMS 0005]

2 Ferry X |-04:00 00:05

2 Ferry Incidents Annotations 04:00 |00:22

2 Ferry 0400 00:33

2 Ferry Default New Incident Permissions --04:00 00:20

: Ferry Owner Only » Read Only 0400 00:06

2 Ferry Read/Write -04:00 00:31

2 Fer 04:00 00:31

b/ Default Incident Protect |

2 Ferry -04:00 00:06
« Protect calls Do not protect calls

2 Ferry 0400  00:06
Default New Incident Record Access Block -

ce Name Block media access L .. |

tch-EMS .

e 50% Pan: N « Do not block media access

B : N ave

tch-Police

e: 50% Pan: None

Fig. 11.7 Default Permissions

The Incident setting “Protect Calls on Save” option in Incident Properties controls whether or not calls
added to an incident after the initial save will be protected when the incident is saved. This defaults to
On when “Protect calls” is selected here, and Off when “Do not protect calls” is selected here.

11.3.3.9. Resource Gain Defaults

Opens the Resource Gain Defaults window. See Section 3.4: The Timeline View for additional
information about Resource Gain Defaults.

11.3.3.10. EQ Settings

Opens the EQ Settings window. See Section 3.5.4: EQ Settings for additional information.
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11.3.3.11. Eventide AutoUnpacker

Once Installed and Configured, this Windows software will automatically unpack and export media from
MediaWorks EXP to your defined default location. requires Windows 7 or higher

11.3.3.12. Edit Call Properties

New for 2022.1, Call Properties can now be configured with customized information and layouts. See
Section 5.1: Call Properties for additional information.

11.3.3.13. Change Password

Opens the Change Password window. Allows the user to change their password.
11.3.4. Playback Menu

Playback View Help

3 Toggle Playback Space ‘
Start Playback Return :
I Start Mixed Playback Shift+Return
| Next Record Shift+Right |
Previous Record Shift+Left E
Skip Forward Right E
Skip Back Left I
Loop Playback v
v Skip Inactive Periods Is

v AutoPlay After Cursor Move

I v Play Audio Annotations

v

Audio Player Options A

Playback Options E

Time Marker Options s
B b e

Fig. 11.8 Playback Menu
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Selecting Playback from the Menu Bar provides the following menu items:

11.3.4.1. Toggle Playback

Keyboard Shortcut: space

Checking the Toggle Playback box starts or stops playback. Starting or stopping playback in this way
applies to either playback mode and applies to any tab. The space bar on the keyboard can also toggle
playback on/off.

11.3.4.2. Start Sequential Playback

Keyboard Shortcut: «enter

The Start Sequential Playback menu item starts sequential playback at the selected recording. If there is
no selection, the first recording in the list will begin playing.

11.3.4.3. Start Mixed Playback

Keyboard Shortcut: shift + center

The Start Mixed Playback menu item starts mixed playback at the selected recording. If there is no
selection, the first recording in the list will begin playing.

11.3.4.4. Next Record

Keyboard Shortcut: shift + -

In sequential mode, Next Record skips to the next recording as listed in the record view. In mixed mode,
Next Record skips to the start of the next recording in time order.

11.3.4.5. Previous Record

Keyboard Shortcut: shift + «

© 2025 Eventide Communications LLC
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In sequential mode, Previous Record skips to the previous recording as listed in the recording view, or
skips to the beginning of the current recording, depending on the time that the current recording has
been playing. If the current recording has been playing for less than 3 seconds, it will skip to the previous
recording. If the current recording has been playing for more than 3 seconds, it will skip to the beginning
of the currently playing recording.

In mixed mode, Previous Record skips to the start of the previous recording.

11.3.4.6. Skip Forward

Keyboard Shortcut: -

The Skip Forward menu item scrubs forward by a user-defined number of seconds (default is 10). In
sequential mode, scrubbing remains within the bounds of the currently playing recording.

11.3.4.7. Skip Back

Keyboard Shortcut: -

The Skip Back menu item scrubs backward by a user-defined number of seconds (default is 10). In
sequential mode, scrubbing remains within the bounds of the currently playing recording.

11.3.4.8. Loop Playback

Checking the Loop Playback box loops playback between user-defined start and end looping points. In
Sequential mode, if no user-defined start and end looping points have been set, the entire recording will
be looped. If start and end points have been set within the recording, checking Loop Playback will initiate
loopback between these two points.

In Mixed mode, if no user-defined start and end looping points have been set, the entire set of recordings
will be looped. If start and end points have been set within the set of recordings, checking Loop Playback
will initiate loopback between these two points.
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11.3.4.9. Skip Inactive Periods

Checking the Skip Inactive Periods box causes MediaWorks EXP to skip inactive periods between
recordings when playing in Mixed mode. In Mixed mode, MediaWorks EXP always proceeds in time order
and there may large gaps of silence separating recordings. By default, MediaWorks EXP will skip over
any gaps and begin playing the next recording. Disabling this option will force MediaWorks EXP to play
the inactive periods in real time.

11.3.4.10. AutoPlay After Cursor Move

On by default, this option controls whether scrubbing a paused call will automatically start playing. If you
want to move the playback position in the timeline while paused without having playback resume, turn
this off.

11.3.4.11. Time Marker Options

Time Marker Options X

Enabled
» Use Talking Time
Use Beep
VOL PAN
-@-@— Voice:[English Male 1 v]

* Say time in local time

Say time in UTC

Say time at start of call set

Say time at end of call set

Say time in intervals of: 11 ¢ Seconds
Say time at start of call

Say time at end of call

00000

Say time at configured annotations

Fig. 11.9 Time Marker Options

This setting allows you to have MediaWorks EXP beep or announce the time when specific events
happen during playback. You can choose to have the time announced in local time, or in UTC. The beep or
time can be heard at the start and/or, end of each call set, or every X number of seconds, or at the start or
end of each call. By default it will only say the time when annotations that have “Speak Talking Time”
configured are played back.
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11.3.4.12. Single Play

Checking the Single Play box stops playback in sequential mode after the data finishes playing for a
recording. If disabled, playback continues to play each recording, as listed in the record view, until the

end of the list is reached.

11.3.5. View Menu

Selecting View from the Menu Bar provides the following menu items:

R

heme

Multimedia Display Options

Enable Geo-Display
Show Connections Icon
Show Alarms Icon
Show Reports Icon
Show Clear Filters Icon
Connection Information
Alarms

Reports

Archives

Play Audible Alarm
Show Export Markers
Show Loop Markers
Show Calltype Icons

Show Tab Search

Show Word Factor in Timeline

Follow Playback
Show Playing Record

Column Defaults

Save Current Columns Layout as Default

Warn On Exit

Fig. 11.10 View Menu

v

v

vJ

vJ
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11.3.5.1. Theme

The Theme menu now gives you the options for Light, Dark, or Custom modes.

¢ Channels

Properties and Notes | | § Export Incident

6 records, 1 selected

Source Name Channel Na... Start Time ~ Duration Callerld  Dtmf
e NLDX_740_22.96 Channel 39 2021-12-31 23:59:38 -05:00 00:05
NLDX _740_22.96 Channel 33 2021-12-31 23:59:28 -05:00 00:05
NLDX _740_22.96 Channel 41 2021-12-31 23:59:18 -05:00 00:05
NLDX _740_22.96 Channel 36 2021-12-28 23:59:28 -05:00 00:06
NLDX _740_22.96 Channel 33 2021-12-28 23:59:28 -05:00 00:06
NLDX _740_22.96 Channel 42 2021-12-28 23:56:58 -05:00 00:05
— — — — —
2021-12-31 23:59:00 -05:00 2021-12-31 23:59:10-05:00 2021-12-31 23:59:20-05:00 2021-12-31 23:59:30 -05:00 2021-12-31 23:59
Resource Name ;
[T T R T R ST KU SRR [ I T T S S U N S S S S S ST R
Channel 33 ‘ > ‘ - e
Channel 39 b e
Channel 41 ‘ > ‘ - e e
Channel 36
Channel 42 ‘ > ‘
AV
TenSecondsv | o © @ a a S
—
00:03 (i 00:05
Volume » Channel 41

Speed

DG <« > > cp.

2021-12-31 23:59:20 -05:00

Fig. 11.11 Light Mode

In order to create a custom theme, select “view” dropdown, “Theme”, then “Configure...”.
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Theme v Classic

NexLoc

6 records, 1 selected

Multimedia Display Options Dark

Enable Geo-Display Custom

Source Name Channel Ni
o NLDX_740.22906  Channel39  'consand Markers »| Configure...
NLDX _740_22.96 Channel 33 Connection Information
NLDX _740_22.96 Channel 41 [ENETE
NLDX _740_22.96 Channel 36 Reports
NLDX _740_22.96 Channel 33 .
Archives
NLDX _740_22.96 Channel 42
Play Audible Alarm
v Follow Playback
R N Show Playing Record Ctri+Alt+C 1 23:59:10-05:00 200 11231 235020 0500 00T 123 255030 0500 2021-12-31 23:59:
esource Name RN TR T N T ST [N T T T T SO T T N BT S
Channel 33 Nl v Show Playback Audit oo
Channel 39 : Column Defaults e
— Save Current Columns Layout as Default
Channel 41 > - (oo
— Warn On Exit
Channel 36 >
Channel 42 Z
AV
Ten Seconds v | & A @ Q q S
S—
00:03 [N 00:05
» Channel 41

2021-12-31 23:59:20 -05:00

Fig. 11.12 Theme Configure

Here you'll be able to adjust primary and secondary text and background colors.
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¢» Channels

Properties and Notes

:= Browse

Help
- © Channel 1 B Evaluations Evaluation

Export Incident

Primary Background Color

Eventide | =)
NexlLoc

6 records,

Secondary Background Color
Source Name Channel Na... Start Time ~ Duration Callerld  Dtmf
e NLDX _740_22.96 Channel 39 2021-12-31 23:59:38 -05:00 00:05 Primary Text Color ’E
NLDX _740_22.96 Channel 33 2021-12-31 23:59:28 -05:00 00:05
NLDX _740_22.96 Channel 41 2021-12-31 23:59:18 -05:00 00:05 Secondary Text Color v
NLDX _740_22.96 Channel 36 2021-12-28 23:59:28 -05:00| 00:06
NLDX _740_22.96 Channel 33 2021-12-28 23:59:28 -05:00 00:06 Apply
NLDX _740_22.96 Channel 42 2021-12-28 23:56:58 -05:00 00:05
— o — — — —
2021-12-28 23:56:00 -05:00 2021-12-28 23:56:10 -05:00 2021-12-28 23:56:20 -05:00 2021-12-28 23:56:30 -05:00 2021-12-28 23:56:40]
Resource Name
| T T T T T | R T T B R T T T TR T TR T [ S T TR N T T | T R |
Channel 33 ‘ > ‘
Channel 39
Channel 41 ‘ > ‘
Channel 36
Channel 42 ‘ > ‘
Ten Seconds v Y @ @
A : =\ < >
—
00:03 (i 00:05
Volume e 100% » Channel 41
Speed O 100% I< > ’I C) 2021-12-31 23:59:20 -05:00

Fig. 11.13 Custom Theme

11.3.5.2. Multimedia Display Options

Multimedia recordings can be played back in the same way as Audio calls, but there are additional
options that relate to specifically to screens. These options are configured via the Multimedia Display
Options window, which is described in detail in Section 3.7: Playing Screen Recordings.

11.3.5.3. Enable Geo-Display

On a system with a Geolocation add-on license and location metadata, when enabled this will open the
Geo-Display popover window featuring a map and pin marks for call records that are tagged with
location data. For more details, see Section {number}: {name}.
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11.3.5.4. Show Connections Icon

—] DCooper | #)

NexlLoeG

59693 records, 1 selected &

Fig. 11.14 Connections Icon

Checking the Show Connections Icon will display Connection Icon for fast access to the Connection
Information window.

11.3.5.5. Show Alarms Icon

When Show Alarms Icon is selected, the alarm icon (a triangle surrounding an exclamation mark) at the
right side of the menu bar will display. When the icon is grey, there are no active alarms.

NexlLoc

13006 records, 0 selected &

Fig. 11.15 Alarm lcon (Nothing Active)

When the icon is red, there are unacknowledged active alarms.
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—] DCooper | &)

NexlLoc

13006 records, 0 selected &

Fig. 11.16 Alarm lcon (Unacknowledged Alarm Active)

When the icon is yellow, there are active alarms, but they are all acknowledged.

exLoe

13006 records, 0 selected L

Fig. 11.17 Alarm Icon (Alarms Active But Acknowledged)

In any case, if you click on the icon, it will open the Active Alarms page of Configuration Manager.

11.3.5.6. Show Reports Icon

Checking the Show Reports Icon will display Reports Icon for fast access to the View Reports window.

NexlLoG

13006 records, 0 selected W7

Fig. 11.18 Reports Icon
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11.3.5.7. Show Clear Filters Icon

Checking the Show Clear Filters Icon will display the Clear Filters Icon for fast access to the Clear Search
Filters option. This is useful if you make heavy use of the Search Filters feature.

:= Browse Q, Search P

Filters oS >

MAR 2020 >

Fig. 11.19 Clear Filters Icon

11.3.5.8. Connection Information

This will open the Connection Information pop up window. See above in Section 11.3.5.8: Connection
Information.

11.3.5.9. Alarms

This will open the Alarms page of Configuration Manager in a pop up window.

11.3.5.10. Reports

This will open the Completed Reports page of Configuration Manager in a pop up window.
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11.3.5.11. Archives

This will open the Archives page of Configuration Manager in a pop up window.

11.3.5.12. Play Audible Alarm

This will enable sound for active alarms. When an alarm is triggered on the recorder, the alarm sound will
play as 4 beeps, pause 15 seconds and repeat, until you go to Active Alarms page and acknowledge the
alarm.

11.3.5.13. Show Export Markers

Checking the Show Export Markers box will display boundary markers for Mixed Mode Exporting. These
red markers default to the start and end of any browse or searched results, and when set within results
will grey out the area that is not inside the boundaries.

11.3.5.14. Show Loop Markers

Checking the Show Loop Markers box will display the current loop points as blue markers in the timeline
header.

11.3.5.15. Show Calltype in Timeline

This will show Calltype icons in the timeline. See Section 11.2: Calltype for more information.

11.3.5.16. Show Tab Search

This will open the Tab Search pop up. See Section 11.3.5.16: Show Tab Search for more information.
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11.3.5.17. Follow Playback

Checking the Follow Playback box will cause the playback indicator to remain centered in the timeline as
the recording is playing.

11.3.5.18. Show Playing Record

This option will bring the currently playing record into view on the Call Grid. By default, the playing
record will stay in view, but if you use the scroll bar, this is overridden. Using this option will bring the
playing record into view and resume following it.

11.3.5.19. Column Defaults

Column Defaults will open a window to set the default columns for the call grid. Use the left & right
arrows to move fields into or out of the list, and the up and down ones to reorder them.

11.3.5.20. Save Current Columns Layout as Default

An alternative to Column Defaults is to set up your preferred columns in the current tab and use this
menu item to save them as the user default. This method has the added benefit of saving the current
column widths as well.

11.3.5.21. Warn On Exit

With Warn On Exit checked, MediaWorks EXP will prompt for confirmation if you try to close the
window or navigate to a different web page.

11.3.6. Help Menu

Selecting Help from the Menu Bar provides the following menu items:
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User Manual

About

Fig. 11.20 Help Menu

11.3.6.1. User Manual

Selecting User Manual from the Help menu will open a link to this user manual as a PDF file.

11.3.6.2. About...

Selecting About from the Help menu provides information about this release of MediaWorks EXP.

About

Search Filters (3) >
10 Source Name Channel Name Calltype  Start Time
i2
:
15 MediaWorks Plus Version 2020.1[623]
3,6 License Enabled
X Note = Air Traffic Control No
Search For: Features
MP3 Exports No
EmptyOnly ) Exact @ Not Empty NAB Ves
Case Sensitive? Packaged Player No
X Audited =z Quarantine No
S RapidSOS No
« Show accessed Word Factor No
Show not accessed eoFence Google

http://www.eventide.com

Maps
_ Geo-Fi =
= enc Copyright 2006-2020 Eventide Inc.
W y

Fig. 11.21 About Pop Up
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11.4. Translations

MediaWorks EXP is supported in multiple languages via user-configurable translations. See NexLog
Express manual for further information or contact your Eventide Rep for more details.

Eventide | )

Propiedades y notas (1) B Exportar incidente | [ Cuarentena 9 registros, 1 seleccionado Q. B &

Nombre de |a fuente Nombre del... Hora de inicio - Duracién Identificador de llamadas Dtmf Weather

o NLDX_VM_240100149 Channel 3 2022-01-21 13:14:18 -05:00 14:56
e NLDX_VM_240100149 Channel 3 2022-01-21 12:49:24 -05:00 14:56
e NLDX_VM_240100149 Channel 3 2022-01-21 12:24:30 -05:00 14:56
o NLDX_VM_240100149 Channel 3 2022-01-21 11:59:36 -05:00 14:56
e NLDX_VM_240100149 Channel 3 2022-01-21 11:34:42 -05:00 14:56 76 F hazy
e NLDX_VM_240100149 Channel 3 2022-01-21 11:09:48 -05:00 14:56
e NLDX_VM_240100149 Channel 3 2022-01-21 10:44:54 -05:00 14:56
e NLDX_VM_240100149 Channel 3 2022-01-21 10:20:00 -05:00 14:56
I e e S O

Nombre del recurso

Channel 3 ﬂ - | J ‘ ] [ ] ‘7

) ) AV
Treinta minutos v v A @ Q < >
00:00 00:00
Volumen [ ] 100%

Velocidad (o] 100% I< » >I CD

Fig. 11.22 MediaWorks EXP Translations
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12. ADDITIONAL OPTIONAL FEATURES

MediaWorks EXP has optional features that are off by default.

They are enabled via the Recorder settings on the front panel or via Configuration Manager, on the Users

and Security: System Security page.
The features:

¢ Incident Clip Management

e User Content Uploads

e Terms of Service Splash Screen

e Media Access Blocking

o Air Traffic Control / Air Traffic Management Mode

12.1. Incident Clip Management

Incident Clip Management allows users making incidents to join or split audio calls in an incident so that
the calls are played back correctly. The original call records remain on the recorder in their as-recorded

state.

More details and usage information can be found in Section 4.8: Incident Clip Management.

12.2. User Content Uploads

User Content Uploads allows a user to upload media to a NexLog Express recorder channel, and use that

media for incidents, evaluations, or general playback.

See Section 12.2: User Content Uploads

12.3. Terms of Service Splash Screen

A custom Terms of Service splash screen can be shown at login time for all users by checking the Enable
Terms Of Service splash screen in MediaWorks DX clients (edit contents in System — Configuration Files
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- Terms of Service Display) box on this page. To configure the text for this, navigate to System —
Configuration Files and edit the file named Terms of Service.

NexLoG DX

Terms of Use

This is an example Terms of Service. This can be edited in
Configuration Manager under System: Configuration Files.

Fig. 12.1 Example Terms of Service

12.4. Media Access Blocking

If a call or screen containing sensitive information is recorded, a site may want to limit who can
listen to or view it. Block Media Access is an optional feature that allows supervisors to restrict
the playback of individual recorded media to certain users only. The call record and it’s metadata
(notes, time, duration, etc) will still be visible for all users, but only specified users will be able to

play it.

When enabled, any user with the Client Software: Block Access To Recordings Permissions
canright-click a call record or group of call records and select Block Media Access. This will pop up

the window shown below:
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Block Media Access

Access is not blocked ‘

Block media access Clear All || Apply Defaults ‘

Allowed Users Allowed User Groups Set as Default
Anton Agents ‘

Eventide Researchers

I ASaunders Archivers

BBellerue Group Evaluators ‘

DBarton Instant Recall
DCooper Maintainers F
DSigal Monitors |
ECherry ~ Report Editor ‘_
|
|

|

Fig. 12.2 Block Media Access Pop Up Window

In this dialog box you can block access to this media by checking the box next to Block Media
Access. The Exceptions area grants permission to listen to this call to the checked users and user
groups. When blocking access, the logged in user is automatically checked for access.

The status bar at the top can show a variety of messages, based on the state of the call(s) selected
when opening the window. If all calls have the same state, it will say Access is not blocked or “Access
blocked by (user name) at (date & time); if all of the records are blocked but the times or exceptions
are different it will say Records are blocked in this dataset with varying exceptions and/or dates:

Block Media Access

Access is not blocked

Block media access Clear All  Apply D

Allowed Users Allowed User Groups Set as Default |

Block Media Access

Access blocked by DCooper at 2020-03-26 14:28:27 -04:00

Block media access Clear All || Apply Defaults ‘

Allowed Users Allowed User Groups Set as Default

Block Media Access

Some records are blocked in this dataset

@ Block media access Clear All  Apply Defaults I

‘Allowed Users Allowed User Groups Set as Default ‘ I

Fig. 12.3 Example Block Media Access Status Messages

If multiple call records with different states are selected and Block Media Access is opened,
settings that differ across the calls will be shown with a - in the check box. If left unchanged, these
settings will not be changed when OK is clicked. To apply that setting to all calls, click once to
check the box. To remove the setting from all selected calls, click twice to empty the box.
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12.5. Air Traffic Control / Air Traffic Management Mode

Air Traffic Control / Air Traffic Management mode swaps out Incidents for Impounds &
Quarantines. These are covered in depthin Appendix {number}: {name} .

12.6. Interleaved Mode

MediaWorks EXP now offers the ability to differentiate between multiple streams on a VolP recorder
and visualize multiple voicings on the Timeline View.

& wfprime & interleaved call m © Instant Recall & interleaved call-1 b NexLOG
Properties and Notes | B Export Incident | | B+ Pack and Go 2records, 1selected Q B
Source Name Channel Na... Start Time ~ Duration Callerld  Dtmf
Charne9 20220201 160325 05000115 | Supanior 2000 |
o NEXLOG Channel 9 2022-02-01 15:58:11 -05:00 01:15 Supervisor 2000
Resource Name 02-01 0 0 1 0 0 2022-02-01 0 02-01 3 0 02-011603:40 20220201
“““ [ L 1 L 1 - 1
Channel 9 > \ CHUE ke ek N
TenSecondsv | = | & &
. < >
——
00:05 (9] 01:15

Ly — ————— il » Channel 6
SPeed —— —100% < > < & I 2005 os -

Fig. 12.4 Interleaved Call Mode

The Example above shows two streams of dialog on one channel, with each voice represented by
different shades of color.
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Interleaved Call Mode requires an additional VolP add-on service. See your Eventide Rep for more
information.

12.6.1. Interleaved Mode Configuration

In order to enable Interleaved Call Mode, a user must refer to their NexLog Express configurations ->
Recording -> Recording Interfaces and update the template details for “Stream Recording Mixing Mode”.
The “Keep Separate” setting will enable Interleaved Mode.

EDIT BOARD TEMPLATE INFORMATION ALIAS BANKS

SIP Trunk Template

Ethernet Device: eth0 [ens160] x

SIP Trunk Type [Passive SPAN v

SIP Pott: Beo ]
RTP Pors e —
Endpoint IP: [
Recorder Sip Stack [Eventiee —v]

Stream Recording Mixing Mode Keep Separate v
Field Mappings:

[ ] Edit

ReApply Template | | Cancel

Fig. 12.5 Interleaved Mode Configuration

To activate Interleaved Mode for certain channels, you need to adjust the settings in the IP Recording
system. Specifically, go to the “Encoding” settings and select “Mulaw Separate Streams” from the
dropdown options available. You can find these options either directly within the “Encoding” dropdown

menu or by navigating to the Settings Section and then selecting the “Audio Storage Encoding”
dropdown.
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View By Channel [J

L] a Recording Generation Simulator
LJ a IP Recording (multicast template)
L] a IP Recording (sip template)

MF ANI DETECT
(SYNWAY)

ACTMITY

Channel
Z - >

Add Virtual Recording Interface

INTERNAL INTERFACES

localhost 4 Channels Enabled
4 Channels Enabled
1 Channel Enabled
DETECT TDD VOX
ENCODING TYPE ENABLE TRIGGER m

PASSTHROUGH
MULAW
G726 32KBPS
G726 16KBPS HOOK Off -32db @
GSM
MULAW SEPARATE STREAMS
RTP VIDEO NS

Fig. 12.6 Encoding Options

Nex

Communications Recording Solufions

2022.1[2042]

EDITCHANNEL | RTP
Standard Channel Settings

Home

System
Channel Name

Networking

Eventide | Logout

DIAGNOSTICS

[Channel 9 ]

‘Audio Storage Encoding MULAW SEPARATE STREAMS v

s Default Call Type [MuLAw
G726 32KBPS
G726 16KBPS
Recording Interfaces Record Start/Stop Settings s
VULAW SEPARATE STREAMS )
Replace Board
Call Detect Mode HOOK v
Retention Setings Max Recording Duration(secs) ) Enable
Resource Groups
Alert Settings
Call Suppression
Activity Timeout(secs) [ ] O enabl
Custom Fields Y eocs) nee
Inactivity O Enable
Alias Banks
Metadata Missing Alert(count) ) Enable

Data Integrations

Additional Settings
Geo-Location

Encryption At Rest Metadata Cache

IMBE/AMBE Vocoders Config Text

Use Floating License

Archiving

Users and Security save | | Cancel

Timeout [T Uses BT O Enable
[

a

Fig. 12.7 Audio Storage Encoding

The VolP Channels that were updated will now show multiple streams of communication on the specified

channels in MediaWorks EXP.
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13. MEDIAWORKS EXP URL ARGUMENTS

13.1. URL Arguments

The base URL for MediaWorks EXP is:
https://<hostname of recorder>/client/mediaworks/

URL arguments are added after the forward slash of the base URL. The first argument must be

prepended with a question mark, and each subsequent argument must be prepended with an ampersand
(&).

Example: https://demo.nexlogdx.com/client/mediaworks/?argl1=valuel1&arg2=value2

13.1.1. Chrome Application

Enables a Chrome Application Instant Recall interface where sessionType=1 and tabType=5
Argument: chromeApp
Values: [integer]

1 - Enable

00:00 00:00

o . N T S )

Fig. 13.1 Enables a Chrome Application Instant Recall interface where sessionType=1 and tabType=5


https://demo.nexlogdx.com/client/mediaworks/?arg1=value1&arg2=value2
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13.1.2. Debugging

Displays a popup for each window.onerror event that occurs.
NOTE: This is for debugging purposes only.

Argument: alertErrors

Values: [integer]

1- Enable

13.1.3. Define Columns

Restricts client interface to specific columns and column width.

“Width” is an optional attribute that can be used to assume a certain percentage of the total space. If you
don’t set any widths, each column will attempt to use an equal portion. It’s not recommended to set some
columns with widths, while leaving others unset.

Argument: defineColumns
Value: [string]

defineColumns ={“name”:ColumnName, “width”:10}

13.1.4. Descriptor

Specifies the source location of the ETI file to be loaded. Should be paired with eti to open the source file.
The value should be the incident record’s GUID.

Argument: descriptor
Values:[string]

string - ETI source file location
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13.1.5. Disable IR Filters

Removes the filter options from the Instant Recall interface. Should be paired with setFilter so that the
tab knows what it should display

Argument: hideFilterOptions
Values:[integer]

1 - Enable, hides filters

13.1.6. Disable Record Context Menu

Disables call record right click menu.
Argument: disableContextMenu
Values: [integer]

1 - Enable, disables record right click menu

13.1.7.ETI

Enables the automatic loading of a packaged incident file (ETI). Should be paired with descriptor
Argument: eti
Values:[integer]

1 - Enable

13.1.8. Evaluation

Opens a specific Quality Factor evaluation. The value should be the evaluation record’s GUID.

Argument: evaluationGuid
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Values:[string]

string - Evaluation GUID to open

13.1.9. Headless

Hides File menu from callgrid header. Useful for small windows. Should be paired with IR tab and
hideFilterOptions arg.

Argument: headless
Value: [integer]

1 - Enable, shows IR without header

13.1.10. Hide Transport

Hides main audio player controls. For audio playback, this should be paired with miniTransport
Argument: hideTransport
Values:[integer]

1- Enable, hides main transport
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& C @ Not Secure | 192.168.22.184.
Choose Channels | [JlFs]Hours ElIFE] Minutes 20records, 0 selected &

Source Name Channel Na... Start Time ~ Duration Callerid  Dtmf

Little Ferry Dispatch-Fire  04:23:16 00:20

Little Ferry Fire-West 04:23:06 00:21

Little Ferry Fire-North 04:23:04 00:32

Little Ferry Dispatch-Fire  04:22:42 00:19

Little Ferry Fire-West 04:22:21 00:22

Little Ferry Dispatch-Fire  04:22:08 00:19

Little Ferry Fire-North 04:22:02 00:32

Little Ferry Fire-West 04:21:36 00:22

= —

Resource Name 042200 042300 O

: ‘ T T T SO T O S S S SO S R S TR
I T S T N CICT W L
Fire-North
e B B [ ] o0 1o [»« Dol }q—rl [n erﬂl«u“w)-r}
Fire-West
e 0% P None 2] [)-wmwhﬂ I.-uw...,.‘ [r-l')l\‘l-vwi"l

’ A Y D O

OneMinute v | & 0 :fl = a N >

Fig. 13.2 Hidden Transport

13.1.11. Incident

Opens a specific incident. The value should be the incident record’s GUID.
Argument: incidentGuid
Values:[string]

string - Incident GUID to open

13.1.12. Instant Recall Minutes

Sets the minutes in the lookback period for Instant Recall.
Argument: instantRecallMinutes
Values:[integer]

0-480 - Number of minutes
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13.1.13. Miniature Transport

Forces the miniature transport interface to be used for audio playback.

If the standard transport should be hidden, pair this argument with hideTransport
Argument: miniTransport
Values:[integer]

0 - Disables, use standard transport

0000 [ 00:00
o . O VTR S SIS

Speed L 100%

Fig. 13.3 Standard Transport

1- Enabled, use Mini Transport

Fig. 13.4 Mini Transport

13.1.14. Mobile Interface

Forces the mobile interface to be used.
Argument: forceMobile
Values:[integer]

1 - Enable, forces mobile interface and license to be used
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Date

Preset

E
3
8
<
3
8
3
iii

" e ‘ Show calls from last 7 = Resources
#& Ambulance

0 s ! Fire
[Q S| HHMM:SS 06:00:00 [ Dispatch-Fire
Views

Days

Fire-North
Fire-West
:

+
Add
Filter

H= 0 0 records, 0 selected

Fig. 13.5 Mobile Interface

13.1.15. Password

Sets the application password, must be paired with username for automatic login.
WARNING: The password will be clearly visible in the URL field
Argument: password

Values:[string]

string - Sets the application username

13.1.16. Session Type

Restricts client interface to a specific view element.
Should be paired with tabType

Argument: sessionType

Values:[integer]

1 - Full View

189
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2 Mediaagent

x +

< C @ Notsecure | 19216817.10,

Choose Channels | ERE ours EES Mites

Source Name
NexLog DXSeries
NexLog DX Series
NexLog DXSeries
NexLog DXSeries
NexLog DXSeries
NexLog DXSeries
NexLog DXSeries
NexLog DX-Series
NexLog DXSeries
NexLog DX Series

Channel Na... Start Time
Dispatch€MS 17:2239
Dispatch€MS 17:2222
EMSWest  17:2210
Dispatch EMS
EMS East2
Dispatch-EMS
Dispatch EMS
EMS West
Dispatch EMS
Dispatch-EMS

= Duration  Caller Id

0005
0005
0033
00:06
0031
0006

m
o 4> > O

Dtmf

162 records, O selected @

Resource Name. )
Dispatch £MS

EMS-East1

EMS East2

One Minute v -

Fig. 13.6 Full View

2 - Call Grid Only

2 Mediangent

« C @ Notsecure

Choose Channels| IS o T62records Dselected B

Source Name Channel Na... Start Time Duration  Callerid  Dtmf
o NeogOxseres s o006

NexogDXseres  Diparch s oous
o Notogoxseres  Ewseasta o024

NesLogDKSars  DipschEMs 17230 o006

NexogDxseres  Ems st o020

Nexog et s oo

NexogDxseres vao

Nexog Dxseres s |

NexogDxseres  Dispatchens 172299 -

NexogDxseres  Dispachs 17222

NexLog DX-Series. EMS-West O INTLAN ) O

NexogDxseres  Dipaches o005

NexogDxseres  Emseasta s

NexogDxseres Dt oous

NexogDXseres  Dipachns o006

NexogDxseres  ems st ” oz

NexogDXseres  Dispotch s 172114 o006

NexlogD¥Series Dipmches 172057 o005

NexogDXSeres  Dispatch s 172040 o005

NexogOXseies  EvSwes 172024 ooss

NexlogD¥Seris DispchEs 172023 o00s

72021 o0zt

NexLogDX-Series  EMSEast2 1

Fig. 13.7 Call Grid Only

3 -Timeline Only

2 Mediaagent x +

< C @ Notsecure | 19216817.10,

Choose Channels

S s G s

Wesource Name
Dispatch£MS 5 0 E

EM:

S C ol ol

EMS £ast2

EMS West

m
o 4> » O o

OneMinute v

Fig. 13.8 Timeline Only
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13.1.17. Set Filter

Sets the filter used for Instant Recall results. Values are entered as an array. The string must be URL
encoded. Multiple filters can be joined with acomma,.

Argument: setFilter

Values:[filter:string]

user_id:string - Also accepts CURUSER to filter for the logged in user.
channelname:string - Filters on Channel Name

*resourcegroup *:string - Filters on Resource Group

custom_field:string - Filters on the system’s custom fields, using the specified string.

13.1.18. Shortcut Keys

Enables/Disables keyboard shortcuts using Ctrl, Shift, or Alt.
Argument: ignoreKeys
Values:[integer]

1- Enable, disables shortcut keys

13.1.19. Show Map

Displays the map in full view for instant recall. Should be paired with sessionType=1, and setFilter for
best usage.

Argument: map
Values:[string]

full - Enable, shows maximized map of media
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Geo-Display

vaites
mmmmmm

Fig. 13.9 Map

13.1.20. Tab Type

Restricts client interface to a specific tab. Should be paired with sessionType
Argument: tabType
Values:[integer]
0 - Channels
1 - Search
2 - Browse
3 - Evaluation
4 - Incident

5 - Instant Recall

13.1.21. Touch Mode

Allows to use MWP on touchscreen desktops.

Argument: touchMode

© 2025 Eventide Communications LLC
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Value: [integer]

1 - Enable, allows to use MWP on touch screen desktop.

13.1.22. Username

Sets the application username, must be paired with password for automatic login.
Argument: username
Values:[string]

string: Sets the application username
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14. REPORTING PROBLEMS

It is Eventide Communications’s policy to work directly with dealers. Your dealer must report your
problem to Eventide Communications with the following information in order to process the service/

support request:

e Serial number(s) of the affected recorder(s).

¢ Software versions for the recorder(s).

e Severity of the issue, including a detailed description.

e Contact information (phone and email) for the dealer and on-site technician.

To contact Eventide Communications customer service for support, call 201-641-1200 Option 6
followed by Option 2 (Communications/Recorders Division) or email
service@eventidecommunications.com.
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